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Introduction
This guide describes Siebel Sales Handheld, providing information on 
configuration, installation, application administration, and the user interface.

This book will be useful primarily to people whose titles or job descriptions match 
one of the following:

This guide assumes that you already have an understanding of Siebel Tools.

Your project team members will benefit from attending Siebel University’s 
configuration training before they begin working with and configuring Siebel 
Handheld applications.

Trained technical professionals should configure Siebel Handheld applications 
carefully. Keep in mind that improper application configuration can adversely affect 
the reliability and performance characteristics of your configured Siebel application. 
Thorough testing is strongly recommended before production rollout of your 
configured application.

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 

Sales 
Professionals

Persons who use Siebel Sales Handheld to manage sales leads, 
opportunities, accounts, quotes, and so on.
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Introduction

How This Guide Is Organized
Product Modules and Options
This guide contains descriptions of modules that are optional and for which you 
may not have purchased a license. Siebel’s Sample Database also includes data 
related to these optional modules. As a result, your software implementation may 
differ from descriptions in this Bookshelf. To find out more about the modules your 
organization has purchased, see your corporate purchasing agent or your Siebel 
sales representative.

How This Guide Is Organized
This guide provides instructions for configuring and using the Siebel Handheld 
application. The instructions assume a working knowledge of Siebel Tools; 
therefore, information that appears in Siebel Tools Reference is not repeated. This 
guide is designed to be read from start to finish, although it can also be used as a 
reference thereafter to look up specific topics.

The following chapters and appendixes are directed to database administrators, 
Siebel application administrators, Siebel application developers, and Siebel system 
administrators:

■ Chapter 1, “Overview”

■ Chapter 2, “Application Development”

■ Chapter 3, “Application Administration”

■ Chapter 4, “Data Filtering”

■ Chapter 5, “Deployment”

■ Chapter 6, “Synchronization Conflict Handling and Recovery”

■ Appendix A, “Troubleshooting”

■ Appendix B, “Screens and Views”

■ Appendix C, “Business Components and Classes”

■ Appendix D, “User Properties and Methods”

■ Appendix E, “Print Tagging Language”
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Additional Resources
■ Appendix F, “Print Configuration Settings”

The following chapters are directed to end users of the application. These chapters 
will also be helpful, as a reference, to administrators and application developers 
who need to understand the handheld application in order to customize it.

■ Chapter 7, “Installing the Handheld Application”

■ Chapter 8, “Working with Siebel Handheld Applications”

■ Chapter 9, “Using Siebel Sales Handheld”

Additional Resources 
The following Siebel application guides contain information that may be relevant to 
your use of the Siebel handheld application.

■ For detailed coverage of the Siebel user interface and how to use it, working with 
data, locating information with the query and find features, sharing information 
with other users and other basic functionality topics, see Fundamentals.

■ For development and configuration information, see Siebel Tools Reference and 
Siebel Tools Online Help.

■ For information on installing the server components that are required for Siebel 
Handheld, see Siebel Server Installation Guide for Microsoft Windows.

■ For more information on assigning user access to catalogs, see Siebel eSales 
Administration Guide.

■ For information on creating user accounts, adding views and associating views 
with responsibilities, and assigning responsibilities and passwords for each 
handheld user, see Applications Administration Guide.

■ For information on using Siebel Remote to complete the Companion Sync 
synchronization process to the Siebel server from the laptop, see Siebel Remote 
and Replication Manager Administration Guide.
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 15



Introduction

Revision History
Revision History
Siebel Sales Handheld Guide for Windows-Powered Devices

Version 7.5.3
Table 1. Changes Made in Version 7.5.3

Topic Revision

“Unsupported Features” on 
page 26

Revised for 7.5.3: Added more information 
to this topic.

“Synchronization Security” on 
page 87

New to 7.5.3: Added new topic.
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Overview 1
Siebel Handheld provides Siebel functionality to Windows-powered mobile devices 
employed by mobile Siebel users working in the field. Siebel Handheld provides the 
subset of the Web Client functionality that is required by the handheld user. It 
differs from Siebel Web Client and Siebel Mobile Web Client in that it uses a selected 
subset of views, accommodates smaller screen sizes, and has a reduced memory 
capacity.

Siebel Handheld
The Siebel Handheld client is a streamlined version of the Siebel Mobile Web Client. 
It includes only the functionality required by mobile sales representatives. The 
Siebel Handheld client supports the same data relationships, the same configuration 
in Siebel Tools, and much of the same functionality as the Siebel Mobile Web Client.

Some features that are available on the Siebel Mobile Web Client are not available 
on the Siebel Handheld. Scripting and Siebel engines (for example, Pricing and 
Reporting) are not supported on the handheld.

Functional Differences
Siebel Handheld applications provide the functionality to support Siebel Handheld 
users working in the field. Not all functionality that is appropriate for the desktop 
or server environment is required by the handheld user. See Chapter 2, “Application 
Development,” for details on functional differences.
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Synchronization Overview
Using Siebel Tools
Siebel Handheld applications for Windows-powered devices can be configured in 
Siebel Tools using Web mode. You can take your existing Siebel application and use 
this as the basis for the handheld application, or you can create a new application 
by using the Siebel Tools application shipped on the Siebel Handheld application 
CD-ROM. See Chapter 2, “Application Development,” for more information.

Filtering
Filtering allows you to specify a subset of data to be used on the handheld device. 
Filtering is an important feature of a Siebel Handheld deployment because of the 
relatively large size of the average enterprise database in comparison to the 
relatively limited memory capabilities of handheld devices. It is important that 
sufficient time is allocated in the project plan to create and test the handheld filters. 
See Chapter 4, “Data Filtering,” for more information.

Deploying
The Siebel Handheld application can be installed on Windows-powered devices in 
one of two ways. The first is to create a partnership between a desktop or laptop PC 
and the handheld device using Microsoft ActiveSync. The second is to install the 
handheld application from external media, for example, a Cabinet (CAB) file. 

Handheld patches can be remotely deployed using PatchAgent. For more 
information, see Chapter 5, “Deployment.”

Backing Up and Restoring Data
The Siebel Handheld application provides database backup functionality. A 
database restore utility is also included with the application. See Chapter 3, 
“Application Administration,” and Appendix A, “Troubleshooting,” for details.

Synchronization Overview
The Siebel Handheld Synchronization (Sync) client synchronizes data between the 
Siebel Handheld database and a remote or server database. The synchronization 
process:
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Synchronization Overview
■ Updates the Siebel server database with changes made to the Siebel Handheld 
database

■ Updates the database on the handheld device with changes made to the Siebel 
server database

■ Downloads metadata changes, such as object definitions for new or modified 
screens or views

■ Allows users to select filters to limit the amount of data that is downloaded

Synchronization Methods and Architecture
The following methods can be used to synchronize data on the handheld device 
with data in the Siebel server database: Companion Sync (CS), Direct Server Sync 
(DSS) and Direct Server Sync via Proxy (DSSvP). The architecture of these methods 
is discussed in the following sections.

Synchronization Servers
There are two types of synchronization servers: direct synchronization servers and 
companion synchronization servers. A direct synchronization server runs in a 
Siebel server installation and can accept concurrent synchronization requests from 
multiple synchronization clients. When connecting to a direct synchronization 
server, the Siebel Handheld Sync client synchronizes its data with the server-side 
database.

In Direct Server Sync mode, the Siebel Handheld Synchronization client uses the 
HTTP protocol over a network connection to communicate with the handheld 
synchronization server. Users should configure their handheld devices for 
communication over the desired network.

A companion synchronization server runs on a companion personal computer with 
a Mobile Web Client installation. A companion synchronization server supports 
synchronization with a data source specified in a client configuration; the database 
resides on the companion PC.
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Synchronization Overview
Companion Sync
Figure 1 on page 20 illustrates Companion Synchronization architecture. 
Companion Sync allows users to synchronize the Siebel Handheld application and 
database with a Siebel Remote database on a Mobile Web Client.

Microsoft ActiveSync is used to connect the handheld device and the companion 
PC, through a serial or USB connection, or through a network connection. The user 
selects synchronization filters and launches Siebel Handheld Sync from the mobile 
client. The Sync server components that manage transaction processing and data 
extraction for the handheld database reside on the mobile client.

Figure 1 illustrates Companion Sync architecture.

Figure 1. Companion Synchronization Architecture
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Synchronization Overview
Direct Server Sync
Direct Server Sync allows users to synchronize their Siebel Handheld application 
and database directly with the Siebel server. The user connects the handheld device 
to the Siebel application server through a network connection that uses the HTTP 
protocol. The connection runs through an IIS Web server to the Siebel Gateway 
server and application server, where the Sync server components are installed. 
Figure 2 illustrates DSS architecture.

Figure 2. Direct Server Synchronization Architecture
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Configuring the Siebel Handheld Client Application
Direct Server Sync via Proxy
Direct Server Sync via Proxy (DSSvP) allows users to synchronize their Siebel 
Handheld application and database directly with the Siebel server. The user 
connects the handheld device to the Siebel application server through ActiveSync 
and the network connection established by the companion PC. The connection runs 
through an IIS Web server to the Siebel Gateway server and application server, 
where the Sync server components are installed.

Configuring the Siebel Handheld Client Application
Complete the following steps to configure your handheld client application.

To configure the Siebel Handheld Client

1 Define the user functionality. 

Determine which user interface elements (such as screens, views, toolbars, 
applets, find, and help) will be necessary for your Siebel Handheld Client end 
users. For more information, see “Defining User Functionality” on page 29.

2 Configure the Siebel Handheld Client user interface. 

The process for configuring user interface elements in the Siebel Handheld 
Client is the same as the process for designing user interface elements in the 
Siebel Mobile Web Client. For more information, see “Configuring User Interface 
Elements” on page 35 and Siebel Tools Reference.

3 Identify all eScript or VB script used in the Siebel application, and make sure that 
it does not conflict with the handheld application configuration. Siebel 
Handheld applications do not currently support scripting.

4 Compile the new configuration.

For more information, see “Compiling the Application” on page 43.

5 Update directives in the Siebel Handheld Client configuration file. 

For more information, see Chapter 4, “Data Filtering.”
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Configuring the Siebel Handheld Client Application
6 Test the new configuration. 

Test the configuration, repeating Step 2 through Step 6, to address any 
configuration errors.

After completing the Siebel Handheld Client configuration, you are ready to install 
it on the handheld devices. To install the Siebel Handheld configuration on a 
handheld device, see the instructions in “Installing on the Handheld” on page 113.
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Configuring the Siebel Handheld Client Application
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Application Development 2
This chapter describes the Siebel Handheld Client configuration process for 
application developers. The process for configuring a Siebel Handheld Client has a 
few differences, described in this chapter, from the process for configuring a Siebel 
Web Client.

NOTE: Readers should familiarize themselves with the Siebel Web Client 
configuration process described in Siebel Tools Reference before attempting to 
configure the Siebel Handheld Client.

Architectural Overview
The five layers in the Siebel Handheld architecture are comparable to those used on 
the Siebel Web Client: 

Application layer. The application layer starts and closes the application.

User Interface layer. The user interface layer renders the display and interacts with 
users’ actions.

Object Manager layer. The object manager layer provides a consistent object behavior 
and interaction between all business objects within the application.

Data Manager layer. The data manager layer maintains an object-oriented abstraction 
of the native data stored in the data repositories for the benefit of the object 
manager.

Database layer. The database layer includes the data that Siebel Handheld users will 
access.
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Unsupported Features
You configure an application using Siebel Tools and compile the Siebel repository 
(.srf) file. During the synchronization process, information specific to the Siebel 
Handheld Client is extracted from the Siebel repository file. This information is used 
to create a repository meta language (.rml) file, which is downloaded to the 
handheld device. The repository meta language file has all of the layout information 
for the handheld device. For more information, see Siebel Tools Reference.

Unsupported Features
The differences between configuring user interface elements for the Siebel Web 
Client and the Siebel Handheld Client are shown in Table 2.

The following are not supported in Siebel Handheld applications:

■ The following applet types are not supported:

■ Chart

■ Explorer

■ More than two applets per view is not supported. A maximum of two applets 
may be displayed at one time.

■ Group boxes are not supported. See “Group Boxes” on page 37 for information 
on how to accommodate this limitation.

■ Alarm Manager is not supported. Therefore, if an alarm check box is added to 
an applet and the check box is selected, no alarm will sound.

■ The base time zone is determined by the system settings on the server and 
cannot be changed on the handheld device.

Table 2. Configuring Siebel Client User Interface Elements

Client Siebel Tools SWT Template Files
Specialized 
Algorithms

Siebel Web Client Yes Yes No

Siebel Handheld Client Yes No Yes
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■ Alphabet tabs are not supported.

■ Scripting is not supported. However, any scripts on the business components 
will be executed during synchronization.

■ Siebel Workflow is not supported. 

Multi-Value Groups (MVG)
The Multi-Value Group applet is not supported on the Siebel Handheld Client; 
however, the Multi-Value Group relationship is supported. The Multi-Value Group 
(MVG) control button does not appear on fields in Siebel Handheld Client 
applications. Instead, MVGs can be implemented as parent-child views. As a result, 
MVG fields are not editable within the parent record. In the Siebel Web Client, 
addresses of accounts are added, deleted, or edited through the Business Address 
MVG applet. However, in the Siebel Sales Handheld Client, these functions must be 
done through a Business Address child applet with an Account applet as its parent.

On the handheld, all MVG fields are displayed as read-only fields with the primary 
record visible. If you have an application or business requirement that requires the 
user to view or update all the records in the MVG, you must configure a separate 
view for that MVG. For example, the Address field in the Accounts or My Accounts 
view is an MVG. In the Siebel Handheld Client that field is read-only and displays 
the primary record. In order for the handheld user to see and update the addresses, 
the new Address view is configured in Siebel Tools. This new Address view is visible 
in the Show drop-down list.

CAUTION: Multi-Value Group fields are automatically displayed as read-only fields in 
the handheld application. If the fields are set to be editable, the application will 
crash during synchronization.
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Unsupported Features
Functions
Siebel Handheld applications support most of the calculated fields and operations 
used in the Siebel Web applications with a few exceptions. See Table 3 for a list of 
the unsupported functions.

The NOT key word is not supported on booleans. Use the != operator instead. For 
example, "Active" != "Y".

The RowIdToRowNum function is supported differently in the handheld 
applications than in the Web applications. In Web applications, RowIdToRowNum 
converts a row Id to a numeric value. In the handheld applications, it returns the 
row ID itself.

Table 3. Unsupported Functions

Function Name

BCHasRows GetXAval*

DockingNodeId IsDocked

DockingNodeName LanguageName

DockingNodeRoutId LocaleName

EAILookupExternal LookupMessage

EAILookupSiebel LookupTranslation

EXISTS NOT

GetHQInstanceId RepositoryId

GetHQInstanceName RepositoryName

GetNumBCRows RowIdToRowNum

GetProfileAttr* ToolsLanguage
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The first step in configuring a Siebel Handheld Client is to determine which user 
interface elements are necessary. Keep in mind the differences in display size, 
memory capacity, and input methods between handheld devices and larger 
computers, such as desktop computers.

The goal is to create applications that are easy for your end users to use and which 
take advantage of the strengths of the handheld device platform. Because of 
processing speed, memory limitations, and form factor differences, you should only 
include those user interface elements that are necessary for users to complete their 
job responsibilities.

General Guidelines
The following list provides some general guidelines for defining user functionality:

■ Limit the number of screens and views.

■ Design each view so that it has one or two applets.

NOTE: In some instances, Siebel Systems found it necessary to create a view with 
three applets in its handheld applications. For these views, a toggle button was 
added to the applet so that the user can easily navigate between the two child 
applets.

■ Design each applet so that it only contains columns and fields that are required 
for end-user tasks. 

Use these guidelines when you design any new objects for the Siebel Handheld 
Client. This approach facilitates a logical separation of the Siebel Handheld Client 
user interface elements from the Siebel Web Client user interface elements. This is 
important because very few applets are shared between the two types of clients.
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Taking Advantage of the Handheld Device
Siebel Handheld Client users have different requirements from Siebel Web Client 
users. Typically, handheld devices have limited screen space and use different 
methods for entering data, such as smaller keyboards or a touch-sensitive screen. 
By keeping the Siebel Handheld Client user experience in mind, you will build 
applications that will allow your users to be more productive. Some guidelines for 
taking advantage of the handheld device are discussed in the following sections.

Identify User Activities
To conserve memory (and thereby improve performance) and ease navigation, 
identify business processes that are required by end users and develop applications 
that support these processes. If more than one type of user needs a Siebel Handheld 
Client application, it is preferable to divide the application into multiple 
responsibilities rather than give all possible users access to all available screens and 
views. Responsibilities are fully configurable by the application developer.

Support Stop-and-Go Workflow
Design Siebel Handheld Client applications to support a stop-and-go workflow. End 
users interact daily with the Siebel Handheld Client application, performing 
job-related tasks. These end users frequently start the Siebel Handheld Client 
application, navigate to data, read or enter data, and later return to the application 
to resume entering information. Frequently, an end user needs to navigate to 
another view to retrieve information while in the middle of a task. Design your 
applications so that end users perform a minimum number of taps to navigate to 
the desired information.

Design Applications That Require Minimal Navigation
Design applications that are as flat as possible. In a Web-based application, you may 
have views with many applets, and the user toggles between the applets. However, 
for handheld applications, create a larger number of views with fewer applets to 
allow users to quickly find information with a minimal amount of toggling.

Design for the Handheld Screen
Consider the type of handheld device that is being used and the way the screen is 
laid out. Consider the following questions when designing your applets:
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■ Are the applets laid out side by side (on a HPC 2000 handheld device) or stacked 
one on top of another (on a Pocket PC handheld device)?

■ If you are using a list applet, how wide is that list applet going to be? 

■ What are the most important fields and columns that a user needs to see at a 
glance before scrolling? 

■ If you have a form applet that is a parent, for example, what fields do you really 
need in order to avoid scrolling?

Because there is less screen space on a handheld device than on a laptop or desktop, 
the most important data should be immediately visible.

Creating a Handheld Project
The Siebel Handheld projects appear in the list of projects in Siebel Tools; when 
Project is selected in the Object Explorer, the list of projects is displayed in the 
Object List Editor.

Use a naming convention that allows you to easily identify applications, screens, 
views, and applets belonging to a particular Siebel Handheld application. This 
allows you to locate all the object definitions in a handheld application by querying 
on the name in the Object List Editor. For example, all of the Siebel Handheld Client 
screens, views, applets, toolbars, and menus use either an SHCE prefix (for 
example, SHCE Sales Account List View) or a CE suffix. Use the Object List Editor 
to query for views that contain the prefix SHCE or the suffix CE; doing so displays 
all of the Siebel Handheld Client views.

If you create a new Siebel Handheld application, create a new suffix or prefix to 
identify the name of the application and each screen, view, and applet name. For 
example, you could use PPC_SHCE for an application that is designed for handheld 
devices using the Pocket PC operating system.
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Each view in a handheld application can display a maximum of two applets at a 
time, regardless of the number of applets in the view. If there are more than two 
applets in a view, the user can navigate to additional applets by toggling. For more 
information, see “Multiple Applet Views” on page 32.

Multiple Applet Views

Screen Allocation
The amount of screen space available for applets is determined by the handheld 
device’s operating system and the type of applets in the view.

For handheld devices using the Pocket PC operating system, the two applets are 
stacked one above the other. A parent form applet in a two-applet view displays up 
to five fields on the screen. The form applet dynamically resizes if there are fewer 
than five fields and, therefore, does not waste screen display space with empty 
lines. The maximum number of fields that are displayed at one time is configurable 
by setting the Max Parent Applet Size preference in the User Preferences dialog. See 
“Setting User Preferences” on page 134 for more information on this user 
preference.

Toggling Between Multiple-Applet Views
The Siebel Handheld Client application displays up to two applets at one time. If the 
view has only one applet, the applet takes up the entire display area. For views with 
two or more applets, the first two applets in the view are displayed, and the user 
toggles to see the other applets. The first applet is always displayed and the second 
applet changes as you toggle.

By default, the user toggles by choosing the View > Toggle menu item. In addition, 
it is recommended that you provide a toggle button as a visual cue to the end user 
that there are additional applets. Add a toggle button to each applet except the first 
applet. Identify the button with a Toggle caption and set methodInvoked to 
ToggleApplet.
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Drill-down Only Views
Some views may be drill-down only views—that is, they can only be accessed by 
navigating from another view. These views should not be accessible through the 
Show drop-down list. However, when the end user navigates to the view, the view 
title appears in the Show drop-down list. To configure a drill-down only view, set 
the view title as you would for any other view and set the ScreenMenu property to 
FALSE. See Siebel Tools Reference for more information.

Applet Focus Behavior
When navigating between views, there may be instances when you need to override 
the default behavior for giving focus to an applet

The GotoView method is used to navigate from one view to another. A button 
control is added to the applet in the view you want to navigate from, the button’s 
methodInvoked property is set to GotoView and the button’s View property is set 
to the view that is to be created. When the GotoView method is executed, it builds 
the specified view. If the view includes a parent and child applet, GotoView gives 
focus to the child applet. This is the desired behavior in most instances when you 
are simply navigating from one view to another.

If the desired behavior is to navigate to a new view and, additionally, create a new 
record, then you must use the GotoViewNewRecord method. This method calls two 
methods; it calls GotoView, and then it calls NewRecord, which creates a new 
record in the new view. 
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In some instances the default behavior of these methods does not produce the 
intended behavior. For example, in the Orders view of the Service Requests screen, 
when you tap the Create New Order button, it takes you to the Order Details view, 
which contains a parent form applet (Service Request Order) and a child list applet 
(Service Order Entry Line Item). In this instance, when the Create New Order 
button’s GotoViewNewRecord method is executed, you want a new order to be 
created. However, the default behavior is to give focus to the child applet rather 
than creating a new record in the parent applet. Therefore, you need to override the 
default behavior of GotoView with the control user property OverrideDefaultApplet, 
and set the value to the applet that you want to give focus. The valid values are 0 
(parent), 1 (child), 2 (grandchild), and so on. For example, if you create a button 
labeled “Create Service Request Order,” you would define the following user 
properties:

Views with Associated Print Templates or Reports
Print templates are text files that you design and create for printing. After creating 
a print template, you associate it with an applet. When an end user chooses to print 
a view, the print template that is associated with the applet is automatically selected 
and used for printing. Follow these guidelines when creating print templates:

■ Only one print template can be associated with an applet.

■ The print template name for a particular display applet is registered in the Mail 
Template property in the Applet object associated with the applet.

■ The template must be placed in the Templates directory.

■ The template name that goes into the Mail Template property should not include 
a path name or extension. For example, if the full path of the template is 
\Program Files\Siebel Handheld\Templates\InvoiceTemplate.txt, you would 
enter only the root name InvoiceTemplate in the property field.

■ The template file itself must have a .txt extension on the device.

Name Value

View SHCE Service Order Line Items View

OverrideDefaultApplet 0
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For more information, see Appendix F, “Print Configuration Settings.”

Configuring User Interface Elements
When configuring user interface elements on the Siebel Handheld Client, also 
consider the processing speed and memory constraints of handheld devices. The 
constraint on processing speed affects the performance of a handheld device. The 
performance of a handheld device is also related to the number of screens and views 
downloaded to the handheld device. Because handheld devices are not meant to 
provide the same functionality as larger devices, such as laptops, the number of 
screens and views must be kept to a minimum on the handheld device.

Due to size constraints on handheld devices, the Siebel Handheld Client displays 
user interface elements differently from the Siebel Web Client. Consider these 
differences when configuring the Siebel Handheld Client application. For example, 
Siebel Handheld Client does not support an alphabetical index.

List Applets
List applets display in the Siebel Handheld Client application almost identically to 
their display on the Siebel Web Client. The list columns in the Siebel Handheld 
application are identical to the list columns that appear as Applet Web Template 
Items under the Applet Web Template.

The recommended strategy when configuring the Siebel Handheld Client is to use 
the list applets for record navigation and to rely on form applets to provide the 
record details.

The following are additional guidelines to follow when designing list applets:

■ Configure specific list applets for your handheld application, rather than reusing 
Siebel Web Client list applets.

■ Remove all but the essential list columns. Because there is limited screen area to 
display list columns, omit all unnecessary columns to minimize horizontal 
scrolling. You may either remove the columns from the application or set the 
Show in List property on the column to FALSE.
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■ Reorder the remaining list columns so that the most frequently used columns are 
furthest to the left.

■ Reduce the default width of the list columns so that more columns can be 
viewed at one time.

These changes can minimize the amount of horizontal scrolling and column 
reordering that a user must do. Limiting the number of list columns to the essential 
ones minimizes the amount of data downloaded to the device, resulting in faster 
synchronization times and more economical use of device memory.

NOTE: All required fields on form and list applets appear with an asterisk (*). If an 
administrator specifies that a field is required, the field appears with an asterisk in 
the user interface.

When designing list applets, consider using hyperlinks on the list applet as a 
convenient way to drill into the form applet.

Use the Web Applet Designer in Siebel Tools to add, remove, or rearrange list 
columns. Open the applet in the Web Applet Designer and choose the List Columns 
option from the Format menu. For more information on the List Column options, 
see information about the Siebel Web Applet Designer in Siebel Tools Reference.

You may make columns available, but not visible by default, by setting the Show In 
List property of the column to FALSE. From the handheld application, you can make 
the columns visible from the View > Columns Displayed menu option. In order for 
the change to be reflected in the application, you must compile the application and 
synchronize with the handheld device. In addition, you must delete the \Program 
Files\Siebel Handheld\siebel.ssf file on the handheld. If this file is not deleted, the 
change to the Show In List parameter will not be reflected in the application.

Form Applets

Layout Sequence
When configuring for the handheld device, the Applet Web Template Items in the 
Applet Web Template determine the controls that appear on a form applet. The 
layout of form applets on the handheld device is determined by the HTML Sequence 
field set on control objects.
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The HTML Sequence field determines the screen layout of a handheld device. 
Controls are ordered from top-to-bottom based on their HTML Sequence property 
values. Label and control pairs that do not fit on the same line as other label and 
control pairs wrap to the next line.

Labels
Keep field labels in applications using the Pocket PC operating system short 
(approximately 12 characters or fewer, depending on the character width). Use 
abbreviations where possible. Labels that are too long are truncated.

Group Boxes
Group boxes are not supported and are not displayed in form applets, even if they 
are added in the Web Applet Designer. Therefore, reword the field labels to include 
group box information if necessary. For example, you may have two group boxes on 
the form, one labeled Ship To and another labeled Bill To. Each group box includes 
a field named Address. Because group boxes are not supported, the Ship To and Bill 
To labels will be lost, and two fields with the identical Address label will remain. 
Therefore, you must rename the Address labels “Ship To Addr” and “Bill To Addr,” 
or some other label that distinguishes them.

Auto Pop-Up Lists
Sometimes when a user is navigated to a new view, there is an action he or she must 
perform, for example, filling in a required field by selecting a value from a pop-up 
list. Rather than requiring the end user tap the control to open the pop-up list, you 
can configure the view so that the pop-up list automatically opens when the end 
user gets to that view. To configure a pop-up list to open automatically, add the user 
property on the applet with Name set to AutoPopupField. Depending on the type of 
applet, this property is set differently:

■ For list applets, set the AutoPopupField property to the Business Component 
field name.

■ For form applets, set the AutoPopupField property to the name of the control.
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Home Page Applets
To configure a Home Page applet, create an applet that has controls of HTML Type 
Button only. Use the following guidelines in creating your Home Page applets:

■ Set the MethodInvoked property of these controls to GotoView. Then add a user 
property for the control, and set the Name parameter to “View” and set the Value 
parameter to the view name.

■ Set the Caption field.

■ Set the HTML Sequence field according to the order in which the buttons are laid 
out on the device. The buttons appear on the Home Page applet of the handheld 
device, laid out in rows of three buttons.

■ Set the class property of the Applet to CSSFrameCEHome.

All pick data is not downloaded to the device due to the memory constraints on the 
device. Only pick data for fields that are editable is downloaded. Therefore, if you 
are doing a query on a pick field, you may not be able to display the picklist. When 
viewing a record in an applet, if a pick field is read-only, its pick button will be 
disabled. If end-users select a read-only field with a pick control, they receive the 
following error: No data available in picklist because field is read-only.

Figure 3. Home Page Applet Example
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Data in picklists are filtered like any other data in a handheld application. For 
information on how to filter picklists, see Chapter 4, “Data Filtering.”

NOTE: Catalogs control visibility of data in pick applets. To make sure that pick 
applets contain valid data, the administrator must add data to a relevant catalog and 
make sure users have visibility to the catalog using the Catalog screen’s Access 
Groups view tab. For more information on assigning user access to catalogs, see 
Siebel eSales Administration Guide.

Buttons
Set the HTML Type field on buttons to Button, MiniButton, PushButton, or 
MiniButtonEditNew. All of these HTML Types map to the same button control on 
the handheld device.

Buttons with text labels on them are sized to the minimum width required to fit the 
text on the buttons.

NOTE: You cannot use scripting to augment the button functionality in handheld 
applications.

See “Toggling Between Multiple-Applet Views” on page 32 for more information on 
toggle buttons.

Menu Bar
You can use the same menu configuration for handheld devices using the Pocket PC 
operating system. The menu in Siebel Tools that is used for the handheld 
applications is SHCE Generic. The default menu bar configuration for the Siebel 
Handheld Client includes the following menus: File, Edit, View, and Help. You may 
remove or rename menus on the menu bar, but you cannot add new menus. You 
may reorder the menu items by changing the Position property for the menu items. 
Generally, use the default menu bar configuration for all of your Siebel Handheld 
Client applications.
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Toolbars
This section describes how to configure the toolbar for your application.

Table 4 shows the supported toolbar functions for the Pocket PC 2002 operating 
system.

On the Pocket PC 2002 operating system, the default toolbar can be configured in 
Siebel Tools by configuring the SHCE Main toolbar object. SHCE Main is the main 
toolbar that is downloaded to the handheld device. If a toolbar named SHCE Main 
does not exist in your repository, a default toolbar, Main, is downloaded instead.

The SHCE Main toolbar contains the default buttons for the device, Back, Forward, 
New Record, New Query, and Execute Query. Change the order of the buttons on 
the display by modifying the Position property of the toolbar items. Remove a 
toolbar button by deleting it or making it inactive.

You can add additional default buttons to the toolbar by creating toolbar items 
whose Command property matches the name of an active bitmap in the SHCE 
Command Icons bitmap category. Do not add bitmaps to the SHCE Command Icons 
bitmap category because only those commands, which are already provided, are 
supported on the device. No additional commands are supported. You can remove 
a bitmap or make a bitmap inactive if you do not want it to appear in the Customize 
Toolbar dialog box.

Table 4. Pocket PC 2002 Toolbar Functions

Pocket PC 2002 Toolbar Functions

Back, Forward

New Record

New Query, Execute Query

Next Record, Previous Record, First Record, Last Record

Minimize, Maximize

Delete Record
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You can change the bitmap for a toolbar by reimporting the bitmap from the SHCE 
Command Icons bitmap category.

An end user can personalize the toolbar by selecting View > Customize Toolbar.

For more information on toolbars, refer to Siebel Tools Reference.

Status Bar
The location and type of information available on the status bar depends on the 
operating system of the handheld device.

On the Pocket PC operating system, the status bar is located above the toolbar. The 
status bar displays the status of applet with focus, including the applet title and 
record item count (for example, Contacts: 1 of 13).

Hyperlinks
Configuring a hyperlink or dynamic hyperlink in the Siebel Handheld Client is 
performed the same way as in the Siebel Web Client. For more information on 
configuring hyperlinks and dynamic hyperlinks, see Siebel Tools Reference.

Preventing Synchronization Conflicts
Because multiple users are synchronizing with the server, conflicts may occur when 
any single user synchronizes their handheld. For more information on how to 
configure your application to prevent synchronization conflicts, see Chapter 6, 
“Synchronization Conflict Handling and Recovery.”

Recommended Configuration Guidelines
The Siebel Handheld Client application will perform best if you use the following 
guidelines: 

■ Keep the number of views in your application to 30 or fewer.
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■ For optimal usability, limit each view to one or two applets.

■ To minimize horizontal scrolling, limit the number of columns displayed in a list 
applet to no more than ten.

■ There is no limit on the number of fields in form applets of single-applet views. 
However, to minimize scrolling, keep the number of fields to 20 or fewer.

■ For each screen, create a view called My * or All * as a single list-applet view. 
For example, for the Activities screen, create a My Contacts view that has the 
Contacts list applet only.

■ For each screen, create a single-applet More Info view. Create this applet as a 
form applet. For example, for the Contacts screen, create a More Info view that 
has the Contacts form applet only.

■ Use a form applet for the parent for each parent-child view.

■ In a multi-applet view, limit the number of fields in form applets to five or fewer. 
Add additional fields only if the field width is short—for example a check box 
field. Reduce the number of fields if the fields are multiline—for example, a 
Comments box that contains three lines of text.

■ Do not include read-only check boxes in form applets. It is very difficult for users 
to discern that the check box is not editable.

■ Limit the number of views within a screen to 12 or fewer so that the View 
drop-down list is not too long and unwieldy.

■ Limit the number of screens to six or fewer so that the Screen drop-down list is 
not too long and unwieldy.

■ Keep query names to about 15 characters or fewer, so that they fit in the Queries 
drop-down list. For example, North American Organization is too long for a 
query name, so you should change it to a shorter name, such as N. American 
Org. The number of characters is a general guide because characters vary in 
width (for example, W is wider than i).

■ Keep screen names to about 15 characters or fewer, so that they fit in the Screen 
drop-down list. The number of characters is a general guide because characters 
vary in width.
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■ Keep view names to about 20 characters or fewer so that they fit in the View 
drop-down list. The number of characters is a general guide because characters 
vary in width.

■ Limit the size of the dbfile.txt file to less than two megabytes (MB). The RDBMS 
on the handheld device will be approximately three times the size of dbfile.txt. 
If the data files are so large that they cannot be imported into the database with 
the available memory, users will not be able to successfully synchronize their 
data. See Chapter 4, “Data Filtering,” for information on how to design data 
filters to limit the amount of data that is synchronized to the handheld.

Compiling the Application
Compiling the repository for the Siebel Handheld Client is identical to compiling on 
the Siebel Web Client (see Siebel Tools Reference). Perform a full compilation the 
first time; subsequent compilations can be incremental, replacing only the projects 
that are affected. This assumes that you have organized all of your handheld object 
definitions in one project or a limited set of projects.

When you compile your application, a Siebel repository file (.srf) is created and put 
in the destination directory you specified during the compile procedure. Make this 
.srf file the source of repository information for the Siebel Handheld test client 
machine, defining all Siebel applications for that client, when you move it to your 
local \Siebel\objects directory.

It is strongly recommended that you make a backup of the existing .srf file in your 
local \Siebel\objects directory before overwriting it with the new one. That way, if 
you make an error or you want to revert to the original application, you have a 
backup that you can easily restore. For more information, see Siebel Tools Reference.

Configuring Printing from the Handheld
Users may print from any view in the application. However, they are not necessarily 
printing what they see on their screen. They may print a portion of the data they 
view or data that is not viewable at the time.A print template defines the document 
that is to be printed. After the template has been defined, it must be associated with 
an applet in a view.
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This section provides information on the following topics:

■ Defining documents

■ Designing print applets

■ Configuring applets for printing

■ Creating print buttons

■ Creating print templates

Defining Documents
Defining documents for printing includes several steps:

■ Determine the documents your users will need to print.

■ Determine the views from which they are most likely to print the documents.

■ Lay out the document for printing.

Determining which documents users will need and the views from which they are 
most likely to print requires that you have a good understanding of the users’ 
day-to-day work.

Whether the existing applets in a view include most of the required data or only a 
small portion is a secondary consideration. It is not likely that a printout of the 
existing applets, which are formatted for an electronic PDA interface, will provide 
an acceptable or usable printed document. In most instances, you need to create 
additional applets that are specifically used for printing data.

The printed document will be composed of several applets which are added to the 
view. The applets pull the data from the underlying business components which are 
a superset of the data in the view. These applets, in turn, direct the data to the print 
templates discussed in Appendix E, “Print Tagging Language.”
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Designing Print Applets
The print template references applets associated with the view and is how you 
specify what data appears in the printed document. As you design your applets, you 
should be aware of the print specifications of the printers used in the field. Portable 
printers typically print on two-inch or four-inch wide paper. You need to design your 
applets so that the data fits within the limits of the paper width. Keep your 
documents simple so that they will work with different sizes of paper. The following 
are some guidelines to use when designing your applets to accommodate the 
smaller paper sizes.

Form Applets
Data from only one business component can be displayed on each line in your 
document. When you design your form applets, keep in mind that you can display 
a maximum of two columns of data in form applets. You can specify that each 
column of data is preceded by an optional caption column. This means you can 
have up to four columns displayed in your document—two data columns and two 
caption columns. Alternatively, you may have no captions, and simply display one 
or two columns of data.

The ratio between caption and data columns is, respectively, 35 percent and 65 
percent. This is a fixed relationship that cannot be customized in the template.

List Applets
When specifying the width of a column, you can either specify it with a unit of 
measurement or as a percentage of the total page width. For example, you can 
specify that the first column is 20 mm, and the second column is 40 mm. If the 
width of the paper you print to is narrower than 60 mm, the column widths 
automatically adjust to fit the printable width as a proportion of the specified width. 
Therefore, the first column will always be 33 percent, and the second column will 
be 67 percent of the paper width. The minimum width for a column is 8 mm, which 
includes a 3 mm gutter margin between columns.

You can specify any number of columns in your list applet. However, if the width 
of the column is less than 8 mm, the application ignores the column and does not 
print it.
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On narrow paper widths, data from a field may not all fit on one line. Data that does 
not fit can be specified, in the Applet tag, to wrap to the next line and keep 
wrapping until the data in that field is completely displayed. The printable width of 
the page is equal to the paper width minus the left and right margins (PaperWidth 
– [LeftMargin + RightMargin]). These parameters are set in the setup.ini file. For 
more information on setting these parameters, see Appendix F, “Print Configuration 
Settings.”

Configuring Applets for Printing
Configure print applets as you would any other applet using Siebel Tools. In 
addition, set the following properties for each applet in the view.

■ Set the HTML Popup Dimension value to 0x0. 

The 0x0 setting hides the applet from the end user who should not see the applet 
that is used to generate the document. Exposing these applets would complicate 
a product that is tightly configured for an effective and efficient workflow on a 
small mobile device.

NOTE: For compatibility with previous versions, Siebel Systems continues to 
support the name, Popup Dimension, for this property. However, it is 
recommended that you use HTML Popup Dimension.

■ Set the name of the Mail Template to be the name of the print template file. For 
more information on the print template file, see “Creating Print Templates” on 
page 47. For more information on the Mail Template property, see “Views with 
Associated Print Templates or Reports” on page 34.

Configuring Print Buttons
While users can use the File > Print menu option to print a document, it is helpful 
to include a Print button on the applet to give users a visual reminder that it is 
possible to print from a particular view.

When you design your applets, keep the following in mind when deciding where to 
place the print button:
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■ Add the print button to the applet that is visible to the user. Do not add the print 
button to the print applet, which the user never sees.

■ Consider what the desired behavior is when determining the placement of a 
print button. 

For example, in a parent-child view, you may want to add the print button to the 
parent applet to ensure that the print button is always enabled. This is not 
necessarily true if the print button is placed on the child list applet. If there are 
no items in the list applet, the print button is disabled, and the end user will not 
be able to print from that view. If you only want the end user to print when there 
are list items, then placing the button on the child list applet is appropriate.

To configure a print button

1 From Siebel Tools, add a control to the print applet and specify HTML Type = 
Button.

2 Set Method Invoked = Print.

3 Set the Display Name property of the button. Generally, this is set to Print.

Creating Print Templates
Once you have identified and created the necessary views, you are ready to create 
print templates. A print template is a text file that includes instructions for printing 
a document. It specifies the data to be printed, document layout options, and text 
formatting. These instructions are specified using a print tagging language that is 
described in Appendix E, “Print Tagging Language.”
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Testing the Handheld Application
Before deploying your application to your end users, be sure to thoroughly test the 
application by synchronizing to a handheld device. The handheld configuration is 
downloaded to the device where you can test the functionality and verify that you 
have the desired behavior. Another equally important aspect of handheld testing is 
to check to see how much data is downloaded to the device. If too many records are 
downloaded, this increases the length of time it takes to synchronize the handheld 
and slows down the application performance. Check the server log file to see how 
many records are downloaded for each business component. You must set the 
LoggingLevels parameter to 25555 to capture this information in the log file. 

For more information on the LoggingLevels parameter, see “Configuring Server 
Logging Levels” on page 83. For more information on the server log files, see “Direct 
Server Sync Log Files” on page 174 and “Companion Sync Log Files” on page 175. 
For more information filtering data, see Chapter 4, “Data Filtering.”
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This chapter describes the application administration procedures for Siebel Sales 
Handheld. These administrative procedures help to make the application run more 
efficiently on the device. 

The audience for this chapter is Siebel application administrators.

Assigning User Responsibilities
You must create user accounts and assign responsibilities and passwords for each 
handheld user. The steps are the same as those for creating user accounts, assigning 
responsibilities and passwords for the Siebel Web Client. See Applications 
Administration Guide for more information on this topic.

Administering Handheld Views
There are two administrative tasks associated with handheld views:

■ If you have added a new view or changed the name of a view, you must add the 
view or update the name of the view in the Application Administration screen.

■ Specify the default views in the configuration file.

Adding Views to the Application
Add new views to the Siebel Handheld application from the Application 
Administration screen in any Siebel Web Client application. You must be logged on 
as an administrator. (If you are using the Siebel Mobile Web Client to log in as an 
administrator, you must also specify the /editseeddata parameter.)
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To add new views to Siebel Handheld

1 Launch the Web Client application that uses the same database that the 
handheld application synchronizes to (or will use to synchronize to).

NOTE: If you launch the application from a mobile Web client, specify the 
/editseeddata parameter.

2 In the Siebel Web Client, from the application-level menu, choose View > Site 
Map > Application Administration > Views.

3 Add the new views.

4 From the application-level menu, choose View >Site Map > Application 
Administration > Responsibilities.

5 Associate each view with the appropriate handheld responsibility.

6 Add appropriate users to the responsibility.

NOTE: For more detailed instructions on adding views and associating views with 
responsibilities, see Applications Administration Guide.

Specifying Default Views in the Configuration File
The Siebel Handheld application uses a small subset of views in the Siebel 
enterprise application. Because there are memory resource constraints on the 
handheld devices, it is recommended that you extract only those views that are used 
on the handheld.

There are two methods for specifying which views will be extracted to the 
handheld. The first method is to compile an .srf of only those views that are relevant 
to the Siebel Handheld application. Or, alternatively, you may specify the handheld 
views in the Siebel Handheld configuration file located in the 
\siebsrvr\BIN\Language directory (Direct Server Sync deployments) or 
client\BIN\Language directory (Companion Sync deployments), where Language is 
the language of the application (for example, ENU for English).
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The views are specified in the [PDA] section of the handheld configuration file 
(salesce.cfg). By default, all views for the handheld application are listed here. Edit 
the list so that only those views which your application is using appear in the list. 
Use the following syntax to specify the views:

DefaultViews1="view_name"
DefaultViews2="view_name"
DefaultViews3="view_name"
DefaultViewsn="view_name"

where view_name is the name of the view as it appears in Siebel Tools. The name 
must match precisely or it will be ignored during synchronization. It is 
recommended that you copy and paste the name from Siebel Tools into the 
handheld configuration file.

The combination of the .srf file, the handheld .cfg file, and the user's responsibility 
determines which views are extracted. Siebel Server uses the information in the 
handheld configuration file and the .srf file during synchronization in the following 
way:

■ If no default views are specified in the handheld configuration file, all the views 
in the .srf are extracted during synchronization. If the .srf contains only the 
handheld-specific views, then this is the same as listing each handheld view in 
the handheld configuration file.

■ If default views are specified in the handheld configuration file, then only those 
views are extracted. If there are some views that do not match the views in the 
.srf file, these are ignored.

■ If default views are specified in the handheld configuration file, but none of the 
views match those listed in the .srf file, then all the views in the .srf are 
extracted.
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Preventing Synchronization With Another Handheld 
Device

End users should not synchronize their mobile client database with any other 
handheld device except their own. Doing so can result in data integrity errors and 
data loss. Siebel Handheld ties a companion PC to a specific handheld device and 
prevents the end user from synchronizing with another end user’s handheld device. 
Uninstalling the software from the companion PC and the handheld device does not 
remove this link. If you need to remove the link between the two, contact Siebel 
Technical Support for the hhunlock.exe utility.
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This chapter provides information on deploying and developing data filters. 
Effective filtering is a key component of handheld deployment. Filtering restricts the 
amount of data downloaded to the handheld device in order to accommodate the 
reduced memory and processing resources of the handheld device. The user 
experience is improved if Siebel Handheld users do not need to navigate through 
unnecessary records. Device performance and synchronization times are improved 
as well.

The audience for this chapter is Siebel application administrators and Siebel 
application developers.

Types of Data Filters
There are three filtering methods that can be used to control the data synchronized 
to the handheld, which are discussed in greater detail later in this chapter.

■ Repository Configuration. By specifying links between business components in 
business objects, you are filtering the data that gets downloaded to the device. 
These links are defined in Siebel Tools by the application developer.

■ Query by Example Filters (QBEs). QBEs are business component-level filters that 
are primarily used to filter data at the business component level across all 
business objects. It defines the overall set of data available to the handheld. This 
filtering mechanism is used to provide handheld-specific business component 
level filtering and to define the overall set of data available to the handheld 
application. QBEs can also be used to filter picklists. It is strongly recommended 
that these filters be thoughtfully designed and be in place before synchronizing 
data to the handheld.
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■ Predefined Query Filters (PDQs). PDQs, sometimes called synchronization filters, 
select data at the business object (screen) level. End users use PDQs to select the 
data downloaded during synchronization. The list of PDQs appear in the Set 
Filters dialog box.

Users select one PDQ filter per business object, or one per screen. Therefore, all 
views in the same screen must be associated with the same business object. The 
filters apply to the screen the same way PDQs apply to screens in the desktop 
applications. The data on all views within the Handheld application screen is 
filtered by the PDQ filter.

Developing Data Filters
Siebel Systems suggests the following general steps for developing Handheld 
synchronization filters.

■ Identify the screens and views of your application. Then identify the business 
components that are required to support each screen and view, noting the areas 
where each business component occurs. For example, identify the form, list, or 
pick applets that are based on each business component.

■ Within Siebel Tools, establish the base parent-child relationships and any 
reverse relationships at the component level.

■ Review the business components that occur in picklists and consider creating 
default sync filter declarations for those that will cause large numbers of records 
to synchronize to the device. These declarations are maintained in the PDAQBE 
file.

■ For each business component, determine whether it is possible to apply a search 
specification to all instances of the business component within the handheld 
application. Develop a set of suitable Query by Example (QBE) declarations in 
the PDAQBE file. Common examples of business components that are suitable 
for global QBEs include: 

■ Employees (for large organizations)

■ Activities (for example, filter for current Activities, Activities of only certain 
kinds)
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■ Accounts (for example, by geography) 

■ Products (for example, active, orderable products)

■ Orders (for example, open, closed in last three months)

■ Create appropriate PDQ synchronization filters for each business object or 
screen and make sure that each screen includes a default filter. Default filters 
make sure that users avoid accidental download of an excessive number of 
records.

Query by Example Filters
During the synchronization process, the synchronization engine accesses a text file 
that contains handheld-specific filters applied at the business component level. 
These filters are QBE (Query by Example) statements that apply only to the 
handheld data extraction, so you can think of these QBE filters as handheld-specific 
business component search specifications. You can combine these QBE filters with 
PDQ synchronization filters or search specifications defined in Siebel Tools for 
flexible data filtering. There is one PDAQBE file per application on a server. (The 
PDAQBE file is the file defined by the PDAQBEFile parameter in the .cfg file. The 
PDAQBE file is located in the Siebel Root\siebsrvr\BIN\language directory for DSS 
deployments and in the Siebel Root\client\BIN\language directory for CS 
deployments.) Therefore, if you require different QBE definitions for different user 
populations, you will need a separate server for each PDAQBE file.

Unlike the PDQ filters, which are visible to the end user and can be selected through 
the Set Filters dialog box of Siebel Handheld Sync, QBE filters can only be created 
by the administrator and are hidden from the end user. QBE filters are always 
applied when the end user synchronizes a handheld device.
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 55



Data Filtering

Query by Example Filters
Adding Business Component Filters
The handheld PDAQBE file is installed by default into the \BIN\language directory 
of the Siebel Application Server or Siebel Mobile Web Client where the handheld 
application is installed. The name of the file is application-specific, but always ends 
with PDAQBE file (for example, pharmaceqbe.txt, cgceqbe.txt, salesceqbe.txt). You 
can create new QBE filters or modify the default QBE filters by editing this file 
directly. Changes are applied to all subsequent synchronizations. You can also 
change the name of the file PDAQBE file by adding the following line to the [PDA] 
section of the Siebel Handheld application .cfg file:

PDAQBEFILE = "PDA filename"

NOTE: The Siebel Handheld application configuration file is located in the \bin\enu 
directory of the Siebel server for DSS or in the \bin\enu directory of the Siebel 
Mobile Web Client application for CS.

To create new business component filters, add rows to the PDAQBE file. The syntax 
for new filters is as follows:

DefaultSyncFilterXXX = Business Component Name|QBE Statement

where:

■ XXX is a unique number. The numbers should be in sequential order.

■ Business Component Name is the name of the business component to which the 
filter is applied.

■ QBE Statement is the query language that limits the records downloaded for the 
specified business component.

For example, the following is a QBE Statement from the PDAQBE file:

DefaultSyncFilter1 = Action|[Status] = "Not Started" OR [Status] = 
"In Progress" OR ([Status] IS NULL) OR [Status] = "On Hold" OR 
([Status] = "Done" AND [Done] >= Today() - 7)
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In this example, a Siebel Handheld filter has been created for the Action business 
component. This is the business component that underlies Activities in Siebel 
eBusiness Applications. This filter limits the Activities extracted for the Handheld 
application to those whose Status field is Not Started, In Progress, Null, On Hold, 
or Done. Activities whose Status is Done will only be allowed if the Done date 
occurred during the past week.

The example also demonstrates how these global QBE statements should be used 
during deployment. In the example, the QBE limits the handheld Activity records to 
those that are current. For every handheld application user and for every occurrence 
of the Activity business component, whether in a parent-child view or a pick applet, 
Activities are limited to those specified in this QBE. While this particular filter will 
not apply to every handheld deployment where Activities are used, most customers 
can use these global QBEs to rule out large sets of data not appropriate or necessary 
for the handheld application user.
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Filtering Out List of Values
You can use QBE filters to filter out values that are not used in picklists in your 
handheld application. For example, there may be account types, such as Distributor 
and Competitor, that are only used by users in the Web Client application and are 
not used by sales representatives out in the field. By including only those values 
that are used by the sales representative, you simplify the application for the user 
and improve the application performance.

The following is an example of a QBE filter that filters List of Values (LOV):

DefaultSyncFilter1 = List of Values| ([Type])="ACCOUNT_TYPE") AND 
(([Value] = "Reseller") OR ([Value] = "Retailer"))

In this example, regardless of the number of values that have been defined for LOV 
type ACCOUNT_TYPE, only the Reseller and Retailer values are extracted to the 
handheld. 

Be careful when you use QBE filters on LOVs. Multiple screens and views may use 
List of Values, such as ACCOUNT_TYPE, and may require that different values 
appear in the list. To avoid data loss, carefully review your filters and verify that all 
the required values are included.

Predefined Query Filters
Siebel Handheld provides synchronization filters that allow users to select the data 
they want to synchronize to their handheld applications. These filters are 
specifically named Predefined Queries (PDQs) that reside in the Siebel database. 
During synchronization, Siebel Handheld Sync accesses the database and processes 
the handheld-specific PDQs. The user can select one synchronization filter from the 
Set Filters drop-down list for each screen in their application. The selected filter 
determines the parent data that gets downloaded to the device.

You may also define a sort specification in your PDQs. These sort specifications are 
applied when the data is displayed on the device and is helpful for displaying 
records in a particular order. An example of a PDQ that includes a sort specification 
is shown below. The sort specifies that Activity records display according to the 
required Start Date, so that the first activities to complete appear at the beginning 
of the activity list.
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Name:  PDA_Current Activities

Query: 'Action'.Search = "[Start Date] >= Today () - 90 AND [Start 
Date] < Today () + 365"

'Action'.Sort = "Start Date (ASCENDING)"

General and Default PDQ Filters
There are two types of synchronization filters in Siebel Handheld—general and 
default filters.

■ General sync filters. Filters users select to specify the records users want 
downloaded to their handheld application.

■ Default sync filters. Filters displayed by default the first time the user taps the 
Select Filters button on the Handheld Sync user interface or if the user 
synchronizes without first selecting a filter.

The naming convention for general sync filters is:

PDA_<filter name>

An example of a general filter name is PDA_My_Recent_Orders.See “Query by 
Example Filters” on page 55 for more information on filter naming conventions.

General filters with the PDA_ prefix appear in the Set Filters dialog when users 
synchronize their data and, if selected, in the handheld application in the Queries 
or Favorites drop-down list.

The naming convention for default sync filters is:

PDADef_<filter name>

or 

PDADef_*<filter name>

Default filters with the PDADef_ prefix appear in the Set Filters dialog when the user 
synchronizes their data and, if selected, in the handheld application in the Queries 
or Favorites drop-down list. Default filters with the PDADef_* prefix only appear in 
the Set Filters dialog; this filter does not show up in the application.
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There should only be one default query for each business object or screen. An 
example of a default filter is PDADef_Current Activities. The sync engine is 
case-sensitive, so pay close attention to using filter prefixes exactly as shown 
(PDA_, PDADef_).

CAUTION: Administrators must be sure to define a default filter for each screen in the 
handheld application. If no filters are applied during the synchronization process, 
an unacceptably high volume of data will probably be downloaded to the handheld 
device.
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All Records PDQ
The All Records PDQ has special implications for Siebel Handheld users. When an 
All Records PDQ has been defined for a screen, the user can select it from the 
Favorites or Queries drop-down list in the application. This PDQ returns all records 
for the primary business component defined for the screen. The purpose of this 
query is to eliminate a potentially confusing scenario for users.

Suppose a user chooses a synchronization filter called My California Accounts that 
applies to the Account screen and causes only Accounts with State = CA to 
synchronize to the handheld application. However, during the course of the day, the 
handheld user creates a new Account on the device with State = NY. When the user 
leaves and later returns to the Accounts screen, the original PDQ (State = CA) is 
applied, and the new NY Account is absent from views within the screen. If the user 
selects the All Accounts PDQ from the Favorites drop-down list on the device, the 
NY Account reappears.

To avoid this kind of confusion, you should create a PDQ for each screen following 
this naming convention:

PDAAll_<filter name>

The query syntax should be written to return all records.

An example of the All Records PDQ:

Name: PDAAll_All Activities, Query: 'Action'.Search = "". 

NOTE: This filter only appears in the application. It is not used during 
synchronization and does not appear in the Set Filters dialog.

See “Query by Example Filters” on page 55 for more information on filter naming 
conventions.
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Summary of PDQ Filter Availability
Table 5 summarizes how the different filters are used. Some filters are 
synchronization filters—that is, they are only visible when the user synchronizes 
their data. Other filters are display filters—these filters are only available in the 
handheld application and are used to filter the records that are displayed on a 
screen. Some filters are both synchronization and display filters.

Sales Handheld PDQ Filters
Table 6 shows the list of filters that come with the Sales Handheld product and the 
query defined for each filter. All filters are public—that is, they are visible to all end 
users. You may create additional PDQs or modify the ones that come with the 
product.

Table 5. Availability of PDQ Filters

Filter Prefix Synchronization Filters Display Filters

PDA_<filter name> Available Available, if selected during 
synchronization from the Set 
Filters dialog

PDADef_<filter name> Available Available, if selected during 
synchronization from the Set 
Filters dialog

PDADef_*<filter name> Available Not available

PDAAll_<filter name> Not available Available
62 Siebel Sales Handheld Guide for Windows-Powered Devices Version 7.5.3



Data Filtering

Predefined Query Filters
The Sales Handheld application includes all PDQs for all of the Siebel Handheld 
applications, some of which are not relevant to Sales Handheld. Therefore, it is 
recommended that you do a thorough audit of the PDQs and maintain only the ones 
that apply to your particular business.

NOTE: A default filter be defined for each screen (or business object) in the 
application. Only one default filter can be defined per screen or business object. The 
default filter for the Action business object (PDADef_*NoAccounts) does not apply 
to the Sales Handheld application and should be deleted. It is recommended that 
you designate another PDQ (for example, PDA_Active Accounts) the default PDQ 
by renaming it. For example, you would rename the PDA_Active Accounts filter to 
PDADef_Active Accounts).

Table 6. Sales Handheld PDQ Filters

Business Object PDA Name Query

Account PDAAll_All Accounts 'Account'.Search = "" "'Account'.Sort = "Name, Location""

Account PDADef_*No 
Accounts (Sales)

'Account'.Search = [Id] IS NULL""

Account PDA_Active Accounts 'Account'.Search = "[Account Status] = LookupValue ( 
""ACCOUNT_STATUS"", ""Active"" )" "'Account'.Sort = "Name, 
Location""

Account PDA_CA Accounts 'Account'.Search = "[State] = LookupValue ( 
""STATE_ABBREV"", ""CA"" )" "'Account'.Sort = "Name, 
Location""

Action PDAAll_All Activities 'Action'.Search = "" "'Action'.Sort = "Due""

Action PDADef_Uncomplete
d Activities

'Action'.Search = "[Status] <> 
LookupValue(""EVENT_STATUS"",""Done"") OR [Status] IS 
NULL" "'Action'.Sort = "Due""

Action PDA_*No Activities 'Action'.Search = [Id] IS NULL""

Action PDA_This Week's 
Activities

'Action'.Search = "[Planned] >= Today() AND [Planned] < 
Today() + 7" "'Action'.Sort = "Due""

Contact PDAAll_All Contacts 'Contact'.Search = "" "'Contact'.Sort = "Last Name, First 
Name""
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Contact PDADef_*No 
Contacts

'Contact'.Search = [Id] IS NULL""

Contact PDA_CA Contacts 'Contact'.Search = "[State] = LookupValue ( 
""STATE_ABBREV"", ""CA"" )"' "Contact'.Sort = "Last Name, 
First Name""

Employee PDAAll_All 
Employees

'Employee'.Search = "" "'Employee'.Sort = "Last Name, First 
Name""

Employee PDADef_North 
American 
Organization

'Employee'.Search = "EXISTS ([Organization] = ""North 
American Organization"")" "'Employee'.Sort = "Last Name, First 
Name""

Employee PDA_*No Employees 'Employee'.Search = [Id] IS NULL""

Employee PDA_All Employees 'Employee'.Search = "" "'Employee'.Sort = "Last Name, First 
Name""

Expense PDAAll_All Expense 
Reports

'Expense'.Search = "" "'Expense'.Sort = "Start Date""

Expense PDADef_All Expense 
Reports

'Expense'.Search = "" "'Expense'.Sort = "Start Date""

Expense PDA_*No Expense 
Reports

''Expense'.Search = [Id] IS NULL""

Expense PDA_In Progress 
Expense Reports

'Expense'.Search = "[Status] = LookupValue(""EXP_STATUS"", 
""In Progress"") OR [Status] = LookupValue(""EXP_STATUS"", 
""Submitted"")" "'Expense'.Sort = "Submitted Date 
(DESCENDING)""

Internal 
Product

PDAAll_All Products 'Internal Product'.Search = "" "'Internal Product'.Sort = 
"Name""

Internal 
Product

PDADef_Active 
Products

'Internal Product'.Search = "[End Date] >= Today() OR [End 
Date] IS NULL" "'Internal Product'.Sort = "Name""

Internal 
Product

PDA_*No Products 'Internal Product'.Search = [Id] IS NULL""

Internal 
Product

PDA_All Products 'Internal Product'.Search = "" "'Internal Product'.Sort = 
"Name""

Table 6. Sales Handheld PDQ Filters

Business Object PDA Name Query
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Opportunity PDAAll_All 
Opportunities

'Opportunity'.Search = "" "'Opportunity'.Sort = "Primary 
Revenue Amount (DESCENDING), Primary Revenue Close Date 
(DESCENDING)""

Opportunity PDADef_Big 
Opportunities

'Opportunity'.Search = "[Primary Revenue Amount] > 
""500000""" 'Opportunity'.Sort = "Primary Revenue Amount 
(DESCENDING), Primary Revenue Close Date (DESCENDING)" 
"'Account'.Sort = "Name, Location""

Opportunity PDA_*No 
Opportunities

'Opportunity'.Search = [Id] IS NULL""

Opportunity PDA_Current 
Opportunities

'Opportunity'.Search = "[Primary Revenue Close Date] > Today 
() - 30" "'Opportunity'.Sort = "Primary Revenue Close Date 
(DESCENDING)""

Opportunity PDA_New 
Opportunities

'Opportunity'.Search = "[Row Status] = ""Y""" 
"'Opportunity'.Sort = "Primary Revenue Amount 
(DESCENDING), Primary Revenue Close Date (DESCENDING)""

Order Entry 
(Sales)

PDAAll_All Orders 'Order Entry - Orders'.Search = "

Order Entry 
(Sales)

PDADef_Open Orders 'Order Entry - Orders'.Search = [Status] <> 
LookupValue(""FS_ORDER_STATUS"",""Closed"") AND [Status]  
<> LookupValue(""FS_ORDER_STATUS"",""Cancelled"")""

Order Entry 
(Sales)

PDA_*No Orders 'Order Entry - Orders'.Search = [Id] IS NULL""

Order Entry 
(Sales)

PDA_All Orders 'Order Entry - Orders'.Search = "

Price List PDAAll_All Price Lists 'Price List'.Search = "" "'Price List'.Sort = "Name""

Price List PDADef_Current Price 
Lists

'Price List'.Search = "[End Date] > Today()" "'Price List'.Sort = 
"Name""

Price List PDA_*No Price Lists 'Price List'.Search = [Id] IS NULL""

Price List PDA_All Price Lists 'Price List'.Search = "" "'Price List'.Sort = "Name""

Quote PDAAll_All Quotes 'Quote'.Search = "

Quote PDADef_All Quotes 'Quote'.Search = "

Table 6. Sales Handheld PDQ Filters

Business Object PDA Name Query
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Administration of PDQ Filters
The following sections provide recommendations for creating and managing filters 
with various synchronization methods.

Companion Deployments
Administrators typically provide their users with an initial set of PDQ filters and 
instruct them how to manage the synchronization filters themselves later. Create the 
desired Default, General, and All Records PDQ Synchronization filters in the Siebel 
Server database, using the Application Administration >Predefined Queries screen, 
or from within the Siebel application screen with which the PDQ is associated. After 
the appropriate PDQs are created, make the PDQs public by deselecting the Private 
flag. The next time the users synchronize, their local databases are updated with 
the new PDQs.

In addition to using administrator-defined PDQs, Companion Sync (CS) users can 
define their own synchronization filters in Siebel Web Client or Siebel Mobile Web 
Client applications using the special naming conventions. See the previous section, 
“Predefined Query Filters” on page 58 for more information on filter naming 
conventions. Synchronization filters (PDQs) created by a user are initially available 
for use only by that user. A user-defined PDQ can be made public by clearing the 
Private field in the PDQ record in the Predefined Queries view of the Application 
Administration screen.

NOTE: If you create a PDA PDQ, you need to restart the Handheld Component for 
that new PDQ to get registered as part of a Handheld synchronization.

Quote PDA_*No Quotes 'Quote'.Search = [Id] IS NULL""

Quote PDA_Active Quotes 'Quote'.Search = [Active] = 'Y' OR [Status] = 
LookupValue(""QUOTE_STATUS"", ""Active"")""

Table 6. Sales Handheld PDQ Filters

Business Object PDA Name Query
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There are several sample PDQs in the sample database, as well as in the Siebel 7 
seed data.

Stand-Alone Deployments
For Direct Server Sync deployments, only administrators or users with access to the 
Siebel Application Server through a Web client can manage the PDQ sync filters. 
This simplifies end-user training, but requires you to carefully manage the filters on 
an ongoing basis. 

Administrators manage most end user filtering needs through the use of public 
PDQs.   These PDQs are made available to all end users and, therefore, must be 
defined with the needs of all end users in mind.   Private filters, targeted for 
individual user needs, can be created only if the administrator logs into the Siebel 
Web Client application as an end user, navigates to the applicable screen, and 
creates the desired filter

Filtering Data for Pick Applets
Configuration file directives are used only in specific situations and should not be 
considered the primary method for filtering data. Modify these filters cautiously and 
only with the support of skilled Siebel configurators.

Use default Business Object declarations to force the extraction of data for a given 
business component in the context of a given Business Object and Visibility type. 
(See “Designating Visibility” on page 70 for more information on visibility 
designations.) The Default Business Object extractions are performed in the first 
phase of data extraction.

You will most often use these declarations to extract additional data that is not 
extracted as part of the user interface extraction. This may be useful for business 
components that are referenced programmatically by other business components, 
but are not exposed in the user interface. The default Business Object declarations 
are used to enforce the extraction of a subset of data to the handheld that would not 
have been otherwise extracted or, most commonly, to filter the data downloaded for 
dynamic picklists or pick applets.
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All pick data is not downloaded to the device due to the memory constraints on the 
device. Only pick data for fields that are editable is downloaded. Therefore, if you 
are doing a query on a pick field, you may not be able to display the picklist. When 
viewing a record in an applet, if a pick field is read-only, its pick button will be 
disabled. If end-users select a read-only field with a pick control, they receive the 
following error: No data available in picklist because field is read-only.

NOTE: Catalogs control visibility of data in pick applets. To make sure that pick 
applets contain valid data, the administrator must add data to a relevant catalog and 
make sure users have visibility to the catalog using the Catalog screen’s Access 
Groups view tab. For more information on assigning user access to catalogs, see 
Siebel eSales Administration Guide.

Configuration File Directives
Within the Siebel Handheld application .cfg file, there is a [PDA] section that 
contains a number of handheld-specific parameters. One of these parameters, the 
Default Business Objects declarations (DefaultBusObjs), can be used as a Handheld 
Sync data filtering tool. Two directives that are used to filter data are:

■ DefaultFields. This directive specifies which fields in the specified Business 
Component are downloaded to the device.

■ DefaultBusObjs. This directive determines the Business Objects and Business 
Components that are downloaded. This directive is used primarily for those 
Business Objects and Business Components that are used internally in the code, 
but do not have applets or views based on them.

In the DefaultBusObjs directive, you can specify that a QBE be applied to a 
Business Component. You can also use the directive to set the visibility on the 
Business Object. This visibility is applied to the parent Business Component of 
the Business Object.
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However, be extremely careful when modifying these declarations. The default .cfg 
file created during installation of the application includes certain Default Business 
Object declarations that are required for the application to function properly. Be 
sure that Default Business Object declarations for business objects like Shift, System 
Preferences, List of Values, System, and others are never modified. The business 
objects that are required for internal application functioning differ by application, 
so consult Siebel Technical Support or Siebel Expert Services before modifying these 
parameters.

Examples of Business Object Declarations
You can set the PDQ in the Default Business Object declarations as described in the 
following examples.

The general format of a .cfg file is as follows:

DefaultBusObjs<##> = <Business Object name> | <Visibility> | <PDQ> 
| <Business Component 1> | <QBE for Business Component 1> | <Business 
Component 2> | <QBE for Business Component 2>

An example from the Handheld .cfg file:

DefaultBusObjs22 = Opportunity | 3 | | Account | [Account Status]  = 
"Active" | Action | [Start Date] >= Today () - 30 AND [Start Date] 
< Today () + 90

The example Default Business Object declaration results in an extraction of the 
Account and Action business components where they occur with visibility of 3 
within the Opportunity Screen. See “Designating Visibility” on page 70 for further 
information on visibility codes. The Account business component is filtered to 
include only Active status Accounts. The Action business component is filtered to 
include current Activities (those occurring in the previous months and over the next 
three months).

Note that there is no PDQ included in the example. A PDQ is only included when 
you want to force the use of a particular PDQ synchronization filter. See “Predefined 
Query Filters” on page 58 for more information on PDQ synchronization filters.

In the following example, the declaration is used to extract all of the Price List Line 
Items that will display within the Orders screen.

DefaultBusObjs13=  Order Entry (Sales)|0||Price List Item|
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Note that this declaration lacks an associated QBE statement. When this is the case, 
all of the records available to the user for the given visibility are extracted.

Another less common way to use the Default Business Object declarations is to set 
a single PDQ synchronization filter for the Business Objects or Screens that are 
synchronized.

Designating Visibility
It is very important that you use the correct visibility designation in the Default 
Business Object declarations. The visibility entered should be the visibility that 
governs the data displayed for the business component within the context of the 
Business Object specified in the declaration. In the previous Example 1, visibility 
code 3 is designated. This corresponds to All Visibility, which is the visibility that 
applies to the Account business component when it is used in a pick applet.
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You determine the correct visibility to use by examining View and Business 
Component properties within Siebel Tools. When creating a Default Business Object 
declaration to restrict the volume of data extracted for a pick applet, begin by 
examining the Popup Visibility Type in Business Component Properties. Cross-
reference the visibility type to the list below, and enter the appropriate visibility 
code in the declaration. If the Popup Visibility Type field on the Business 
Component is null, the default value is All. Table 7 summarizes popup visibility 
types and the corresponding visibility codes.

.

NOTE: Do not use the Group, Catalog, and Sub Organization PopupVisibilityType. 
This is not supported in the CE handheld applications.

Table 7. Visibility Codes

Popup Visibility Type Visibility Codes

Sales Representative 0

Manager 1

Personal 2

All 3

None 4

Organization 5

Contact 6
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Overriding the Popup Visibility
If the Popup Visibility Type setting is not sufficiently restrictive (for example, All 
visibility), this can lead to a large number of records being extracted when the 
picklist is processed during synchronization. Making the Popup Visibility Type more 
restrictive reduces the number of records extracted for picklists. The 
OverridePopupVisibility user property for an applet overrides the Popup Visibility 
Type on a business component. Use this property when the desired visibility differs 
from the business component’s Popup Visibility Type, and you do not want to 
change the Popup Visibility Type. If several picklists use the same business 
component, you can also use the OverridePopupVisibility user property to vary the 
visibility of the picklists in the different applets.

There are two considerations you should keep in mind if multiple applications are 
sharing the same repository. First, changing the Popup Visibility Type has a global 
effect for all instances where the business component is used. If multiple 
applications share the same repository and use the same business components, 
changing the Popup Visibility Type for a common business component could have 
an undesirable effect for another application. Second, if multiple applications share 
the same applet, the picklist in each applet shares the same visibility as defined by 
OverridePopupVisibility property. This is because the OverridePopupVisibility 
property is set on the containing applet.
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In Siebel Tools, go to Applet > Applet User Properties, and define the 
OverridePopupVisibility user property on the applet containing the control that 
opens the pick applet. See Table 8 for a description of the syntax. Assign a value to 
this property using the syntax shown, where <buscomp field n> is the underlying 
business component field of an applet control or column, and <visibility type> is 
the code corresponding to the desired visibility of the picklist’s business 
component. (See Table 7 for a list of the visibility codes.) Because the name of the 
OverridePopupVisibility parameter must be unique, append a unique number to the 
name of the parameter for any other picklists, for example, 
OverridePopupVisibility1, OverridePopupVisibility2, and so on.

NOTE: If OverridePopupVisibility is used, then the picklist and pick applet search 
specifications are ignored during synchronization when the records for the picklist 
are extracted.

Table 8. OverridePopupVisibility Syntax

Name Value

OverridePopupVisibility <buscomp field 1>, <visibility type>

OverridePopupVisibility1 <buscomp field 2>, <visibility type>

OverridePopupVisibility<n> <buscomp field n + 1>, <visibility type>
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This chapter discusses the following aspects of deploying the handheld application: 

■ Server installation, including how to optimize the server

■ Web client installation

■ Handheld installation, including administrative tasks that must be performed 
before the handheld application is deployed

The audience for this chapter is Siebel application developers, database 
administrators, and system administrators.

Scripting
The Siebel Handheld Client does not execute Siebel Visual Basic (VB) or Siebel 
eScript scripting.

The Siebel Web Client application runs Siebel VB or Siebel eScript scripts and 
specialized business component logic at synchronization time, rather than in real 
time on the handheld device. This has significant consequences in applets and 
controls, because scripts attached to applets and controls are ignored.

Be aware of the following additional issues with respect to scripts and validation: 

■ Deactivating scripts. Do not deactivate existing scripts in Siebel Tools to make the 
handheld device or the synchronization process accept data it is excluding. The 
script is probably used by the Siebel Web Client, and you can cause damage 
elsewhere.
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■ Calls to user interface methods. When a business component script makes a call 
to a user interface method (such as MsgBox), the script cannot be executed, and 
the record update, deletion, or addition is rejected during synchronization. 
Strictly speaking, a script attached to a business component should not interact 
with the user interface, but it is nevertheless a common practice.

Any Siebel Visual Basic code should be restricted to the business component level. 
Applet-level Siebel Visual Basic will not be executed and, therefore, should not be 
written for the Siebel Handheld Client application. As a substitute to using Siebel 
Visual Basic on the Siebel Handheld Client application, for real-time execution, use 
the following business component user properties:

■ BC/Field Read Only Field...for making fields or business components read-only 
dynamically.

■ Pickmap for fields on the picklist.

Do not use message boxes or prompts on the Siebel Visual Basic code used in 
conjunction with the Siebel Handheld Client application business components. If 
the business component is shared between the Siebel Handheld Client application 
and a laptop, use the following construct to determine if the code is being executed 
in real time on the laptop or during synchronization:

'ActiveViewName is only available when the script is called real time 
on the laptop

If (TheApplication.ActiveViewName<>"") then

MsgBox"....."

End If
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Server Installation
This section provides an overview of important factors to consider when planning 
Direct Server Synchronization (DSS) infrastructure. One aspect of successful 
planning and execution of a Siebel Handheld DSS deployment is to understand 
hardware and network requirements. While these factors are generally applicable 
to all deployments, there are unique aspects to each customer configuration and 
implementation strategy. Therefore, it is highly recommended that customers 
conduct detailed configuration, sizing, and production readiness reviews with 
Siebel Expert Services. This is especially important for complex deployments, such 
as those supporting large numbers of users over wide geographic areas. 

For each new customer deployment of Siebel Handheld, there is a mandatory Siebel 
Professional Services program called the Siebel Mobile eBusiness Competency 
QuickStart Engagement or the Siebel Expert Services Handheld Review Package. For 
more information about this program, contact Siebel Global Services or your district 
manager.

You can also improve the performance and scalability of DSS deployments by 
working with the Siebel application server component parameters. For more 
information about the Siebel application server, see “Optimizing Server Process 
Management” on page 86.

NOTE: The recommendations in this chapter are general ones and are intended to 
raise your awareness of the key factors in handheld synchronization, performance, 
and scalability. These factors must be confirmed for your actual environment, and 
the usage patterns in your enterprise should be taken into consideration.
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Server Topology Overview
The diagram in Figure 4 shows the servers and components that are required to 
deploy Direct Server Sync. The components are the Siebel database, Siebel server, 
Siebel Web engine, and Siebel Handheld. The synchronization components are the 
Siebel Sync engine which resides on Siebel server and the Sync client on Siebel 
Handheld. 

NOTE: Companion Sync uses Siebel Remote to complete the synchronization process 
to the Siebel server from the laptop. For more information, see Siebel Remote and 
Replication Manager Administration Guide.

You can improve performance by properly selecting the machine that each server 
runs on (Web server, Siebel server, database server). For example, increasing the 
memory and number of spindles improves the database server performance, and 
increasing the number of CPUs and the amount of memory improves the 
performance of the application server.

Figure 4. DSS Servers and Components
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Recommended Hardware and Network Configuration
There are many factors to take into account when designing and implementing your 
server and network hardware and architecture, and sizing your database. The 
critical factor in sizing a handheld implementation is the expected peak 
synchronization load. Specific application variables to consider in calculating this 
load are: the number of concurrent users, number of transactions, and size of the 
data file. These variables should be considered within the context of the hardware 
specifications, including memory and processor speed.

The following resources are available as you plan your Siebel Handheld 
implementation:

■ Refer to Microsoft and manufacturer documentation for comprehensive 
information on server hardware and registry parameters.

■ Refer to Siebel Technical Note 405, Siebel Handheld Synchronization for specific 
recommendations on the following topics:

■ Server Architecture

■ Server Hardware and Registry Parameters

■ Database Server Sizing

■ Database Tuning

■ Dial-Up and Network

■ Wireless

■ VPN (Virtual Private Networks)

■ The Expert Services Handheld Review Package assists customers with planning 
their hardware and network for handheld implementations. Contact Siebel 
Global Services for more information about this program.
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Server Installation for Direct Server Sync
The server components that are required for Siebel Handheld are installed when 
you install the Siebel server. See Siebel Server Installation Guide for Microsoft 
Windows for details on installing and configuring Siebel server. The Siebel server 
installer copies the necessary DLLs to create an Object Manager for Direct Server 
Sync and creates and configures a Server Component and Component Group. The 
rest of this subsection describes which options you must select to correctly install 
the software, along with creating or configuring additional Object Managers.

Installing the DSS Components Using the Siebel Server Installer
Install the Siebel server, following the instructions in the Siebel server installation 
guide for the operating system you are using. When you reach the Setup Type screen 
in the Installer wizard, you will see three installation options:

■ Typical. This setup option installs all Siebel server components except those 
displayed. 

■ Compact. This setup option installs only those components necessary to run the 
Siebel server, but no additional components or help.

■ Custom. This setup option lets you customize your installation by choosing the 
specific components you want to install.

To install the Direct Server Sync components with your Siebel Server installation

1 Choose the Custom setting, and then click Next.

NOTE: At this screen, you may also choose a different directory for your Siebel 
server installation. 

2 Choose from the following components:

■ Object Manager Component

■ Handheld Synchronization

■ Siebel Data Quality Connector

■ Remote Search Support
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■ Siebel Java Integrator

The listed Custom Installation options are all selectable.

NOTE: You must Handheld Synchronization to enable Direct Server Sync for your 
DSS installation.

3 Click Next.

Continue with the installation in Siebel Server Installation Guide for Microsoft 
Windows.

The install wizard automatically installs and configures the DSS components. In 
addition, the installer creates a configuration file that includes the parameters 
necessary to properly run the DSS server components and the Business Component 
filters file.

Editing the DSS Object Manager Configuration File
You must edit the configuration (.cfg) file associated with the DSS server 
components that you installed and configured to reflect your company's 
environment.

To edit your configuration file

1 In Windows Explorer, navigate to the directory where the Siebel server is 
installed and locate the configuration file associated with the DSS server 
component. By default, this directory is C:\Siebel Root\ siebsrvr\BIN\ENU.

NOTE: By default, the name of the DSS Object Manager configuration file is 
salesce.cfg, but you can change the name of this file.

2 Create a backup copy of the configuration file and name it salesce.cfg.bak.

This step allows you to recover the original version of the file if you encounter 
errors.

3 Open the configuration file using Microsoft Notepad.
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4 Enter parameter values appropriate for your deployment.

The following parameters in the .cfg file may need to be edited to reflect your 
environment. All other parameters in this section should not require change. 

Parameter Default Value Description

[Siebel] 
section 

ApplicationName Siebel Sales for CE The handheld application. 
This value must match the 
name of the application as it 
is specified in Siebel Tools.

ApplicationTitle Siebel Sales The name of the Siebel 
Handheld application as 
shown on the Title bar on 
the browser. This parameter 
is only used if the Siebel 
Tools application developed 
for the handheld is run on 
the Web client.

ApplicationSplashText Siebel Sales The Siebel Handheld 
application name as shown 
on the splash screen. This 
parameter is only used if the 
Siebel Tools application 
developed for the handheld 
is run on the Web client.

ComponentName Siebel Sales Client Required for Direct Server 
Sync, it is entered in the 
registry on the handheld 
device.
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5 Save your changes.

6 Restart the component or server.

Configuring Server Logging Levels
You can specify the level of logging to the server hhsync.*.log files by setting the 
LoggingLevels parameter in the [PDA] section of the .cfg file. By default, the 
parameter is set to the following:

[PDA]

LoggingLevels = 23333

Generally, you should start with the default values. These values work for most 
customers and were selected to optimize performance. If you are experiencing 
problems with the application, change the logging levels to 77777 to capture 
additional diagnostic information. Performance degrades slightly as you increase 
the logging levels, but in most instances, this is not discernible. Once the problem 
is resolved, reset the logging levels to their default values.

[PDA] 
section

AppDir hhsync\salesce The directory location for 
the user's synchronization 
files.

PDAQBEFile salesceqbe.txt The Business Components 
filtering file used by the 
synchronization process.

RemoteCfgName Name of the Siebel Mobile 
Web Client configuration 
file. If the parameter is not 
specified in the .cfg file, the 
default is siebel.cfg. This 
parameter is used by Siebel 
Handheld Sync to invoke 
Siebel Remote. It applies 
only when synchronizing 
using the Integrated Sync 
option.

Parameter Default Value Description
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Each number specifies two things:

■ The type of log record. (See Table 9 for the specific values.)

■ The amount of information that is logged. (See Table 10 for the specific values.)

The different types of log records are described in Table 9 and correspond to the 
following format: LoggingLevels = emdts.

Each type of log record (emdts) can be set to one of the logging levels described in 
Table 10:

Table 9. Types of Log Records

Log Record Description

e Transaction events captured and returned to the client application as error 
messages

m Log records created by the metadata extractor

d Log records created by the database extractor

t Log records created by the transaction processor

s Log records created by the mainline synchronization code

Table 10. Logging Levels

Logging Level Description

0 Suppress all log records

1 Process Critical records only

2 Process Critical and Error records only

3 Process Critical, Error, and Warning records only

4 Process Critical, Error, Warning, and Information records only

5 Process Critical, Error, Warning, Information, and Debug records
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Figure 5 shows the default settings for the LoggingLevels parameter. The parameter 
specifies both the type of log record and the logging level. The figure describes the 
logging levels for the default setting.

Figure 5. Logging Levels Parameter

CAUTION: The maximum level for transaction events (e) is 2. It is recommended that 
you do not lower the value for logging transaction events. If the transaction events 
level is set to 0 or 1, transaction error messages are not sent to the client, and 
transactions will silently fail.

NOTE: The salesceqbe.txt that is shipped with the application does not include a 
[PDA] section. What this means is that the defaults for all PDA parameters apply. 
For example, the default setting of 23333 applies for the LoggingLevels parameter. 
If the LoggingLevels parameter or any other PDA parameter needs to be changed, 
administrators can add this section to the end of the file and manually enter the 
parameter.

LoggingLevels = 23333

Metadata Extractor 
Database Extractor 

Transaction Processor 
Sync Code

3=Critical, Error, and 
Warning Messages

2=Critical and Error
Messages

emd t s

Transaction Events
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Optimizing Server Process Management
Several parameters are outlined below that help optimize server processing for 
Direct Server Sync. To set these parameters, log into a Siebel client as a user with 
Administrative responsibility and navigate to Servers >Components >Component 
Parameters through the Screens menu. Select the SalesCE ObjManager (or the 
appropriate Siebel Handheld application) and update the following parameters to 
optimize threads per process. For further information and assistance, see Technical 
Note 405, Siebel Handheld Synchronization, and contact Siebel Global Services 
about the Siebel Expert Services Handheld Review Package.

■ Max tasks. This parameter determines the maximum number of threads that can 
run concurrently for a given component. The value of this parameter should 
equal the maximum expected peak number of concurrent synchronizations.

■ Min MT servers. This parameter determines how many multithreaded server 
processes are started by default for the Siebel Object Manager.

■ Max MT Servers. This parameter defines the maximum number of processes 
supported by the instance of the Siebel Object Manager. The value for this 
parameter should be the same as Min MT servers and should be set so that 
threads per process (Max Tasks/Max MT Servers) is optimized.

Synchronization Performance and Scalability
There are a number of factors that affect the performance and scalability of 
handheld synchronization. It is very important that administrators and those 
involved in the design and deployment of Siebel Handheld understand the impact 
of usage parameters on synchronization performance and scalability. For more 
information, see Technical Note 405, Siebel Handheld Synchronization for 
application-specific variables affecting synchronization and data from 
synchronization scalability tests. In addition, the Siebel Expert Services Handheld 
Review Package assists customers with optimizing the synchronization 
performance of their handheld installations. Contact Siebel Global Services for more 
information about this program.
86 Siebel Sales Handheld Guide for Windows-Powered Devices Version 7.5.3



Deployment

Mobile Web Client Installation
Using Multiple Synchronization Servers
As you scale your deployment, you may need to use multiple synchronization 
servers to accommodate all of your users. Your end users must be manually 
assigned to a particular server. Resonate products cannot be used for load 
balancing. Refer to Technical Note 405, Siebel Handheld Synchronization and to 
your hardware manufacturer’s documentation for more information on scaling 
deployments.

Synchronization Security
In Siebel Handheld Version 7.5.3 and beyond, the synchronization data stream can 
be secured using SSL (Secure Sockets Layer). 

Mobile Web Client Installation

You must edit the configuration (.cfg) file associated with syncmanager.exe (the 

Companion Sync executable) that was installed with the Siebel Mobile Web Client 

to reflect your user's environment. It may not be practical to individually edit each 

Companion Sync user's .cfg file; therefore, it is recommended that you create one 

edited file and distribute it to all your users with Siebel Anywhere. See Siebel 

Anywhere Administration Guide for more information.

Handheld Device Installation
Before you deploy the handheld application, there are several tasks you need to 
perform:

■ Editing the installation configuration file (setup.ini)

■ Enable database backup

■ Setting up installation on the CompactFlash card
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 87



Deployment

Handheld Device Installation
■ Verifying that the logging parameters are set correctly

■ Changing the DSS URL

■ Print Templates

■ Creating a stand-alone installer (This is optional.)
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Editing the Installation Configuration File
The Siebel Handheld application setup.ini file configures the Siebel Handheld Client 
application installer. Before you deploy a custom-configured Siebel Handheld 
application, you must update the parameters in the setup.ini file so that the correct 
values are written to the device registry before distributing the client installer to end 
users.

The setup.ini file resides in the Siebel Handheld application directory (for example, 
the Sales Handheld directory) on the Siebel Handheld CD-ROM. To modify this file, 
create a Siebel Handheld installation directory on the network, or create and 
duplicate a custom CD-ROM for distribution to end users. This installation directory 
must include the same files and directory structure as the original CD-ROM. Then, 
modify the setup.ini file in the custom installation directory.

Table 11 lists the parameters that you may need to modify in the setup.ini file, their 
default value, and a description of the parameter.

Table 11. Siebel Handheld Sync setup.ini Parameters

Parameter Default Value Description

Version 7.5.2 Version of the desktop Siebel 
application against which the Siebel 
Handheld version synchronizes.

ApplicationName Siebel Sales for CE The handheld application. This value 
can be ignored in the setup.ini file 
because the value will be read from the 
configuration file on the server (for 
DSS). or the PC (for CS).

ApplicationSplashText Sales Handheld The Siebel Handheld application name 
as shown on the splash screen.

MultiCurrency True Required for the application to handle 
multiple currencies.

DSSURL http://Web Server Name 
or IP address/Virtual 
Directory Name

Required for Direct Server Sync. This 
value is entered in the registry on the 
handheld. See “Changing the DSS URL 
on Devices” on page 96 for more 
information on this parameter.
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[Printing] Section See Appendix F, “Print Configuration 
Settings,”for more information on the 
parameters used to configure printing.

[Backup] Section Enables handheld database backups.

See “Editing the Database Backup 
Parameters” on page 94 for more 
information on settings for the 
parameters in this section of the 
setup.ini file.

[ApplicationLocation] Section Specifies where the handheld 
application and database are installed.

See “Setting up Installation on a 
CompactFlash Card” on page 95 for 
more information on the parameters in 
this section of the setup.ini file.

InternetOptionReceiveTime
out

600000 Length of time to receive data (except 
data extraction) from the server before 
the handheld client times out. This 
parameter only applies to 
synchronizations using Direct Server 
Sync.

In milliseconds. The default value, 
600000, is 10 minutes.

InternetOptionSendTimeout 600000 Length of time to send data to the 
server in a single call the handheld 
client times out. This parameter only 
applies to synchronizations using 
Direct Server Sync.

In milliseconds. The default value, 
600000, is 10 minutes.

Table 11. Siebel Handheld Sync setup.ini Parameters

Parameter Default Value Description
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InternetOptionDataExtractionTimeout 900000 Length of time to extract data from the 
server to the handheld device the 
handheld client times out. This 
parameter only applies to 
synchronizations using Direct Server 
Sync.

LogSqlStmts N This outputs all SQL statements 
generated by the handheld application 
to a log file in the Siebel Handheld 
directory on the handheld. See 
“Configuring Handheld Logging 
Parameters” on page 95 for more 
information on this parameter.

Table 11. Siebel Handheld Sync setup.ini Parameters

Parameter Default Value Description
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 91



Deployment

Handheld Device Installation
LogSSAErrors N This outputs all system error messages 
generated by the handheld application 
to a log file in the Siebel Handheld 
directory on the handheld. See 
“Configuring Handheld Logging 
Parameters” on page 95 for more 
information on this parameter.

SyncLogReportingLevel 1 Specifies the level of logging by Siebel 
Handheld Sync.

Valid values are:

0 – includes critical errors for the Siebel 
Handheld Sync client and all messages 
that are displayed to the end user.

1 – includes all error messages for the 
Siebel Handheld Sync client, repository 
version information, device Id, 
extraction Id, and last processed 
transaction Id.

2 – includes transactions that are sent 
to the server, schema file and repository 
file activity, and device information.

TXNErrorLevel 1 Specifies the level of transaction errors 
returned by the server and displayed to 
the end user.

Valid values are:

0 – returns only critical messages from 
the server. This setting is not 
recommended.

1 – returns all error messages from the 
server.

Table 11. Siebel Handheld Sync setup.ini Parameters

Parameter Default Value Description
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Enabling Database Backup
Siebel Systems provides a way to automatically back up a snapshot of the user’s 
database and current settings, and to restore those settings in the event of a total 
device failure. The backup functionality automatically copies all the necessary files 
to a single compressed file. Each time the user backs up, the backup process creates 
a new copy of the file and deletes older backups. The backup process must close 
the application in order to copy the RDBMS and handheld configuration files. After 
the files are copied, it automatically restarts the application.

The backup feature must be enabled in the application. (For more information on 
enabling the backup feature, see “Setting Up Database Backups.”) If the backup 
feature is enabled, a backup is created during every synchronization. This way, the 
user retains an up-to-date snapshot of the database, and older backup versions are 
removed.

When the database backup feature is enabled, a database backup occurs 
automatically at the end of each synchronization. This makes the overall time to 
synchronize somewhat longer. The size of the database and the speed of the 
CompactFlash card also affect the time it takes to complete synchronization.

NOTE: Backups should not be used as a replacement for synchronization.

Setting Up Database Backups
In order to back up the database:

■ Provide users with an external memory card.

■ Install the handheld application with the backup functionality enabled.

■ Instruct users to back up their database on a regular basis.

Backing Up to External Media
It is recommended that you back up to external media—for example, a 
CompactFlash card.
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 93



Deployment

Handheld Device Installation
Backing up data to a directory in memory is an option, if external media is not 
available on the handheld device. However, if the handheld device is damaged, the 
backup in memory may not be retrievable. Also, when backup data is stored in 
memory, the amount of memory available to run the application decreases, and 
application performance may suffer.

Editing the Database Backup Parameters
Before users can back up the database on their handheld devices, you must first 
enable the Backup menu item on the handheld application. This requires editing the 
setup.ini file to enable backup.

The following is an example of the default settings for the backup parameters:

[Backup]
BackupLocation= \Storage Card\Siebel Backup
BackupEnabled= N

■ BackupEnabled = [Y/N] The default is N (No). Change this setting to Y (Yes) 
to enable the Backup menu item and to trigger a backup to occur automatically 
after each synchronization.

If the product is installed with Backup = N, the backup menu item is disabled. 
You will need to change the parameter, then reinstall the product in order to 
enable the menu item.

■ BackupLocation = [Backup location] The default is an external storage card. 
Specify the location where you want the data backed up. It is recommended that 
you do not back up to internal RAM because this may have a negative effect on 
the performance of the application. However, if you back up to RAM, then 
specify the directory location where you want the data backed up.

For more information on the setup.ini file, see Chapter 7, “Installing the Handheld 
Application.”

Restoring from a Backup
For information on restoring a database from a backup, see “Backing Up and 
Restoring Data” on page 135.
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Setting up Installation on a CompactFlash Card
The default, when installing Siebel Handheld applications, is to install both the 
application and the database into RAM on the device. In most instances, there is 
sufficient available memory, and end users are satisfied with the application 
performance. There are situations, however, where you may need to optimize the 
application performance. You can improve performance by installing the Siebel 
Handheld application on an external storage device.

To improve the performance of the application, it is recommended that you install 
the application binary files on a CompactFlash card. By doing so, you can free up 
program memory. Installing the data on the CompactFlash card is not recommended 
because performance will likely degrade.

You can specify, in the application’s setup.ini file, where the application files and 
database files are to be installed. By default, this is set to the handheld device. In 
the ApplicationLocation section of the setup.ini file, there are two parameters. The 
following shows the default settings for these parameters:

[ApplicationLocation]
ApplicationBinariesLocation=Device
ApplicationDataLocation=Device

■ ApplicationBinariesLocation = Device. The default is Device. To improve 
application performance, set this to CF (CompactFlash).

■ ApplicationDataLocation = Device. The default is Device. It is recommended 
that you always install the data files on the device.

After you have edited the setup.ini file, follow the instructions for installing the 
Siebel Handheld application on the client.

Configuring Handheld Logging Parameters
Before you deploy your application, verify that your logging parameters are set 
correctly in the setup.ini file. The parameters and their default values are:

[Logging]

LogSqlStmts = N
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LogSSAErrors = N

The LogSQLStmts and LogSSAErrors parameters log messages to the 
sql_stmt_log.txt and ssa_errors_log.txt files, respectively. You may want to set these 
parameters to Y for debugging while you are developing your application. However, 
once you are ready to deploy your application, be sure to reset the values of both 
parameters to N. For more information on these log files, see “Handheld Device 
Logs” on page 176.

CAUTION: If the LogSQLStmts and LogSSAErrors parameters are set to Y, then the log 
files will get very large and use up the available memory on the handheld device.

Changing the DSS URL on Devices
Once the handheld application is installed, the DSS URL cannot be changed. If you 
need to change the DSS URL, contact Siebel Technical Support.

Installing Print Templates
If your application allows printing, you must include all print templates in the 
template subdirectory of the Siebel Handheld Install directory. The print templates 
are language-specific, so copy the templates to the template subdirectory within the 
language directory of the language you are deploying (for example, 
...\ENU\Template). See the system requirements and supported platforms 
documentation for your application for the language codes.

See Appendix F, “Print Configuration Settings”for more information about Printing.
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Installing from External Media
You may create an image of the Handheld Installer that can be loaded onto external 
media such as a CompactFlash card. When you create a stand-alone installer 
platform, a Cabinet file (CAB) is created in a location that you specify. On the Pocket 
PC platform, this file is named siebel.hpc2k_arm.cab. You can copy the CAB file to 
a CompactFlash card, insert the card into the handheld device, and double-click on 
the file to install the Siebel Handheld application on the device.

NOTE: When installing the application on the device, the end user is asked if he or 
she wants to install the application in the default directory. Regardless of the user's 
answer, the application is always installed in the directory specified by the setup.ini 
file. Therefore, the only way to change the directory the application is installed in 
is to modify the parameters in the ApplicationLocation section of the setup.ini file.

Creating a Stand-Alone Installer
Users who synchronize in DSS mode may not have a PC, and so may not be able to 
create a partnership and synchronize using Microsoft ActiveSync. You can install 
the application for each user through a standard partnership, or you can configure 
a stand-alone installer as shown in the following pages.
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During the installation, as shown in Figure 6, the InstallShield Wizard screen 
prompts you by asking, Would you like to deploy a CAB file to enable rapid 
installation for additional devices? You can configure a stand-alone installer by 
selecting Yes.

You are prompted to select a language for the application and to specify a location 
for the CAB file. The installer creates the CAB file in the location you specify.

The CAB file is a self-extracting file that includes all the files needed to install the 
Siebel Handheld application on the handheld device. When you double-click the 
file, the CAB file installs the application.

Figure 6. CAB File Option
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 Synchronization Conflict Handling and
Recovery 6
When multiple end users synchronize with a remote database, transaction conflicts 
may occur which can result in data loss. The Extended Pick and Extended Insert 
functionality minimizes synchronization conflicts. If transaction conflicts are 
unavoidable, then Siebel Handheld Journaling captures the transaction information 
so that the data can be recovered. The combination of Extended Pick, Extended 
Insert, and journaling eliminates the potential for data loss.

Preventing Synchronization Transaction Conflicts
There are two features that minimize synchronization transaction conflicts.

■ Extended Pick processing

■ Extended Insert processing

The next several sections describe these features in detail.

Extended Pick Processing
The handheld is used to capture and record transactions entered by the handheld 
user. During synchronization, these transactions are processed on the server. A 
situation may arise in which a transaction fails when it is applied to the Siebel 
server (through Direct Server Sync) or Siebel Mobile Web Client (through 
Companion Sync)—both of which are referred to as “server.” For example, a Siebel 
ePharma Handheld user creates a professional call activity for one of his contacts. 
However, since he last synchronized with the server, the contact involved in this 
transaction was deleted from the server database. When he tries to synchronize his 
handheld, the server does not find his contact, and the call activity for the contact 
cannot be inserted into the server database. To generalize this example, any 
transaction that involves data selected through pick lists or pick applets will fail on 
the server if that pick data is not present at the time of synchronization.
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With many handheld users synchronizing with Siebel server and modifying data at 
different times, this scenario is not uncommon.

The following describes how a pick transaction is recorded on the handheld device 
and processed on the server during synchronization. Assume that the handheld 
user wants to create a new call activity for the contact. In order to do this, the user 
inserts a new record in the Professional Call screen and “picks” the desired contact. 
When the contact is selected on the handheld, the Row Id of the contact (Contact 
Id) is recorded. However, on the handheld, the application does not record any of 
the pick map fields associated with the contact; only the Contact Id is recorded. 
When the user synchronizes his handheld, that Contact Id is used to locate the 
contact record in the server database. The Contact Id is then used to retrieve all of 
the fields used in the pick map for the Contact Id (Last Name, First Name, Middle 
Initial, Address, City, State, Zip Code, and so on).

In order to minimize pick processing failures, the handheld must record the pick 
row Id and all of the pick map data that is required for a successful transaction. This 
data must be recorded at the time of the pick, so that it can be passed to the server 
for processing. This enhanced functionality is called Extended Pick processing. 
Now, when the user synchronizes, the transaction is processed on the server as 
follows:

■ The synchronization process first looks for the pick record on the server 
database. For example, to add an activity it looks for the contact and, if it finds 
the contact, it retrieves the necessary data and adds the activity. This is the 
default behavior. 

■ If the server does not find the pick map record in the database and extended pick 
processing is enabled, it retrieves the pick record Id and pick map data from the 
handheld transaction and applies the data directly to the server.

Enabling Extended Pick Processing
You can enable Extended Pick processing in two ways:
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■ Configuration file parameter

The configuration file parameter applies globally throughout the application. 
When enabled, every handheld pick transaction is subject to pick processing. 
The parameter is set as follows:

DefaultHandheldSyncPickMode=Mode

Table 12 describes the settings for this parameter.

Table 12. Configuration File Setting

Configuration File Parameter Mode Value Description

DefaultHandheldSyncPickMode NoFail Turns Extended Pick processing ON

FailOnError Turns Extended Pick processing OFF. 
This is the default behavior if the 
parameter is not specified in the .cfg 
file.
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■ Business component user property

The user property is defined on specific business components. The syntax for 
setting Extended Pick on a business component and the parameter values 
(Table 13) follow:

HandheldSyncPickMode=Fieldname|Mode

You may apply Extended Pick processing to multiple fields in a single business 
component, using the following syntax:

HandheldSyncPickMode=Fieldname1|Mode1, Fieldname2|Mode2

The setting on the business component takes precedence over the setting in the 
configuration file. For example, you can use the business component setting to 
nullify the global application of Extended Pick in the configuration file. See 
“Extended Insert Processing” on page 105 for an example. Conversely, you can 
enable Extended Pick processing on specific business components if the 
configuration file setting has disabled the functionality.

Table 14 shows the combined effect of the settings in the configuration file and on 
a business component.

■ The business component setting always takes precedence over the setting in the 
configuration file. 

■ If there is no setting on a particular business component, the configuration file 
setting applies.

Table 13. Business Component User Property Parameters

Business Component User Property Parameter Value Description

HandheldSyncPickMode Fieldname — Specify the field name 
as defined in Siebel 
Tools.

Mode NoFail Turns Extended Pick 
processing ON.

FailOnError Turns Extended Pick 
processing OFF.
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■ If there is no setting in either the configuration file or on the business 
component, the default behavior is for Extended Pick to be turned OFF.

Extended Insert Processing
When the server executes an insert transaction and the insert fails, there are two 
ways the insert failure can be handled:

■ A record is logged that indicates the insert failed, and synchronization 
continues. This is the default insert behavior. If it is enabled, the Handheld Sync 
Journal can be used to recover the data.

■ The insert failure is logged, including details of the failure, and synchronization 
is interrupted. This is the extended insert behavior. Extended insert behavior 
guarantees that, should an insert fail, data loss does not occur since 
synchronization is stopped until the circumstances causing the failure are 
resolved.

NOTE: If Extended Insert processing takes place, synchronization is interrupted. The 
synchronization process will continue to fail until the problem is resolved. End 
users will need to contact their system administrators to recover from the failure. 
The recovery effort may involve modifying transactions queued for processing, 
modifying data on the server, or reentering transactions through the handheld 
application.

Table 14. Combined Effect of Extended Pick Settings

Business Component Setting
HandheldSyncPickMode=

Configuration File Setting
DefaultHandheldSyncPickMode=

NoFail FailOnError No Setting in .cfg file

NoFail NoFail NoFail NoFail

FailOnError FailOnError FailOnError FailOnError

No Setting on Business 
Component

NoFail FailOnError FailOnError
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Enabling Extended Insert Processing
You can enable Extended Insert processing in two ways:

■ Configuration file parameter

The configuration file parameter applies globally throughout the application. 
When enabled, every failed insert interrupts synchronization. The parameter is 
set as follows:

DefaultHandheldInsertMode=Mode

Table 15 shows the settings for this parameter.

Table 15. Configuration File Setting

Configuration File Parameter Mode Value Description

DefaultHandheldInsertMode NoFail Disables Extended Insert 
processing. This is the default 
behavior if the parameter is 
not specified in the .cfg file.

FailOnError Enables Extended Insert 
processing.
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■ Business component user property

The user property is defined on specific business components. The setting in the 
business component takes precedence over the configuration file setting. The 
syntax for setting the Extended Insert on a business component and the 
parameter values (Table 16) follow:

HandheldInsertFailMode=Mode

Table 17 shows the combined effect of the setting in the configuration file and the 
setting on a business component.

■ The business component setting always takes precedence over the setting in the 
configuration file. 

■ If there is no setting on a particular business component, the configuration file 
setting applies.

■ If there is no setting in either the configuration file or on the business 
component, the default behavior is for Extended Insert to be disabled.

Table 16. Business Component User Property Parameter

Business Component User Property Parameter Value Description

HandheldInsertFailMode Mode NoFail Disables Extended 
Insert processing.

FailOnError Enables Extended Insert 
processing.

Table 17. Combined Effect of Extended Insert Settings

Business Component Setting
HandheldInsertFailMode=

Configuration File Setting
DefaultHandheldInsertMode=

NoFail FailOnError No Setting in .cfg File

NoFail NoFail NoFail NoFail
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Recovering Data with Siebel Handheld Journaling
Siebel Handheld Journaling compiles the details on all transaction conflicts in a log 
file dedicated for that purpose. This log file, in XML format, can be viewed in a 
Journal Viewer which allows administrators to review data and to copy and recover 
data.

In order to use the handheld journaling, three parameters in the handheld 
configuration (.cfg) file must be set.

The parameters and their default settings are as follows:

EnableJournaling=False
LoggingLevels=23333

■ EnableJournaling=False. This parameter, when set to True, enables journaling. 
The default (False) disables journaling.

■ LoggingLevels=23333. Specifies the level of logging for log records. The default 
is the minimum level of logging required for journaling. See “Configuring Server 
Logging Levels” on page 83 for more information about configuring the 
LoggingLevels parameter.

Location and Name of Journal Log Files
The journal log file resides in the Siebel application directory on the server. The 
name of the file is derived from the AppDir parameter in the handheld .cfg file.

For example, if the AppDir parameter is set as follows:

AppDir=hhsync\salesce

FailOnError FailOnError FailOnError FailOnError

No Setting on Business 
Component

NoFail FailOnError NoFail

Table 17. Combined Effect of Extended Insert Settings

Business Component Setting
HandheldInsertFailMode=

Configuration File Setting
DefaultHandheldInsertMode=
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then the location of the file is: Client Root\log

and the name of the file is: hhsync.salesce.journal.log.

Companion Sync Journal Files
Any journal log files that are generated during Companion Synchronization are 
saved in the Siebel application directory on the Mobile Web Client. To facilitate the 
administration of Companion Sync deployments, a mechanism is embedded in 
Siebel Handheld that uses MAPI integration to transfer the journal log files to the 
Siebel Administrator. When this functionality is enabled, if a journal log file is 
generated, it is automatically attached to an email and sent to an email alias. The 
administrator can then use an Outlook macro to concatenate these attachments into 
a single XML file that can then be viewed in the Journal Viewer.

NOTE: This functionality is only available to clients using Microsoft Outlook.

Automatic Forwarding of Journal Log Files
In order for the journal log files to be forwarded to the Siebel Administrator, the 
following parameters need to be set in the handheld .cfg file.

AdminEmail=
JournalGenerations=60

■ AdminEmail—Email alias of the Siebel Administrator. The default is null. If this 
parameter is null, the email with the journal log file is not sent.

■ JournalGenerations—Number of journal log files that are archived on the Mobile 
Web Client. The default value is 60. When the 61st journal log file is archived, 
the oldest file is deleted.

If a network connection is not available when the email is generated, the email 
resides in the end user’s Outbox until a connection with the server is established. 
The forwarding of the log files requires no action on the part of the end user.
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Concatenating Journal Log Files
Siebel Administrators will generally receive numerous emails from end users with 
journal log files attached. To facilitate viewing the journal log files, you can use an 
email macro to concatenate the various files into a single file. Contact Siebel 
Technical Support to obtain this macro.

When it is executed, the macro:

■ Locates all email in the System Administrator’s Inbox whose subject line begins 
with “Sync Journal for.”

■ Concatenates the text from the files that are attached to the emails into a single 
text file. The name of this file, by default, is centraljournal.log.

■ Saves the file to the default location, D:\journalfiles.

■ Deletes the emails after the attached files are processed.

Before you can use the macro, you must add the macro to Microsoft Outlook and 
create the directory where the concatenated journal log file is saved.

Macro Constants
You may modify the following constants and tailor them to your environment. The 
constants and their default values are:

■ Const JOURNALROOTDIR="d:\JournalFiles\"—Specifies the location of the 
concatenated journal log file.

■ Const JOURNALFILE="CentralJournal.log"—Specifies the name of the 
concatenated journal log file.

Viewing Transaction Errors
The Journal Viewer is used to view the journal log files and allows Siebel 
Administrators to recover data. Contact Siebel Technical Support to obtain the 
software for the Journal Viewer. Once you have received the software, run the 
Journal Viewer installer to install the viewer on your machine.
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To open a file

1 From the Windows Start menu, choose Programs > Journal Viewer to start the 
application.

2 Choose File > Open and open the journal log file you wish to view.

Using the Journal Viewer
When you open a journal log file in the Journal Viewer, you will see a list of log 
records. When you double-click on a record in the Journal Viewer, the Error Details 
window displays the following information for the record:

■ Business component

■ Previous field values and new field values

■ Error message describing the sync conflict
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 Installing the Handheld Application 7
This chapter provides instructions for the end user for installing the Siebel 
Handheld application on their device. Installation instructions are provided for each 
of the different synchronization methods and for installing the application on a 
Compact Flash card. System administrators may also find the information in this 
chapter useful for maintaining their end users’ systems.

Installing on the Handheld
There are two ways to install software onto any Windows-powered handheld 
device. The first is to create a partnership between a desktop or laptop PC and the 
handheld device using Microsoft ActiveSync. The second is to install the application 
from type of external media. See “Reinstalling or Upgrading the Handheld 
Application” on page 117 for more information.

It is important to remember that end users must synchronize their handhelds to 
download the application configuration and populate the database before they can 
use the application. Therefore, an administrator may install the application for an 
end user, but the synchronization must occur using the end user’s name and 
password.
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Installing for Companion Sync Users
Before you install and use Companion Sync (CS) with the Siebel Handheld 
application, you must first install the Siebel Mobile client on your PC. The Mobile 
Client Installer copies the Companion Sync files to your personal computer. Then 
install the Siebel application on your handheld device.

NOTE: Users can only use Companion Sync to synchronize their Siebel Handheld 
application to a personal computer that already has the Siebel Mobile client 
installed. 

To install the Siebel Handheld application and Siebel Handheld Sync using CS

1 Using Microsoft ActiveSync, establish a partnership between the handheld 
device and the personal computer.

2 On the PC, network, or CD-ROM, locate the folder where the Siebel Handheld 
Application folder is installed. In this folder, double-click setup.exe.

3 Choose the language you want to use for the installation and click OK.

The Welcome Screen appears. 

4 Click Next.

The Synchronization Options screen appears. 

5 Choose the Companion Sync option and click Next.

6 Select the desired language of the Siebel Handheld application and click Next.

A window appears showing the setup status, followed by several DOS windows, 
and the Add/Remove Programs dialog box.
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7 At the Installing Applications dialog box, click Yes to install in the default 
directory.

NOTE: The default directory in the Applications dialog is the directory specified 
by the system administrator in a setup file. So that the application works 
correctly, the Siebel Installer installs the application in the default directory. 
Therefore, even if you specify a different location for the application, the 
application will be installed in the default location.

The Siebel Handheld installation automatically installs SSCE Service Pack 1 and 
overwrites existing files on your system. A message may appear asking if you 
want to replace existing files. Respond by tapping “Yes to All.”

The Siebel Handheld application is installed on the handheld device. During the 
installation, the Installing Applications dialog box displays a progress bar.

It may take several minutes to install on the handheld device. When the 
application has been downloaded to the handheld device, the Application 
Downloading Complete dialog box appears on the PC. 

8 Click OK.

A message appears informing you that setup has finished installing the Siebel 
Handheld application on your computer.

9 Click Finish.

The Siebel Handheld icon appears in the Start > Programs screen on the 
handheld device.

After installing the handheld application and Siebel Handheld Sync, you must 
perform an initial synchronization before you can use the application. If you are 
installing the application for the first time on the device, synchronize the Siebel 
Remote database with Siebel Server, then synchronize the Siebel Handheld and 
Siebel Remote databases. See “Synchronizing Data” on page 137 for the procedure 
for synchronizing your data.

See Chapter 4, “Data Filtering,” for more information on using Companion Sync 
and setting filters.
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Installing for Direct Server Sync Users
Most DSS users do not have access to a PC for creating a partnership with their 
handheld device. In this case, the administrator has to create partnerships with each 
user's device and install the application. Siebel Handheld applications can be 
installed in DSS mode using the Siebel Installer as described in this section.

To install the Siebel Handheld application using DSS

1 Using Microsoft ActiveSync, establish a partnership between the handheld 
device and the PC.

2 On the PC network or CD-ROM, locate the folder where the Siebel Handheld 
Application folder is installed. In this folder, double-click setup.exe.

3 From the Choose Setup Language window, choose the language you want to use 
for the installation and click OK.

4 From the Welcome screen, click Next.

5 At the Synchronization Options screen, choose the Direct Server Sync option and 
then click Next.

The next screen displays and asks, “Would you like to deploy a CAB file to 
enable rapid installation for additional devices?”

NOTE: If you want to create a stand-alone installer, choose Yes, and then click 
Next. See “Reinstalling or Upgrading the Handheld Application” on page 117 for 
details.

6 To install the application on the device, click Next.

7 Select the desired language of the Siebel Handheld Application, and click Next.

A window appears showing the setup status, followed by several DOS windows.
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8 The Add/Remove Programs dialog appears. This is followed by the Installing 
Applications dialog that asks if you want to install in the default directory. Click 
Yes to install the Siebel Handheld application on the handheld device.

NOTE: The default directory in the Applications dialog is the directory specified 
by the system administrator in a setup file. So that the application works 
correctly, the Siebel Installer installs the application in the default directory. 
Therefore, even if you specify a different location for the application, the 
application will be installed in the default location.

The Siebel Handheld installation automatically installs SSCE Service Pack 1 and 
overwrites existing files on your system. A message may appear asking if you 
want to replace existing files. Respond by tapping “Yes to All.”

During the installation, the Installing Applications dialog box displays a progress 
bar. It may take several minutes to install on the handheld device. When the 
application has been downloaded to the handheld device, the Application 
Downloading Complete dialog box displays on the PC.

9 Click OK.

A window appears informing you that setup has finished installing the Siebel 
Handheld application on your computer.

10 Click Finish.

The Siebel Handheld and Siebel Handheld Sync icons appear in the Startup screen 
on the handheld device.

After installing the handheld application and Siebel Handheld Sync, you must 
perform an initial synchronization before the application can be used. Refer to 
“Synchronizing Data” on page 137 for the procedure for synchronizing your data.

See Chapter 4, “Data Filtering,” for more information on using Direct Server Sync 
and setting filters.

Reinstalling or Upgrading the Handheld Application
Follow the steps below to reinstall or upgrade your handheld application.
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To reinstall or upgrade the handheld application

1 Before you reinstall the current application or upgrade to another version of the 
handheld application, you must first uninstall the current application on your 
device. See “Uninstalling the Handheld Application” on page 118 for more 
information.

2 Once you have uninstalled the application, you may then reinstall the 
application or install the newer version. See “Installing on the Handheld” on 
page 113, and follow the instructions for installing the handheld application.

3 Synchronize your handheld application. See “Synchronizing Data” on page 137 
and follow the instructions for synchronizing your data.

NOTE: If you are using Companion Sync to synchronize your data, synchronize the 
Siebel Handheld database with the Siebel Remote database.

Uninstalling the Handheld Application
Uninstalling the application deletes the database files as well as the application files.

CAUTION: Before you uninstall your application, you must synchronize your database 
to save any changes to your data since the last synchronization. If you do not 
synchronize before uninstalling, these changes will be lost.

See “Synchronizing Data” on page 137 and follow the instructions for 
synchronizing your data.

To uninstall the handheld application

1 Select Start > Settings.

2 Select the System tab and tap Remove Programs.
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3 From Remove Programs, select the Siebel handheld application and tap Remove.

NOTE: A dialog box will appear that says that a file cannot be deleted. This occurs 
because a file may still reside in memory. Ignore this message and tap OK to delete 
all application and database files. No additional steps are required to remove the 
application and database files.
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Working with Siebel Handheld Applications 8
This chapter provides an overview of the Siebel Handheld application’s interface. 
Once you understand the basics of the interface, you will find it easier to complete 
your tasks. This chapter discusses:

■ Navigating the interface

■ Working with data

■ Using the calendar

■ Setting user preferences

In addition, this chapter also provides procedures for performing the following end-
user tasks:

■ Backing up and restoring data

■ Synchronizing data

Components of the Handheld Interface
The components of the handheld interface include the Screens menu, Show drop-
down list, application-level menu, Queries drop-down list, toolbar, and status bar.
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 121



Working with Siebel Handheld Applications
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Figure 7 shows the components of the Pocket PC application.

Figure 7. Pocket PC Application Window Components
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Screens Menu
The screens menu is the first level of navigation in the Siebel Handheld application. 
When you launch the Siebel Handheld application for the first time, this tab is 
labeled Screens unless you have configured a start up view to appear. When you tap 
the screens menu, a drop-down list of all available screens appears. Tap the desired 
screen in the list to navigate to it. 

For information about configuring a start up view, see “Setting User Preferences” 
on page 134. 

Show Drop-Down List
The Show drop-down list is the second level of navigation in the Siebel Handheld 
application. This is where you choose views for the selected screen.

Application-Level Menu
The application–level menu consists of the File, Edit, View, and Help menus. Tap a 
menu to select a menu option. The options that are available in each menu vary 
depending on the task you are performing.

Queries Drop-Down List
Up to two predefined queries (PDQs) are displayed in the Queries drop-down list. 
The list displays the query chosen when you synchronized (or the default filter if 
you did not change the Set Filters selection) and the All Records query, if it is 
defined. For more information, see “Predefined Query Filters” on page 58.

Siebel Toolbar
The Siebel toolbar has buttons for frequently used functionality like record 
navigation and querying.

NOTE: There may be a slight variation in your version of Siebel software, and the 
toolbar may not look exactly as shown here. You can configure your toolbar and 
specify which buttons are displayed. See “Configuring User Interface Elements” on 
page 35 for more information on configuring your toolbar buttons.
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Figure 8 is an example of the Pocket PC toolbar.

■ Tap the New Record button to add a new record to the active list or form.

■ Tap the Back button to navigate to the previous view.

■ Tap the Forward button to navigate to the view you were in before you selected 
the Back button.

■ Tap the Record Navigation buttons to move through records in a form or a list.

■ Tap the New Query button to begin a new query in a form or a list.

■ Tap the Execute Query button to run the query you just created.

■ Tap the Maximize Minimize Applet button to expand the active applet so that it 
is the only applet displayed and takes up the entire screen display. This allows 
you to see more columns or more rows of data at one time. Tap again and the 
screen displays two applets.

Customizing the Toolbar
You can customize which buttons appear on your toolbar by selecting View > 
Customize Toolbar from the application menu.

To add and remove buttons from the toolbar, drag and drop the desired buttons 
between the Choose Toolbar Buttons dialog box and the toolbar.

Figure 8. Pocket PC Toolbar Example

New Query button

Execute Query button
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New Record button

Back button

Maximize Minimize 
Applet button
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Minimize Button
The minimize button appears in the upper right corner of your window.

NOTE: Do not confuse the Minimize button that appears in the upper right corner 
with the Maximize Minimize Applet button that appears on the Toolbar.

When you tap the Minimize button, the application minimizes, but does not close. 
To reopen the application, from the Start menu, tap the Siebel Handheld icon. 
Minimizing the application merely hides it; it does not close the application. 

NOTE: Be sure to close the application before you synchronize.

Status Bar
The status bar appears at the bottom of the application window. It provides 
information about the current view. 

Navigating the Handheld Interface
Navigating the Siebel Handheld application is achieved through the screens menu, 
the Show drop-down list, drilling down, drilling across, toolbar buttons, and 
toggling.

Screens Menu
The screens menu provides the first level of navigation. Here you select the screen 
you want to work in. For more information about the screens menu, see 
“Components of the Handheld Interface” on page 121.

Show Drop-Down List
The Show drop-down list is the second level of navigation. After you have selected 
a screen from the screens menu, select a view from the Show drop-down list. Views 
in the Show drop-down list are specific to each screen.
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 125



Working with Siebel Handheld Applications

Navigating the Handheld Interface
For example, in the Activities screen you can pick the My Activities view from the 
Show drop-down list.

More Info View
To view all of the information available for a record, make sure it is selected, and 
choose More Info from the Show drop-down list.

NOTE: Not all screens have a More Info view.

Toggling Between Applets
A maximum of two applets can be displayed at one time in a Siebel Handheld 
application. In situations where there are more than two applets configured and a 
Toggle button has been configured, you may tap the Toggle button on the applet. Or 
you may select View > Toggle from the menu to toggle between applets.

Expandable Fields
Due to the limited screen size on the handheld, it is not always easy to view the 
data in a field without scrolling or resizing the field width. Therefore, some fields 
that could contain large amounts of text are expandable—that is, the data can be 
viewed in a text box. An ellipsis (...) appears in the field to indicate that the field is 
expandable. When you tap the ellipsis, a text box opens showing the data in that 
field. When you step off the field, the text box closes.

In form applets, an ellipsis is always visible in those fields that are expandable. 
However, in list applets, due to space constraints, the ellipsis is not always visible 
in expandable fields. When you tap on an expandable field in a list applet, the 
ellipsis appears. Once the ellipsis appears, you tap the ellipsis to open the text box.

Navigating a List of Records
Within the view you select from the Show drop-down list, you can view detailed 
information on a record. When records are displayed in a list, you can drill down 
or drill across the record to get additional details.
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Drilling down occurs when you tap a hyperlink in a record and are taken to another 
view within the current screen. For example, if you are in the Accounts screen, and 
tap the Account Name hyperlink, you navigate to the details for that account. You 
do not leave the Accounts screen; you just move deeper into it.

NOTE: Hyperlinks are indicated by blue underlined text as long as they are set up this 
way in User Preferences. For more information see “Setting User Preferences” on 
page 134.

Drilling across a record occurs when you tap a hyperlink in a record and are taken 
to another view in a different screen. For example, tapping a hyperlink in the 
Accounts column of a contact record in the Contacts screen takes you to the record 
for that account in the Accounts screen.

Dynamic drilldown occurs when you tap a hyperlink in a record and are taken to 
another screen or just another view. Where you navigate to depends on the content 
in the drilldown field. 

History Arrows
To navigate back to views you have recently displayed, tap the Back button. After 
you have used the Back button, you can use the Forward button to navigate back 
to your original screen and view.

NOTE: The History arrows only allow you navigate between views. They will not 
recover data that may have been entered or deleted in another view.
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Record Navigation Buttons
Use the Record Navigation buttons to move back and forth though a set of records. 
The navigation buttons are described in Table 18.

Entering Data

Pocket PC There are several different methods for entering data on the Pocket PC operating 
system. Tap the up arrow next to the Input Panel button to select a method. See the 
user guide for your device for information on using the different input methods.

Working with Columns
Data is displayed in lists and forms in your Siebel Handheld application. You can 
organize and work within it in a number of ways to better suit your needs.

There are several ways in which to organize columns in a list. You can:

■ Sort data by up to three columns

Table 18. Record Navigation Buttons

Button Description

Navigates back to the first record in the list or form.

Navigates back to the previous record in the list or form.

Navigates forward to the next record in the list or form.

Navigates forward to the last record in the list or form.
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■ Resize columns

■ Change the order in which the columns appear

■ Show and hide columns

■ Lock columns for horizontal scrolling

You can sort records in a list by tapping in the column header of the column in 
which you want to sort the records. If the green column sort indicator points up, 
the column is sorted in ascending order. If it points down, the column is sorted in 
descending order.

If you need to sort by more than one column, you can open the Sort Order dialog 
box to sort up to three columns at one time. Open the Sort Order dialog box by 
choosing View > Advanced Sort from the application-level menu.

Resize columns by tapping and dragging the divider between the column headings 
until the column is the desired size.

You can change the order of columns using the Columns Displayed dialog box. 
Open the Columns Displayed dialog box by choosing View > Columns Displayed. 

Show and hide columns using the Columns Displayed dialog box. In the Available 
columns list, select the items you want to show and tap the arrow to move the 
selected items to the Selected columns list. To hide columns, select the items and 
tap the arrow to move the selected items to the Available columns list.

Lock or unlock columns by tapping and holding the column header.

Finding and Querying Data
You can search for data using the Find or Query functionality in your Siebel 
Handheld application.
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Find
Use Find to do a simple search for a record. You can access Find by choosing Edit 
> Find from the application-level menu. This launches the Find dialog box, in 
which you can enter your search criteria. The asterisk wildcard function (*) can be 
used in the search criteria. Figure 9 shows an example of the Find dialog window 
with the following fields: Look In, Last Name, Type, Last Call Date, Primary 
Specialty, and Rep Specialty.

NOTE: There may be a slight variation in your version of Siebel software, and the 
Find dialog box may not look exactly as shown here. 

Query
Use Query to locate a number of records containing a specific set of criteria. There 
are a number of ways in which to perform query tasks in your Siebel Handheld 
application.

Creating a Query
To begin a query, you can choose Edit > Query > New from the application-level 
menu, or you can tap the New Query button on the toolbar. Both will provide you 
with a blank form or list where you can enter your query criteria, depending on 
where you are in the application when you invoke the command. The asterisk wild 
card function (*) can be used in the search criteria.

Figure 9. Find Dialog Box
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Executing a Query
After you have created the query, you can execute it by choosing Edit > Query > 
Run from the application-level menu or by tapping the Execute Query button in the 
toolbar.

Refining a Query
You can refine your current query by choosing Edit > Query > Refine from the 
application-level menu.

Printing
You may print from any view in the handheld application that has been configured 
to support printing. When you print from the handheld, a document that has been 
configured for the view is printed. You can print directly to a printer, or, if you are 
not connected to a printer at the time, you can queue your print jobs and wait until 
you have access to a printer to print your documents.

NOTE: When you print from a view, you are not necessarily printing what is visible 
on the screen at the time. Every field on the screen may not be relevant for the 
document. The document may contain only a portion of what is in the view, and it 
may also contain data that is not viewable at the time. A separate applet, which 
often cannot be viewed in the user interface, is configured specifically for printing.

The print templates used to generate the printed documents are downloaded to the 
handheld during the synchronization process. After you have synchronized your 
handheld with the server or a desktop computer, you are ready to print.

For a list of supported printers, see the system requirements and supported 
platforms documentation for your application.

Printing From the Handheld Device
Your handheld device is configured for a particular printer by the Siebel 
administrator. You may print directly to this printer, or, if your handheld is not 
connected to a printer, the print job is sent to a print queue. Print jobs may be 
queued until you have access to a printer, at which time you may print all of the 
jobs in the queue. 
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 131



Working with Siebel Handheld Applications

Exporting Data
Print from the Siebel Handheld application by choosing File > Print. If you are 
connected to a printer, the print job will run. If you are not connected to a printer, 
the print job is sent to a print queue. View the print queue by choosing File > Print 
Queue.

Exporting Data
You may export data from any view in your application in HTML format or as tab 
delimited text and save it to a file. This file can be viewed in applications such as 
Microsoft Pocket Word, Microsoft Pocket Excel, and Internet Explorer.

To export data, select File > Export... to open the Export dialog box.

In the Export dialog box, you may specify the following:

■ Format. Specify either HTML or Tab delimited text file. 

■ Export. Select Only active applet to export only the data in the active applet. 
Select All applets in view to export the data in all visible views. 

■ Output file name. By default, the file is saved in the temp directory with the 
filename “output.” You may tap Browse to specify a different location or 
filename.

■ And paste output to clipboard. Select the checkbox to save the data to the 
clipboard.

■ And open file.  Select the checkbox to automatically open the file. When you tap 
OK in the Export dialog box, the data is exported to the specified file, and the 
file is automatically opened.
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Table 19 describes how to set the parameters to export data to specific applications.

Calendar and Calendar Views
To view your calendar, choose Calendar from the screens menu.

You can view your calendar in a monthly, a weekly, or a daily format. To navigate 
within the calendar, select the calendar view you want to see from the Show drop-
down list.

Calendar Icons
Calendar icons appear in the monthly calendar to make it easier to see and 
understand your schedule at a glance. These calendar icons are explained in 
Table 20.

Table 19. Exporting Data

To export data to Do the following

Microsoft Word Set Format to “Tab delimited text file.”

Microsoft Excel Select the “And paste output to clipboard” check box. 
The Output format may be set either to HTML or “Tab 
delimited text file.” Paste the data from the clipboard 
into an Excel spreadsheet.

Internet Explorer Set Format to HTML. 

Table 20. Calendar Icons (1 of 2)

Icon Description

Current day without an appointment

Day with appointment before and after 12 pm
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Customizing the Calendar
You can customize aspects of your calendar from the User Preferences view. For 
more information, see “Setting User Preferences” on page 134.

NOTE: Siebel Handheld Calendar does not support modification of single instances 
of recurring activities. For example, if you delete or modify an appointment 
scheduled to recur daily for 10 days, the entire series will be deleted.

Setting User Preferences
You can customize aspects of your Siebel Handheld application from the User 
Preferences dialog box. Access the User Preferences dialog box by choosing View > 
User Preferences from the application-level menu.

In the User Preferences dialog box you can:

■ Set a default startup screen.

■ Set number of maximum history threads to be saved.

■ Set the maximum percentage of the display area that the parent applet can take 
up (Pocket PC operating system only).

■ Change font size.

■ Customize list spacing, column width settings, and grid lines.

Day with appointment before 12 pm

Day with appointment after 12 pm

Table 20. Calendar Icons (2 of 2)

Icon Description
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■ Customize your calendar’s default view, start time, time slot interval, and 
default appointment duration.

■ Specify screen aesthetics such as alternating colors for rows and showing 
drilldown sources as hyperlinks.

Backing Up and Restoring Data
It is recommended that you back up your data to an external device—for example, 
a CompactFlash card or a Secure ID card. If the handheld device is damaged, the 
backup may not be retrievable. If you store your backups in RAM, depending on the 
size of your application and data extract, you may decrease the amount of memory 
available for the application, and your application performance may suffer.

Automatic Backup After Synchronization
The automatic backup feature must be enabled in the application by your System 
Administrator. If the backup feature is enabled, a backup is automatically created 
at the end of every synchronization. This way, you have an up-to-date snapshot of 
the database. You must never synchronize your data to the handheld device and 
then restore the database using an older copy of the database. If you do, the next 
time you synchronize, the application will try to rewrite changed transactions. This 
can cause data integrity problems. Therefore, when the database backup feature is 
enabled, a database backup occurs automatically at the end of each 
synchronization. Keep in mind that this will make the overall time to synchronize 
somewhat longer. The size of the database and the speed of the CompactFlash card 
also affect the time it takes to complete synchronization.

Backing Up Data
The following procedure describes how to back up the database on the handheld 
device.
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To back up the database

1 From the application-level menu, choose File >Backup.

NOTE: If the Backup menu item is disabled, contact your system administrator to 
have backup enabled in your application.

A dialog box appears, telling you that backing up the data will restart the 
application and prompts you to confirm that you want to continue.

2 Tap Yes to start the backup.

A status dialog box appears indicating that the backup is in progress and may 
take a few minutes. The Handheld configuration files and data are copied to the 
backup location specified in the setup.ini file. Typically, the backup location is a 
CF or SD card. In some cases, the location is a directory in memory.

A dialog box appears telling you if the backup succeeded and asks if you want 
to return to the application.

3 Tap Yes to return to the application.

NOTE: If the backup fails, consult your system administrator.

Restoring Data from a Backup
In order to restore the application to its previous state, the user should contact the 
system administrator. Any work performed on the handheld device since the last 
backup will be lost.

To restore the database

1 Remove the external flash card from the damaged device and place it in a new 
handheld device where the application has been installed.

2 Navigate to the \Program Files\Siebel Handheld folder.
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3 Start the restore by tapping the BackupUtility file twice.

A dialog box appears, asking you to confirm that you want to restore the device 
from a previous backup.

4 Tap Yes.

A status dialog box appears, indicating that the restore is in progress. The 
backup utility restores the files to the state when the backup was performed. A 
dialog box appears telling you if the restore was successful. If successful, it asks 
you to confirm that you want to restart the Siebel Handheld application.

5 Tap Yes to start using the application.

Synchronizing Data
You must synchronize the data on your handheld device:

■ After you install or upgrade the handheld application

■ Before uninstalling the handheld application

■ On a regular basis to keep your data synchronized with Siebel Server and Siebel 
Mobile Web Client

The sections that follow describe how to synchronize using Companion Sync (CS), 
Direct Server Sync (DSS) and Direct Server Sync via Proxy (DSSvP), and provide 
some troubleshooting tips.

Using Siebel Handheld Synchronization
Siebel Handheld Synchronization differs depending on whether users synchronize 
through Companion Sync or Direct Server Sync. The following procedures show 
how to launch and use Handheld Synchronization for each method.

NOTE: A given user can only synchronize using one method. For example, it is not 
possible to install a handheld application that a particular user will synchronize 
both to the Siebel Mobile Web Client database through Companion Sync and also 
to the Siebel Server database directly through Direct Server Sync.
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Using Companion Synchronization
End users that synchronize their data using Companion Sync must follow a 
three-step process to synchronize their handheld, remote, and server databases. 
Immediately before and after every Siebel Remote sync, you must perform a 
Companion Sync. This process can be time consuming for the end user and difficult 
for the administrator to enforce. 

Integrated Sync eliminates the need for you to initiate three separate sync sessions 
for each Siebel Remote sync. Integrated Sync is a one-button process that 
automatically initiates each of the following synchronization steps:

1 Handheld Upload and Processing—Handheld transactions are uploaded to the 
companion PC and processed.

2 Siebel Remote Synchronization—The Siebel Mobile Client is synchronized with 
Siebel server. Transactions on the mobile client database are uploaded to Siebel 
server, and changes to Siebel server are downloaded to the mobile client 
database.

NOTE: If there is a handheld patch staged on the server, synchronization terminates 
and the patch is installed. After the patch installation is completed, the handheld 
user is prompted to synchronize again (using either Integrated Sync or Companion 
Sync) to complete the data extraction and download (that is, Step 3). It is critical 
that the handheld user synchronize a second time after the patch installation is 
completed. If he fails to do so, he will not be able to start the handheld application.

3 Handheld Data Extract and Download—Data is extracted from the mobile client 
database to the handheld device database.

You may use Companion Sync to synchronize your handheld with Siebel Mobile 
Client as many times as you wish between Integrated Sync sessions. However, it is 
recommended that you conduct Integrated Sync sessions frequently so that the 
Siebel Remote synchronization process does not take long periods of time to 
complete and update conflicts are minimized.
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Synchronizing the Handheld for Companion Sync Users
When you synchronize, you have the option of either doing an Integrated Sync or 
Companion Sync. To do an Integrated Sync, select Perform Remote Sync when the 
Siebel Handheld Sync dialog box appears.

To perform Companion Sync

NOTE: You must close your handheld application before synchronizing your 
application.

1 From the companion PC, establish a Microsoft ActiveSync connection to the 
handheld device. 

2 From the device, verify that the Siebel Handheld application is closed.

NOTE: On the Pocket PC 2002 operating system, the Minimize button (the button 
with the “X” in the top right corner of the application) minimizes but does not 
close the application. To close out the Handheld application in preparation for 
synchronization, you must use the File > Exit command.

3 From the companion PC, choose Start > Programs > Siebel Handheld Sync.

The Siebel Handheld Sync dialog box appears.

a Enter your user name and password.

b By default, Perform Remote Sync is selected. To perform an Integrated Sync, 
accept the default setting.

If you want to do Companion Sync only, then unselect the Perform Remote 
Sync box.

Selecting Bypass Set Filters skips the step of selecting the filters and 
immediately starts the synchronization process. If you select Bypass Set 
Filters, then the filters that you selected the last time you synchronized are 
used. If this is the first time you are synchronizing, then the default filters are 
used.

4 Tap Login.
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 139



Working with Siebel Handheld Applications

Synchronizing Data
5 Tap Set Filters.

The Filters dialog box appears.

6 From the Filter list box, select the screen for which you want to choose a filter.

7 From the Choose drop-down box, select the filter you want to associate with the 
screen you selected in Step 6.

NOTE: Tap Default Filters to restore the filter selection to the default setting.

8 Tap OK and tap Start to begin synchronization.

a The Siebel Handheld Sync dialog box appears. If “Perform Remote Sync” was 
selected, this is followed by the Siebel Remote dialog box. When 
synchronization has successfully completed, the Finished dialog box 
appears.

b If a handheld patch needs to be installed, the synchronization process is 
interrupted and the patch is installed. After the patch is installed, you must 
restart Siebel Handheld Sync to complete the data extract process. If you fail 
to do this, you will not be able to start your application.

c The Finished dialog box appears indicating that the synchronization has 
successfully completed.

9 Tap OK to exit Siebel Handheld Sync.

NOTE: If synchronization errors occur, an error dialog box appears.

Using Direct Server Synchronization
There are two methods for synchronizing between the handheld device and the 
Siebel application server:

■ Direct Server Sync (DSS) provides synchronization between the Siebel Handheld 
application and the Siebel application server.
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■ Direct Server Sync via Proxy (DSSvP) provides synchronization between the 
Siebel Handheld application and the Siebel application server, using the desktop 
or companion PC to provide the network connection between the handheld 
device and the server.

NOTE: DSSvP is only supported on the Pocket PC 2002 platform.

To synchronize with the Siebel application server

NOTE: You must close your handheld application before you synchronize with the 
Siebel application server.

1 If you are synchronizing using DSS, create a direct network connection through 
a modem or a direct LAN connection.

If you are synchronizing using DSSvP, establish an ActiveSync connection 
between the handheld device and the PC.

2 From the device, verify that the Siebel Handheld application is closed.

3 From the device, choose Start > Programs > Siebel Handheld Sync.

The Siebel Handheld Sync dialog box appears.

4 Enter your user name and password.

Selecting Bypass Set Filters skips the step of selecting the filters and immediately 
starts the synchronization process. If you select Bypass Set Filters, then the 
filters that you selected the last time you synchronized are used. If this is the first 
time you are synchronizing, then the default filters are used. 

5 Tap Login.

The Siebel Handheld Sync dialog box appears.

6 Tap Set Filters.

The Filters dialog box appears.

7 From the Filter list box, select the screen for which you want to choose a filter.
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8 From the Choose drop-down box, select the filter you want to associate with the 
screen you selected in Step 6.

NOTE: Tap Default Filters to restore the filter selection to the default setting.

9 Tap OK, and then tap Start to begin synchronization.

NOTE: If a handheld patch needs to be installed, the synchronization process is 
interrupted and the patch is installed. After the patch is installed, you must 
restart Siebel Handheld Sync to complete the data extract process. If you fail to 
do this, you will not be able to start your application.

The Finished dialog box appears indicating the synchronization has successfully 
completed.

10 Tap OK to exit Siebel Handheld Sync.

NOTE: If synchronization errors occur, an error dialog box appears.

Troubleshooting
This section lists potential error messages that are associated with synchronization. 
In addition, this section explains how to fix transaction errors.

General Synchronization Errors
There are a number of different errors that can occur when synchronization does 
not complete successfully, for example:

■ Faulty wire connection

■ Server crash

■ Insufficient memory

■ Login error
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When these errors occur, the user should exit Siebel Handheld Sync and launch the 
application again.

NOTE: When you restart Siebel Handheld Sync, you may see an error message that 
says that another instance of syncmanager.exe is running. You will be asked 
whether you want to terminate the first instance or not, and you should choose Yes.

Transaction Conflicts
Transaction conflicts are minimized when customers adhere to the standard 
configuration practices outlined in this document. However, even when proper 
configuration practices are followed, conflicts can occur for a variety of reasons. For 
example, if a field value is updated on both the handheld client and the server 
between synchronization events, a transaction update conflict will occur. In this 
instance, the user will be presented with an error dialog after synchronization has 
completed.

A transaction consists of one or more smaller transactions called mini-transactions. 
For example, if you update several fields in a record, the update to the record counts 
as a single transaction, and each update to a field is a mini-transaction. The Siebel 
Handheld application behaves in the same way as the Siebel Web application in that 
if any part of the transaction fails, the entire transaction fails. Assume, for example, 
that you update four fields in a record. If, during synchronization, three fields 
update correctly and one field fails to be updated, none of the fields in the record is 
updated.

Improving Application Performance
If you find that the performance of the Siebel Handheld application is very slow or 
begins to degrade, the following can help to improve the application performance:

■ Verify that your device meets the minimum memory requirements. See Siebel 
System Requirements and Supported Platforms documentation for your Siebel 
application.

■ When you run the Siebel Handheld application, it is recommended that you do 
not run any other applications. By doing so, you maximize the amount of 
memory that is available to run the application.
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■ Increase the amount of memory that is allocated for running applications.

■ Installing the binaries to a CompactFlash card. For more information, see 
“Setting up Installation on a CompactFlash Card” on page 95.

To increase application memory

1 From the Start menu, select Settings.

2 Select the System tab and tap Memory.

3 Move the slider bar so that more memory is allocated to Program Memory, then 
tap OK.
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This chapter explains how to use Siebel Sales Handheld to complete tasks in a 
typical workflow performed by a mobile sales representative. Your company may 
follow a different workflow according to its business requirements.

Siebel Sales Handheld Overview
Siebel Sales Handheld provides mobile sales professionals with the sales tools and 
information to manage sales processes such as opportunity, account and contact 
management while they are in the field or away from their desk.

Although the sales process varies by organization, certain similarities do exist. 
Siebel Sales Handheld has been designed so that each organization can adapt its 
usage to best suit mobile business needs while building on similarities in practices 
found across many sales organizations. Organizations can use Siebel Sales 
Handheld in conjunction with the Siebel Sales Web client application or as a stand-
alone product.

Sales representatives may use the handheld to record contact and account 
information, manage opportunities, schedule sales activities, check product and 
pricing information, provide quotes and orders, and create expense reports. In 
addition, sales administrators and sales managers can customize the software to fit 
current business needs.

Contacts are individuals with whom your company conducts business or expects to 
conduct business in the future. Contacts can be employees of other companies, 
independent consultants, vendors, or personal acquaintances. Contacts may be 
associated to several accounts, but a contact may be primary on only one account. 
Contacts may be associated with a number of opportunities, including those that 
are not related to their accounts.

You can access different Contacts screen views to manage your contacts.
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■ My Contacts. View your own contacts, with information that may include 
account, site location, and phone number.

■ More info. Enter information about your contacts, which may include Account, 
preferred method of contact, and commentary.

■ Personal Contacts. Create, edit and view personal contacts.

■ Opportunities. Associate your contacts with opportunities you have created. For 
more information about adding Opportunities, see “Creating Opportunities” on 
page 154.

Business Scenario
At a trade show, a sales representative exchanges business cards with the people 
she meets. Instead of waiting until she returns to her office, the sales representative 
uses Siebel Sales Handheld to enter essential contact information. When she returns 
to her office, she identifies individuals that may be possible sources for leads.

As the sales representative works with each contact, the possibility of doing 
business—an opportunity—may arise. If so, she can then create an opportunity and 
associate contacts and activities with it to track important milestones and key 
players for closing the deal.
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Adding Contacts
Use the My Contacts or Personal Contacts views to enter information about your 
contacts. Contacts entered using the Personal Contacts view are not shared with 
team members.

To add a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts (business), or Personal 
Contacts (personal).

3 Tap the New Record button, and complete the necessary fields.

4 From the Show drop-down list, choose More Info, and then complete additional 
fields, as needed.

The following table describes some fields in the Contact form.

Fields Comments

Last Name A required field that displays the contact’s last name.

First Name A required field that displays the contact’s first name.

Job Title A text field that displays the Contact’s professional 
title.

Account Displays the primary account with which the contact 
is associated. A contact may be associated to more 
than one account, but may be the primary contact on 
only one account at a time. To associate the Contact 
with an Account, navigate to the Contacts > 
Accounts view (if configured).

Work Phone Number A text field that displays the contact’s work telephone 
number.

Site A default value that populates automatically based 
on the location of the primary account.
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Associating Contacts with Opportunities
A contact may be a source of revenue for your company. Potential revenue-
generating events are called Opportunities. You will want to associate a contact with 
an existing opportunity to track information about both the opportunity and the 
contact. For more information, see “Creating Opportunities” on page 154.

To associate a contact with an existing opportunity

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select the contact with which the opportunity will be 
associated.

4 From the Show drop-down list, choose Opportunities.

5 In the Contact Opportunities view, tap the Opportunities list, and then tap the 
New Record button.

6 In the Add Opportunities dialog box, select the opportunity to associate with the 
contact, and then tap OK.

Tap New to enter a new opportunity.

■ My Team’s Accounts. View information about active accounts managed by your 
team members.

■ Activities. Respond to customer inquiries, quote requests, and perform account-
related administrative tasks. Fore more information, see “Creating Activities” on 
page 158. 

■ Contacts. Associate business contacts to accounts.

■ Addresses. Enter primary and secondary address information for accounts.

■ Opportunities. Associate accounts with existing opportunities. For information on 
creating new opportunities, see “Creating Opportunities” on page 154.
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Business Scenario
A prospect is interested in learning more about the products and services that your 
company sells. The sales representative sets up a time for a sales call later in the 
week. 

During the sales call, the sales representative asks a number of questions to 
determine the account structure of the prospect’s business to help the 
representative determine how best to fit the prospect’s product needs. The sales 
representative learns that the prospect’s business has a total of four locations, and 
that sales and service are billed through the main office, although each location 
receives a billing statement.

After the sales representative meets with the prospect, he creates the account 
structure for his business.
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Creating Accounts
When you identify a possible lead, the lead can be added as an account. You can 
then begin to add and track information about the account.

To create an account

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

The My Accounts list appears.

3 Tap the New Record button.

4 In the new row, complete the necessary fields.

To add account addresses

1 Navigate to the Accounts screen.

2 In the My Accounts list, select the account record.

3 From the Show drop-down list, choose Addresses.

4 In the Account Addresses view, tap the Addresses list to select it, and then tap 
the New Record button.

5 Complete the fields for the address, and tap the Primary field to display a check 
mark if this is the primary address for the account.

To add additional account information

1 Navigate to the Accounts screen.

2 In the My Accounts list, select the Account Record.

3 From the Show drop-down list, choose More Info.
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4 Complete the fields to add additional information.

The following table describes some fields in the More Info form. The name and 
address fields are automatically populated with information entered at the My 
Accounts and Addresses views.

Associating Activities with Accounts
An activity is a task or event that is generally, but not always, performed for a 
contact, account, or opportunity. You will likely have many meetings, calls, 
presentations, and other activities surrounding an account. 

Fields Comments

Parent Account Select the parent account from the Pick Account pick list.

Account Type Pick the Account Type from the list. Examples are 
Fulfillment Shipper, Commercial, Competitor.

Account Team Displays the primary Account Team member with which 
the account is associated. To associate the account with 
one or more team members, navigate to the Account > 
Account Team view.

URL Text entry. 

Industries Displays the primary industry with which the account is 
associated.

Price List Choose applicable price list from the Pick Price List dialog 
box.

Current Volume Enter amount, or tap the ellipses and enter Currency Code, 
Exchange Date and Amount in the dialog box. Then tap 
OK.

Potential Volume Enter amount, or tap the ellipses and enter Currency Code, 
Exchange Date and Amount in the dialog box. Then tap 
OK.

Status A list of values established by your company. Status 
examples might be Qualified, Silver, Active.

Currency Select the currency code from the Pick Currency Code list.
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Activities provide a place to enter and track this information. If the activity entered 
has a time associated with it, it will appear on the Activities and Calendar screens.

To associate activities with accounts

1 Navigate to the Accounts screen.

2 In the My Accounts list, select the account with which the activity will be 
associated.

3 From the Show drop-down list, select Activities.

4 In the Account Activities view, tap the Activities list to select it, and then tap the 
New Record button.

5 In the new row, complete the necessary fields.

The Type field defaults to Appointment.

6 Drill down on the default activity Type hyperlink to display the Activities 
screen’s More Info view.

7 In the More Info form, add and edit details about the activity. 

For more information, see “Creating Activities” on page 158.

Associating Opportunities with Accounts
Accounts are a source of business for your company. An opportunity is a potential 
revenue-generating event and is another type of information that you can use to 
manage your accounts within Siebel Sales Handheld.

To add an opportunity to an account

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the My Accounts list, select the account to which the opportunity will be 
associated.

4 From the Show drop-down list, choose Opportunities.
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5 In the Account Opportunities view, tap the Opportunities list to select it, and 
then tap the New Record button.

6 In the Opportunities list, complete the necessary fields for the new record.

The Account field is automatically populated with the name of the selected 
account. Sales stage selections are based on the sales methods used by your 
organization.

An opportunity is defined as a potential revenue-generating event. An opportunity 
is usually associated with an account and one or more contacts, products, activities, 
and quotes.

Examples of opportunities are:

■ At a trade show, a company representative expresses interest in purchasing a 
product.

■ When called by a telesales representative, a contact indicates interest in 
contracting maintenance services.

■ In a conversation with an existing client, the client expresses an interest in 
upgrading to the newest product model.

Opportunity-related information is recorded and tracked in the views of the 
Opportunities screen. You access these views to complete the following tasks.

■ My Opportunities. Enter and track information about new opportunities that may 
include the associated account, sales stage and anticipated revenue.

■ My Team’s Opportunities. View opportunities managed by members of your team.

■ More Info. Update opportunities through the sales cycle from creation to closure.

■ Quotes. Generate quotes based on opportunities. For more information, see 
“Developing Quotes” on page 162. 

■ Contacts, Products and Activities. Associate business professionals, product 
information and tasks that must be accomplished to your opportunities.
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Business Scenario
A sales representative is involved in revenue-generating and customer contact 
activities at her company. At a trade show she meets a prospective customer who 
could be a lead for a new business opportunity. Using her Siebel Sales Handheld 
application, the sales representative discovers that the company is listed in Siebel 
Sales as an account, but the person she met is not listed as a contact associated with 
the account.

After adding this person as a contact, the sales representative creates the 
opportunity. Next, the sales representative schedules meetings, records the 
associated activities, and associates other important contacts to the opportunity.

As the sales process continues, the sales representative gathers and updates 
information about the account, its contacts, and the opportunity. As the relationship 
grows, the sales representative can add, view, and share information and key 
knowledge with other members of the sales team.

Creating Opportunities
Each time you identify an opportunity, you should create a new record.

To create an opportunity

1 Navigate to the Opportunities screen, and from the Show drop-down list, choose 
My Opportunities.

The My Opportunities list appears.

2 Tap the New Record button, and complete the necessary fields.

3 From the Show drop-down list, choose More Info and complete additional fields.

The following table describes some fields in the Opportunities - More Info form.

Field Comments

Name A required value that identifies the opportunity.

Account Allows you to associate an opportunity with an 
account. 
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Description A text area for additional information about the 
opportunity.

Site A default value that populates automatically when 
you associate the opportunity to a specific account 
and location.

Primary Displays the primary Sales Team member for the 
opportunity. To associate the opportunity with one or 
more team members, navigate to the Opportunity > 
Sales Team view (if configured). 

Revenue Allows you to enter the currency amount of the 
opportunity. This field defaults to zero.

Probability % Allows you to enter the percentage of confidence you 
have that the deal will close with the specified 
revenue on the specified close date. Probability 
automatically updates based on the Sales Method 
and Sales Stage selected.

Expected Value Displays a currency value that is calculated based on 
the potential revenue field multiplied by the value in 
the probability field. A lower percent in the 
probability field reduces the expected value that will 
be included in your revenue forecast.

Close Date A required field that allows you to enter the expected 
date on which the opportunity will close. The default 
date is the same as the Created Date. It is important 
to modify the date, if the opportunity will close on a 
different date, since this date is used in revenue 
forecasting.

Lead Quality A list of values established by your company that 
allows you to rank the quality of the lead. Default 
values include 1-Excellent, 2-Very High, 3-High, 4-
Fair, 5-Poor.

Sales Method A list of values established by your company that list 
the sales methodologies. For more information, see 
“Sales Methods” on page 156.

Sales Stage A list of values established by your company that lists 
the sales stages associated with the sales method you 
selected. 

Field Comments
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Sales Methods
A sales method is a formalized approach or methodology used during the sales 
process. A sales method can encompass all activities associated with the sales 
process, from prospecting to forecasting to closing deals. This approach allows sales 
representatives to use the most appropriate method for opportunities. 

The application administrator will create and implement the sales stages your 
company uses, and then establish values in your Siebel application that represent 
these methods and stages. A recommended business practice is to designate a 
default sales method in your Siebel application. This practice allows a sales method 
to be associated with each opportunity and aids in charting and reporting accuracy.

Sales methods can differ within a company. For instance, a sales method for 
managing a complex multimillion dollar opportunity may include 15 stages, while 
a sales method for a simple low-dollar opportunity may require only four stages.

For more information about creating or implementing sales stages, see Applications 
Administration Guide.

Associating a Contact with an Opportunity
As you work with an opportunity, you will want to maintain information about the 
contacts associated with the opportunity. For more information about contacts, see 
“Adding Contacts” on page 147.

The Opportunities screen’s Contacts view allows you to associate and review 
contact-related information for an opportunity.

To associate a contact with an opportunity

1 Navigate to the Opportunities screen, and from the Show drop-down list choose 
My Opportunities.

2 In the My Opportunities list, select the opportunity with which you will 
associate a contact.

3 From the Show drop-down list, choose Contacts.

4 Tap the Contacts list to select it, and then tap the New Record button.
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5 In the Add Contacts dialog box, select the contact or contacts you wish to add, 
and then tap OK.

NOTE: To select multiple records, tap the control key and select the contact records.

Associating a Product with an Opportunity
Specific products can be associated with an opportunity. For example, if a customer 
is interested in purchasing a new product model, this information can be entered in 
the Products view.

After the information is entered, you can drill down on the product to find 
additional information such as product features and prices.

To associate a product with an opportunity

1 Navigate to the Opportunities screen, and from the Show drop-down list, choose 
My Opportunities.

2 In the My Opportunities list, select the opportunity with which a products will 
be associated.

3 From the Show drop-down list, choose Products.

4 In the Opportunity Products view, tap the Products list to select it, and then tap 
the New Record button.

5 In the new row, tap the arrow in the Products field.

6 In the Pick Product dialog box, select the product, and then tap OK.

7 Complete the remaining fields, as needed.

Opportunity Quotes
The Opportunity Quotes view displays quotes that have been generated for a 
specific opportunity. After adding products to an opportunity in the Opportunity 
Products view, you can navigate to the Opportunity Quotes view to initiate Auto 
Quote functionality or to manually create a quote. For more information, see 
“Creating Quotes” on page 162.
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Managing Customer Relationships
An organization’s records should accurately reflect the amount of work required 
and performed to maintain customer satisfaction. This practice avoids duplication 
of effort if a different or an additional team member has to get involved. It also 
keeps everyone up to date as to exactly what activities have occurred and when they 
have occurred.

Activities Overview
Activities are various tasks or events that are performed for contacts, accounts, and 
opportunities. Activities that are given start times are automatically entered on the 
activities screen and your calendar. 

Business Scenario
While working away from his desk, a sales manager receives a call from a customer 
who wants to visit the sales manager’s company for an executive summary meeting. 
The customer also wants the sales team to perform a product demonstration. The 
sales manager schedules the meeting using his handheld. After his next 
synchronization, the meeting appears on calendars of his team members. The sales 
manager delegates the tasks required to prepare for the meeting, such as preparing 
presentation slides, reserving a conference room, and configuring the demo system. 
These activities appear in the sales manager’s Activities screen and calendar for the 
customer’s account.

As the sales manager and his team members complete the activities, the activities 
are marked as done, providing key status information about the opportunity.

Creating Activities
Throughout the day, you have new tasks to accomplish and activities to monitor. 
These activities are part of your business. By keeping track of these activity records 
on your handheld, you make sure your team members know about these tasks, and 
you create a valuable history of your past interactions with customers.
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To create a new activity

1 Navigate to the Activities screen.

The My Activities list appears.

2 Tap the New Record button, and in the new row, complete the necessary fields.

A default value is provided in the activity Type field.

3 Drill down on the hyperlink value in the Type field.

4 In the More Info form, pick the appropriate activity type from the list, and 
complete the fields.

Delegating Activities
If you work as part of a sales team or are the manager, an important part of 
managing your activities includes managing other people’s activities. When an 
activity needs to be performed by someone else, you can reassign or delegate it to 
an employee.

To delegate an activity

1 Navigate to the Activities screen.

2 In the My Activities list, find the activity that needs to be delegated.

3 From the Show drop-down list, select Employees.

4 In the Activity Employees view, tap the Employees list to select it, and then tap 
the New Record button.

5 In the Add Employees list, select the employees to whom the activity will be 
assigned.

6 To make an employee the primary for the activity, tap the Primary field to display 
a check mark.

Associating Contacts with Activities
When you add an activity to your calendar, you may also want to have a record of 
contacts who will be participating in the activity. 
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To add contacts 

1 Navigate to the Activities screen.

2 In the My Activities list, select the activity with which a contact will be 
associated.

3 From the Show drop-down list, select Contacts.

4 In the Activity Contacts view, tap the Contacts list to select it, and then tap the 
New Record button.

5 In the Add Contacts dialog box, select the contacts and then tap OK.

Adding General Activities Using Calendar
General activities and appointments must have the Planned Start and Duration 
fields populated in order to be displayed in the correct time slot on the Daily 
Calendar view.

To add a general activity in the Calendar view

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select Daily, Weekly, or Monthly.

3 For My Weekly or My Monthly, select the day on which you want to schedule a 
general activity.

4 On the toolbar, tap the New Record button.

You may also tap an open time slot within the daily view.

5 In the new record, complete the necessary fields for the appointment or task.

Some fields are described in the following table.

Field Comments

Type The type of activity. Activity types might be call, email-outbound, 
demonstration, and so on.

Planned Start This date-time field defaults to the time selected when you created 
the new appointment.
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To specify contact participants

1 Navigate to the Calendar screen and locate the day the task or appointment 
occurs.

2 Drill down on the task or appointment hyperlink to display the Calendar form.

3 From the Show drop-down list, select Contact Participants.

4 In the Calendar Contacts view, tap the Contacts list to select it, and then tap the 
New Record button. 

5 In the Add Contacts dialog box, select contacts and tap OK.

To specify employee participants

1 Navigate to the Calendar screen and locate the day the task or appointment 
occurs.

2 Drill down on the task or appointment hyperlink to display the Calendar form.

If the appointment or task repeats over time, you will be asked to indicate if 
changes to the appointment should be applied to the specific occurrence, or to 
all occurrences.From the Show drop-down list, select Employee Participants.

3 From the Show drop-down list, select Employee Participants.

Duration When the duration is updated, the planned completion time is 
automatically adjusted.

Account Complete this field if the activity is related to a particular account. 

Repeat Tap the check box to display a check mark if the appointment or task 
is recurring.

Siebel Handheld Calendar does not support modification of single 
instances of recurring activities. For example, if you delete or modify 
an appointment scheduled to recur daily for 10 days, the entire series 
will be deleted.

Repeat Until The end date of a repeating appointment.

Field Comments
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4 In the Calendar Employees view, tap the Employees list to select it, and then tap 
the New Record button.

5 In the Add Employees dialog box, select employees, and then tap OK.

Developing Quotes
When the customer is ready to purchase a product or service, you can develop a 
quote using Siebel Sales Handheld that includes specific prices for products and 
services with related payment terms. 

Business Scenario
A mobile sales representative relies on quotes to create formal offers to clients for a 
variety of products and services that her company provides. Using Siebel Sales 
Handheld she can produce accurate offers at the customer site, with up-to-date 
product and pricing information. When details and pricing are finalized, the sales 
representative can print the quote and deliver it promptly to the customer.

Creating Quotes
Quotes includes effective dates, price lists, and discounts used in pricing products 
and services. Before any of this information can be added to a quote, however, the 
quote must be created with basic information.

To create a quote

1 Navigate to the Opportunities screen.

2 In the My Opportunities list, select the opportunity for which the quote will be 
generated.

3 From the Show drop-down list, select Quotes.

4 In the Opportunity Quotes view, tap the Quotes list to select it, and then tap the 
New Record button.

The new quote is automatically assigned a record identifier, a revision number, 
the default status of In Progress, and a created date.
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5 In the Name field, enter a name for the quote.

When you tab to an adjacent field, the quote name becomes a hyperlink.

6 Drill down on the hyperlink in the Name field to display the More Info form 
where you can add quote details.

Using Auto Quote
If you are working with an opportunity for which the products and solutions have 
already been specified in the Opportunity Products view, there is a faster method to 
generate a quote. You can use the Auto Quote button.

When Auto Quote generates a quote from an opportunity, quote line items are 
created for each product under the opportunity that has the Auto Quote flag 
checked. The Quote Item fields are populated from the corresponding Opportunity 
Product's fields, as shown in the following table.

In addition, information from the generated quote’s Quote # field is copied to the 
Opportunity Products’ Quote # field. The Part Number field of the generated Quote 
Item is determined by the quote item's product. 

Table 21. Quote Item Fields Populated by Opportunity Product Fields

Opportunity Product Fields Quote Item Fields

Product Product

Product Quantity Extended Quantity Requested

Write-In Product (not exposed in 
application)

Write-In Product (not exposed in application)

Expected Delivery Date Requested Delivery Date (not exposed in 
application)

ID (not exposed in application) Opportunity Product ID (not exposed in 
application)
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Table 22 shows the quote record fields that are automatically completed when Auto 
Quote is used to create a quote.

To create a quote using Auto Quote

1 Navigate to the Opportunities screen.

2 In the My Opportunities list, select the opportunity for which the quote will be 
generated.

3 From the Show drop-down list, select Quotes.

Table 22. Quote Fields Completed with Auto Quote

Field Value

Quote # System generated

Revision 1

Name Quote number, unless the user provides 
another value

Opportunity The opportunity from which the quote is 
automatically generated.

Account The account for the opportunity

Account Site The location of the account associated with 
the opportunity

Status In Progress

Active Checked

Currency The currency code for the opportunity

Price List The price list associated with the 
opportunity’s account

Sales Rep User ID

Effective Current date

Through Current date plus 30 days (30 days is 
determined by the 
QUOTE_EXPIRATION_PERIOD LOV)
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4 In the Opportunity Quotes view, tap Auto Quote.

A new row appears in the Quotes list, with the Quote #, Revision, Status and 
Created date filled in.

5 Provide a quote name, edit other fields as necessary, and then drill down on the 
hyperlink in the quote Name field.

6 In the Quote detail form, enter additional information about the quote.

a Select the applicable predefined Discount that will be applied to the quote. 

b Select the applicable predefined Price List.

NOTE: Auto Quote functionality is only available in the Opportunities screen Quotes 
view.

Adding Quote Items
Using the Quotes screen, you can add line items to quotes that you are developing. 
If the Auto Quote method is used, products associated with opportunities appear 
automatically as line items with any applicable discounts.

Line items can be used to:

■ Add new products as line items

■ Apply manual price adjustments to the line items using the Toggle button.

NOTE: Siebel Handheld does not support complex quotes (bundled line items). Only 
simple line items can be created.

To add line items

1 Navigate to the Opportunities screen.

2 In the My Opportunities list, select the opportunity with which the quote is 
associated.

3 In the Show drop-down list, select Quotes.
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4 In the Opportunity Quotes view, locate the quote in the list and drill down on 
the Name hyperlink.

The quote detail form appears (Quotes > More Info).

5 From the Show drop-down list, select Quote Items.

6 In the Quote Line Items view, tap the Line Items list, and then tap the New 
Record button.

7 In the Line Items list, complete the required fields.

Quote Line Item price fields are automatically populated based on the product's 
price in the parent quote's price list.

If you are entering more than one line item, repeat Step 6 and Step 7 until each 
line item has been entered. Tap the Toggle button to display a form that you can 
use to add Item discounts and other adjustments.

To delete line items

1 Navigate to the Quotes screen.

2 In the My Quotes list, select the quote containing the line item that will be 
deleted, and choose Quote Items from the Show drop-down list.

3 In the Quotes Line Items view, select the quote item in the list.

4 From the Edit Menu, select Delete Record. 

NOTE: Quote revisions are not supported on the handheld.

Printing Quotes
Once the customer has expressed significant interest, it is often appropriate to 
present a hard copy quote. 

To print a quote

1 Navigate to the Quotes screen.
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2 In the My Quotes list, select the quote containing the line items that will be 
printed.

3 From the Show drop-down list, select Quote Items.

4 Align the infrared ports on the handheld device and the printer.

5 In the parent Quotes form, tap the Print button.

Managing Orders
After you have completed the initial quote, and the customer has agreed to the 
products and prices you have presented, you create a sales order.

Creating Orders
You can create orders from quotes manually or by using the Auto Order button.

To create an Auto Order from your quote

1 Navigate to the Quotes screen.

2 In the My Quotes list, select the quote from which an order will be generated.

3 From the Show drop-down list, select Orders.

4 In the Quotes list, select the quote, and then in the Orders list tap AutoOrder.

A new record appears in the Orders list, with the order date, number, type, status 
and so on, filled in. 

5 In the Orders list, drill down on the Order # hyperlink.

6 Tap the Orders Line Items list to select it, and then tap the New Record button.

7 A new row appears in the Line Items list.

8 Tap Select in the Products field, and then in the Pick Products dialog box, select 
the product to add as a line item.

To manually create an order

1 Navigate to Orders screen > My Orders.
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2 In the My Sales Orders list, tap the New Record button.

3 Complete the necessary fields for the new order record.

From the Show drop-down list, choose More Info to display a form where you 
can add more details.

Adding Order Line Items
Once the initial sales order is created, you can complete the line items that make up 
the order.

1 Navigate to the Orders screen.

2 In the My Sales Orders list, select the order to which line items will be added.

3 From the Show drop-down list, select Line Items.

4 In the Order Line Item view, tap the Line Items list to select it, and then tap the 
New Record button.

A new row appears in the Line Items list with the Line # and Status fields 
completed. 

5 Complete the fields for the line item.

Repeat Step 4 and Step 5 to add additional line items

The Totals field automatically updates with the Quantity Requested total, and 
the Order record Item Total and Total fields get updated based on the sum of the 
Line Item Start Price and Net Price fields, respectively.

Entering Terms and Totals
After completing the line items, navigate to the Order Terms view to enter shipping 
and payment information for the order.

To add terms and totals

1 Navigate to the Orders screen.

2 In the My Sales Orders list, select the order.
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3 From the Show drop-down list, select Order Terms.

4 In the Order Terms view, tap the Terms form to select it.

5 In the Terms form, complete the necessary fields (such as Payment Terms, Ship 
Carrier, and so on).

NOTE: The basic Sales Handheld configuration does not include detailed shipping 
and billing fields. These fields are based on different business components and 
can be configured as required.

Tracking Expenses
You can track expenses and create expense reports using Siebel Sales Handheld.

To create an expense report

1 Navigate to the Expense Reports screen > My Expense Reports list appears.

2 In the Expense Reports list, tap the New Record button, and complete the 
necessary fields for the new record.

3 From the Show drop-down list, select More Info to view additional fields.

NOTE: You must complete the Submit To field or you will get an error message 
and your expense report will not be saved.

To add detailed line items

1 Navigate to the Expense Reports screen. 

2 In the My Expense Reports list, locate the expense report record.

3 From the Show drop-down list, select Expense Items.

4 In the Expense Report Line Items view, tap the Line Items list, and then tap the 
New Record button. 
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5 In the new row, complete the necessary fields for the line item.

You can not enter Line Items whose Start or End Date is outside of the Expense 
Report period. 

NOTE: Siebel Sales Handheld Expense Reports functionality does not currently 
support the Mileage expense type or detailed Hotel expense tax itemization. If 
these expense types are required, you must enter these items using the desktop 
Siebel Sales application.

6 Repeat Step 4 and Step 5 to add line items. 

The cumulative total of all expense line items is automatically displayed in the 
Totals field.
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This appendix addresses some of the common issues faced while deploying Siebel 
Handheld. The appendix presents troubleshooting tips in three areas:

■ Installation

■ Performance

■ Log Files

The audience for this appendix is Siebel database administrators, system 
administrators, and application administrators.

Installation
Siebel Handheld supports a specific and limited set of devices, handheld OS, 
desktop OS, server OS, server databases, and languages. This range of devices and 
platform support varies widely across the range of Siebel Handheld releases and 
must be carefully checked to confirm support. See the system requirements and 
supported platforms documentation for your Siebel application for information on 
supported Handheld OS, desktop OS, server OS, and server databases.

Client Installation, Backup, and Restore
If you run into problems while installing the handheld application on client devices 
from a desktop PC, refer to the following checklist. Most installation problems are 
covered by this checklist.

■ Is the device certified and supported? Refer to the system requirements and 
supported platforms documentation for the handheld application.

■ Confirm that the device has 64 MB of RAM with the majority of it available for 
the Siebel Handheld application.
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■ Is an ActiveSync connection running (green icon)? If not, check your computer 
to make sure that the serial or USB port is activated and functioning correctly.

■ If previous versions of Siebel Handheld were installed to the device, did you 
uninstall the application? See “Uninstalling the Handheld Application” on 
page 118.

Siebel Handheld binaries may also be installed to a CompactFlash card to conserve 
(RAM) memory. The application will still be loaded into memory when it executes. 
To install to the CompactFlash card, set the ApplicationBinariesLocation and 
ApplicationDataLocation parameters in the setup.ini file. See “Setting up 
Installation on a CompactFlash Card” on page 95.

Siebel Handheld (application only - no data) may also be backed up to a 
CompactFlash card to aid in deployments. Using the built-in backup utility that 
comes with Compaq (QUtilities) and HP Jornada (HP Backup) devices, a backup 
image may be created which can then be restored onto other devices. The initial 
backup image should be made of a device that has not done an initial 
synchronization. An initial synchronization will still be required by each user to 
receive the configuration and data.

It is also possible to back up Siebel Handheld to a PC using the Backup/Restore 
feature within ActiveSync.

Synchronization
Synchronization problems can be caused by incorrect settings in the Siebel 
Handheld setup.ini or .cfg files. Be sure that application names, data sources, and 
SRFs are correct.

Make sure to set the URL setting (DSSURL) in the client setup.ini for direct server 
synchronization installations. Be sure to list the views (DefaultViews) in the 
application .cfg file. Also, do not forget to grant the user visibility to these views in 
the Application Administration > Responsibilities view.

NOTE: Check the log files and confirm the accuracy of the generated connect string.
172 Siebel Sales Handheld Guide for Windows-Powered Devices Version 7.5.3



Troubleshooting

Synchronization
Companion Sync Checklist
Use the following checklist to troubleshoot problems you encounter using 
Companion Sync.

■ Is the latest version of ActiveSync (v.3.5 or later) installed and running?

■ Is ActiveSync connected (green icon)?

■ Do you have the correct data source defined in the handheld .cfg file?

■ If you have problems logging in, check to make sure that you can use the same 
credentials to log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in 
to sync each device. Failure to do so causes data corruption.

Direct Server Sync Checklist
Use the following checklist to troubleshoot problems you encounter using Direct 
Server Sync.

■ Did you install all client and server components successfully?

■ Is there a PDA OM running on the Siebel Server?

■ Did you bounce the IIS, SWE, and Siebel Server after installation?

■ Do you have network access to the URL for DSS? Can you ping the IIS server 
from inside and, if applicable, from outside the firewall?

■ Can you successfully run a SWE command?

■ Do you have the correct DSS URL defined in the setup.ini file?

■ Is the network connection working from the device? Try Pocket IE.

■ If you have problems logging in, check to make sure that you can use the same 
credentials to log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in 
to sync each device. Failure to do so causes data corruption.
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Re-synchronizing Problems
Generally if, for whatever reason, synchronization is terminated, the end user is 
prompted with a message and the synchronization process ends. In this situation 
the synchronization session is allowed to close. However, if the connection with the 
server is unintentionally broken, the session may not have a chance to close before 
the connection is broken. Therefore, if the end user tries to immediately 
synchronize again, he may get an error message and may not be able to 
synchronize. Should this occur, the end user should wait for a period of time 
(generally, 15 minutes) to allow the session to time out and terminate. Once the 
session terminates, the end user should be able to synchronize again.

Log Files
This section discusses issues related to log files.

Direct Server Sync Log Files
To assist Siebel Technical Support, collect the following files when logging a Siebel 
Handheld service request. The following files are found on the machine where 
Siebel Server is installed:

■ All server sync user files in the Siebel Root\siebsrvr\hhsync\application 
directory\user id\node id directory

■ Server NT application event log extract

■ Server NT system event log extract

■ All files in the Siebel Root\siebsrvr\log directory including hhsync.*.log files 

The hhsync.*.log files log every message returned by Object Manager (including 
informational messages, synchronization errors, debugging messages, and 
warnings.) The information logged depends on the logging level set in the .cfg 
file.

■ All files from all subdirectories under the Siebel Root\siebsrvr\logarchive 
directory.
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■ Server perfmon log files (showing memory, network, disk performance), if 
available.

The following files are found on the machine where the Web Server (that is, IIS) is 
installed:

■ SWE log files from Siebel Root\eappweb\log (all files)

■ IIS server NT application event log extract

■ IIS server system event log extract

■ IIS server perfmon log files (showing memory, network, disk performance), if 
available

Companion Sync Log Files
To assist Siebel Technical Support, collect the following log files when logging a 
Siebel Handheld service request. The following files are found on the companion 
PC where Siebel Mobile Web Client is installed:

■ Client Siebel Handheld Sync log file: \log\syncmanager_log.txt

■ All files in the Siebel Root\client\hhsync\application directory\user id\node id 
directory

■ NT application event log extract

■ NT system event log extract

■ All files in the Siebel Root\client\log directory including hhsync.*.log files 

The hhsync.*.log files log every message returned by Object Manager (including 
informational messages, synchronization errors, debugging messages, and 
warnings.)

■ Perfmon log files (showing memory, network, disk performance), if available
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Handheld Device Logs
The following log files are found in the /Program Files/Siebel Handheld directory 
on the handheld device:

■ dbimport_log.txt—This file is a log of the database objects that were imported 
during synchronization. The file is located in the \Program Files\Siebel 
Handheld directory on the handheld client.

■ sql_stmt_log.txt—This file logs all SQL statements generated by the application. 
You must set a parameter in the setup.ini file to turn this log on. The log file is 
located in the \Program Files\Siebel Handheld directory on the handheld client. 
See “Configuring Handheld Logging Parameters” on page 95 for more 
information about setting the parameter.

■ ssa_errors_log.txt—This file is a log of all system error messages. You must set a 
parameter in the setup.ini file to turn this log on. The log file is located in the 
\Program Files\Siebel Handheld directory on the handheld client. See 
“Configuring Handheld Logging Parameters” on page 95 for more information 
about setting the parameter.

■ syncmanager_log.txt—This file contains all of the messages displayed on the Sync 
Manager dialog box as well as some basic information about synchronization, 
such as data source and connect string. You can set the logging level for this file 
using the SyncLogReportingLevel parameter in the setup.ini file.

For Direct Server Sync deployments, the file is located in the \Program 
Files\Siebel Handheld directory on the handheld client. For Companion Sync 
deployments, the file is located in the Siebel Root\client\log on the companion 
PC.

Logging Handheld Synchronization Errors
Siebel Handheld Sync logs all the strings that the user sees in the sync message 
window as well as many informational messages that do not get displayed in the 
UI. These informational messages are used to help track down where an error 
occurred. Siebel Handheld Sync determines which messages get logged based on a 
value stored in the registry under the key SyncLogReportingLevel. The values range 
from 0 to 4; 0 logs all error messages and strings that the user sees, and 4 logs all 
data that Siebel Handheld Sync sends and receives.
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If Siebel Handheld Sync fails for some reason, check the syncmanager_log.txt file 
immediately after the failure. If you need more detail, increase the logging level and 
run Siebel Handheld Sync again. Use the LoggingLevels parameter in the setup.ini 
file to change the logging level. Furthermore, each time a user synchronizes, the 
syncmanager_log.txt file is overwritten with the new data.

SQLTrace
Use SQLTrace for diagnostic purposes if you encounter serious configuration errors 
or performance problems and cannot otherwise diagnose the problem. The problem 
may quickly become apparent in the log entries from SQL tracing.

To enable SQL tracing, set the EnableSqlTrace parameter in the .cfg file. By default, 
EnableSqlTrace=FALSE, and SQL tracing is disabled. Set EnableSqlTrace=TRUE to 
enable tracing. Log entries are written to the hhsync.*.log server log file.

NOTE: SQL tracing only logs SQL statements for one user at time. SqlTrace is applied 
to the first user who synchronizes after tracing is enabled.

CAUTION: When SQL tracing is enabled, synchronization is severely and adversely 
affected. Therefore, it is recommended that you turn SQL tracing on for a limited 
time to diagnose a specific problem, then turn SQL tracing off.

End User Error Messages
End users may encounter error messages when they synchronize their data. For 
more information on these messages, see “Troubleshooting” on page 142.
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Web Server Timeout Errors
If synchronization times are long due to the size of the database file or the speed of 
the network connection, your end users may encounter Web server timeout errors 
and synchronization failures. First try to resolve this problem by reducing the size 
of your extract and configuring your server performance. If after doing this, your 
end users continue to experience timeout errors, then increase the timeout 
parameter on IIS for the default Web Server.

Follow the procedure for your platform to change the timeout parameter.

To change the timeout parameter on Windows 2000 

1 From the Start menu, select Programs > Administrative Tools > Internet 
Services Manager.

2 From the Internet Information Services window, select the local machine, right-
click on the Default Web Site, and select Properties from the pop-up list.

3 From the Web Site Properties window, select the Web Site tab.

4 Under the Connections heading, locate the Connection Timeout property and 
increase the number of seconds.

5 Click OK.

To change the timeout parameter on Windows NT

1 From the Start menu, select Programs > Windows NT 4.0 Option Pack > 
Microsoft Personal Web Server >Internet Service Manager. 

2 Under Internet Information Server, right-click on the Default Web Site and select 
Properties from the pop-up list.

3 From the Web Site Properties window, select the Web Site tab.

4 Under the Connections heading, locate the Connection Timeout property and 
increase the number of seconds.

5 Click OK.
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This section discusses ways you can optimize your client performance, server 
performance, and network performance.

Client Performance
Client performance is affected primarily by the device capability (minimum 206 
MHz processor and 64 MB RAM), configuration, and the quantity of data loaded 
onto the device. In general, screen-to-screen and view-to-view navigation times of 
3 to 4 seconds or less should be considered normal. 

It is strongly recommended that customers follow these general guidelines to 
optimize the performance of their handheld applications:

■ Keep configuration under 30 views.

■ Keep RML file size under 1.75 MB.

■ Keep database files (dbfile.txt) under 2 MB. 

Use filters as outlined in the Siebel 2000 Handheld Synchronization Technical 
Note.

■ Keep the number of records for each business component under 2,500.

■ Avoid installing other applications on the device at the same time.

■ Users should synchronize their data frequently.

Additional configuration information can be found in the Siebel Technical Note 405, 
Siebel Handheld Synchronization.

The Professional Services Mobile eBusiness Competency group has a Siebel 
Handheld Quickstart program that is mandatory for all new Siebel Handheld 
customers to assess their configuration and deployment.

The Siebel Handheld client will benefit from periodic closing and restarting the 
application to release memory consumed by the handheld operating system. Use 
File > Exit in the menu to exit from the Siebel Handheld application.
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If an external VGA driver is or has been loaded on the device in the past and is no 
longer needed, be sure to unload it, because it is known to have significant 
performance impacts on handheld devices.

Server Performance
Server performance affects the performance and scalability of Direct Server Sync 
processes. Customers should engage Expert Services to do a Scalability Review. The 
following guidelines are general in nature and pertain to the Siebel Handheld sync 
components running on a Siebel Server:

■ Use Performance Monitor to track memory and processor performance on the 
Siebel server.

■ Make sure that the Servers (IIS, GW, OM and DB) are on the same high speed 
LAN segment.

■ Siebel Handheld Sync components will stress Siebel Server and database 
performance because of the intensive interactions during large concurrent 
synchronizations.

■ Estimate that 64 MB is used per Siebmtsh.exe instance.

■ To calculate the theoretical maximum concurrent users:

■ Numusers=Server_Memory*threads_per_process_ratio/64 MB.

■ Optimize the Threads per Process Ratio (Max Tasks/Max MT Servers) per 
Technical Note 405, Siebel Handheld Synchronization. 

■ Set Max Tasks=Max. number of concurrent users (for example, 150).

■ Set MinMTServers=MaxMTServers (for example, 30 for 5:1 ratio, if this is 
determined to be appropriate).

To optimize and tune a Siebel DB server:

■ Use Performance Monitor to track memory and processor performance on the 
DB server.

■ Turn on SQL tracing and search for long-running SQL calls.

■ Estimate 64 MB of RAM for each concurrent user.
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■ Consider creating indexes to tune the queries (only performed with the 
assistance of Siebel Expert Services).

■ Consider using a RAID 0+1 disk array with an expanded number of spindles to 
optimize database performance.

NOTE: Make sure that DB Server settings are set to recommended values. Timeouts 
should be set at the Siebel Server. Be careful that the timeout is set longer than the 
longest SQL query.

Network Performance
The condition of the network affects Direct Server Sync performance and scalability. 
In general, a low-latency, high-bandwidth network is preferred with dedicated 
rather than shared network connections. The following are general network 
considerations:

■ Make sure there is adequate bandwidth throughout the entire round-trip of 
network packets and estimate where bottlenecks will occur due to high 
concurrent load. For example, if 50 users are concurrently synchronizing 1 MB 
each, 50 MB of data must pass through the network. If this data is passing 
through a single leased 56 KB per second line, then this data will minimally take 
500,000 KB/56 KB/sec=8928 seconds=148 minutes. In reality, a 56 KB per 
second line will offer only 30-40 KB per second average throughput, which 
causes further bandwidth constraints. Check the total available bandwidth of 
network providers (private or public ISP).

■ Verify that you have low latency lines with ping round trips of less than 1 second 
(1000 ms) with no dropped packets.

■ Verify if roundtrips occur with less than 10 hops.

■ Check the actual throughput of network connections by performing simple file 
transfers with no Siebel software.

■ Nonvalidated VPN software from third parties accounts for 30 to 60 percent of 
additional packet overhead because of the encryption.
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Siebel Services
Network problems can usually be resolved by working with network providers to 
size network connections and optimize network routing. Consider the use of burst 
networks, quality of service contracts, private networks, and dedicated modem 
banks directly into a high-speed LAN environment. Noisy phone lines in some 
countries may benefit from the use of an external modem card from Xircom or 
Pretec instead of the built-in modem on the HP Jornada 720.

Siebel Services
You may wish to consult experts who have experience designing and configuring 
handheld applications, and who are knowledgeable about optimizing the 
performance of the applications.

Siebel Professional Services
To make deployment planning and implementation successful, Siebel Handheld 
customers are encouraged to engage the Siebel Mobile eBusiness Competency 
group. The Siebel Professional Services team has developed a Siebel Handheld 
Quickstart solution which defines the strategy, approach, and roadmap for 
successful Siebel Handheld deployments. Working directly with experienced 
handheld experts from the Mobile eBusiness Competency, customers can develop a 
complete deployment strategy, approach, and roadmap to facilitate their handheld 
implementation in a short time period.

Siebel Expert Services
All Siebel Systems customers should work with Siebel Expert Services to conduct 
detailed configuration and hardware sizing reviews. This helps customers make 
sure they have implemented the most effective and efficient solutions possible. 
Siebel Handheld customers benefit by making sure Siebel Handheld applications are 
configured according to best practices and that server environments are properly 
designed.
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Siebel Handheld Client supports a subset of the screens and views supported by the 
Siebel Web Client application. Other screens and views can be configured for your 
Siebel Handheld Client application if they are based on currently supported classes. 
Application developers and application administrators will find the information in 
this appendix useful.

If you configure screens and views based on unsupported classes, you may see 
anomalous results. For information on how to determine the classes used by other 
screens and views, see Object Types Reference.
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The screens and views shipped with the Siebel Sales Handheld sample application 
are shown in Table 23.

Table 23. Siebel Sales Handheld Screens and Views

Screen View Name on UI View Name in Siebel Tools (salesce.cfg)

Contacts My Contacts SHCE Sales Visible Contact List View

More Info SHCE Sales Contact Details View

Personal Contacts SHCE Sales Personal Contact List View

Opportunities SHCE Sales Contact Detail - 
Opportunities View

Accounts My Accounts SHCE Sales Account List View

My Team’s Accounts SHCE Sales Manager’s Account List 
View

More Info SHCE Sales Account Detail View

Activities SHCE Sales Account Detail - Activities 
View

Contacts SHCE Sales Account Detail - Contacts 
View

Addresses SHCE Sales Account Detail - Business 
Address View

Opportunities SHCE Sales Account Detail - 
Opportunities View

Opportunities My Opportunities SHCE Sales Opportunity List View

My Team’s Opportunities SHCE Sales Manager’s Opportunity List 
View

More Info SHCE Sales Opportunity Detail View

Activities SHCE Sales Opportunity Detail - 
Activities View
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Contacts SHCE Sales Opportunity Detail - 
Contacts View

Quotes SHCE Sales Opportunity Quote View

Products SHCE Sales Opportunity Detail - 
Products View

Employees All Employees SHCE Sales Employee List ReadOnly 
View

Employees - More Info SHCE Sales Employee Detail View

Calendar Daily SHCE Sales Calendar Daily View - My

Weekly SHCE Sales Calendar Weekly View - My

Monthly SHCE Sales Calendar Monthly View - 
My

Employee Participants SHCE Sales Calendar Employee 
Participants View

Contact Participants SHCE Sales Calendar Contact 
Participants View

Note: This view does not 
have a view name in the 
UI. It is a drill–down 
view.

SHCE Sales Calendar Add/Modify View

Activities My Activities SHCE Sales Activity List View

More Info SHCE Sales Activity Detail View

Contacts SHCE Sales Activity Contact Participants 
View

Employees SHCE Sales Activity Employee 
Participants View

Expense Reports My Expense Reports SHCE Sales Expense List View

Table 23. Siebel Sales Handheld Screens and Views

Screen View Name on UI View Name in Siebel Tools (salesce.cfg)
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More Info SHCE Sales Expense List Detail View

Expense Items SHCE Sales Expense Item List View

Quotes My Quotes SHCE Sales Quote List View

More Info SHCE Sales Quote List Detail View

Quote Items SHCE Sales Quote Detail View

Orders SHCE Sales Quote Orders View

Orders My Sales Orders SHCE Sales Order Entry - My Orders 
View (Sales)

More Info SHCE Sales Order Entry - Detail Orders 
View (Sales)

Line Items SHCE Sales Order Entry - Line Items 
View (Sales)

Order Terms SHCE Sales Order Entry - Order Terms 
View (Sales)

Products All Products SHCE Sales Product List View

More Info SHCE Sales Product Detail View

Pricing Price Lists SHCE Sales Price List View

More Info SHCE Sales Price List Detail View

Line Items SHCE Sales Price List Line Item View

Table 23. Siebel Sales Handheld Screens and Views

Screen View Name on UI View Name in Siebel Tools (salesce.cfg)
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Siebel Handheld Client supports a subset of the business components and classes 
supported by the Siebel Web Client application. This appendix lists the supported 
business components, business component classes, and applet classes.

Business Components
Table 24 lists the supported Business Components for Siebel Sales Handheld.

Table 24. Siebel Sales Handheld Business Components

Supported Business Components

Account

Action

Business Address

Contact

Contact (All)

Contact (Personal)

Employee

Employee (MM)

Expense

Expense Item

Internal Product

Opportunity

Opportunity Product
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Order Entry - Line Items

Order Entry - Orders

Price List

Quote

Quote Item

Table 24. Siebel Sales Handheld Business Components

Supported Business Components
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Business Component Classes
Table 25 lists the supported Business Component classes for Siebel Sales Handheld.

Table 25. Siebel Sales Handheld Business Component Classes

Supported Business Component Classes

CSSBCActivity

CSSBCBase

CSSBCBCExpitm

CSSBCExprpt

CSSBCLineItem

CSSBCOppty

CSSBCOrder

CSSBCPriceList

CSSBCProdBuyNow

CSSBCProdRev

CSSBCQuote

CSSBCQuoteItem

CSSBCUser
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Applet Classes
You may create additional screens and views for your handheld application. Any 
new screens and views must be based on classes and Business Components that are 
supported for the Sales Handheld application. Refer to Table 26 for the supported 
applet classes.

Table 26. Siebel Sales Handheld Applet Classes 

Supported Applet Classes

CSSFrame

CSSFrameAlarmList

CSSFrameBase

CSSFrameCECalAddModify

CSSFrameCEGridDay

CSSFrameCEGridMonth

CSSFrameCEGridWeek

CSSFrameCEHome

CSSFrameCEMultPart

CSSFrameList

CSSFrameListBase

CSSFrameListExpitm

CSSFrameListQuote

CSSFrameListQuoteItem

CSSFrameQuote
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This appendix documents the handheld-specific user properties and methods for 
the Siebel Handheld application.

User Properties

Table 27. User Properties

Name Description

HandheldSyncPickMode User property on a field of a business component. 
When set to NoFail, turns Extended Pick processing 
ON. See “Extended Pick Processing” on page 101 for 
more information.

HandheldSyncInsertMode User property on a business component. When set to 
FailOnError, enables Extended Insert processing. See 
“Extended Insert Processing” on page 105 for more 
information.

OverridePopupVisibility Overrides Popup Visibility Type on a business 
component. Use OverridePopupVisibility to change 
the visibility on a picklist without changing the 
Popup Visibility Type. See “Overriding the Popup 
Visibility” on page 72 for more information.

View Used with the GotoView method. Specifies the view 
to be displayed when navigating from one view to 
another. See “Applet Focus Behavior” on page 33 for 
more information.
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The following details methods you can use for your Siebel Handheld application.

AutoQuote
The AutoQuote method generates a quote from an opportunity. The opportunity 
may contain one or more products. A quote item is generated for each product in 
the opportunity that has the AutoQuote field flag selected.

When the AutoQuote method is executed, the quote business component fields are 
populated with the values shown in Table 28.

Table 28. AutoQuote Method

Field Value

Quote Number This field is assigned a system-
generated value.

Revision 1

Name Quote Number 
(or user-provided name)

Opportunity Opportunity from which 
AutoQuote was called.

Account Opportunity’s account

Account Location Opportunity’s account location

Status In Progress

Active Flag is set to on

Currency Opportunity’s currency code

Price List Opportunity’s price list
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The Quote Item business component fields are populated from the corresponding 
Opportunity Product’s business component fields as shown in Table 29:

Fields that are noted as “Not exposed” do not appear in the user interface.

Sales Rep User’s login 

Start Date Today’s date

End Date Today’s date + 30 days
(30 days is determined by the 
QUOTE_EXPIRATION_PERIOD 
LOV)

Table 29. Population of Fields in Quote Item View

Source Field Destination Field

From Opportunity Product View Quote Item View

Product Product

Product Quantity Extended Quantity Requested

Write-In Product (Not exposed) Write-In Product (Not exposed)

Expected Delivery Date Requested Delivery Date (Not exposed)

ID (Not exposed) Opportunity Product ID (Not exposed)

Table 28. AutoQuote Method

Field Value
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In addition, the Quote Number field in the generated quote is copied back to the 
Opportunity Product view (Table 30).

AutoOrder
The AutoOrder method generates an order from a quote. AutoOrder creates a 
corresponding line item for each quote item in the quote. The Order Entry Line 
Items business component fields are populated with the corresponding Quote Item 
business component fields as shown in Table 31.

Table 30. Population of Fields in Opportunity Product View

Source Field Destination Field

From Quote View To Opportunity Product View

Quote Number Quote Number (Not exposed)

Table 31. Population of Fields in Order Entry - Line Items View

Source Field Destination Field

From Quotes – Quote Items View To Order Entry - LIne Items View

Extended Quantity Requested Extended Quantity

Product Product

Discount Amount (Not exposed) Discount Amount (Not exposed)

Discount Percent Discount Percent (Not exposed)

Description (Not exposed) Description (Not exposed)

Requested Delivery Date (Not exposed) Due Date (Not exposed)

Unit Price (Not exposed) Unit Price (Not exposed)

Volume Discount Id (Not exposed) Volume Discount Id (Not exposed)

Volume Discount Item Id (Not exposed) Volume Discount Item Id (Not exposed)

Base Price Base Price 
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If the quote item’s product is a service product, then the following fields are also 
copied from the Quotes – Quote Items view to the Order Entry - Line Items view 
(Table 32).

When AutoOrder is executed, the quote’s Status field is updated to “Order Placed.”

When AutoOrder is executed, the following fields in the Order Entry - Orders 
business component are pre-populated (automatically populated?) as shown in 
Table 33.

Adjusted List Price Adjusted List Price

Covered Product Id (Not exposed) Covered Product Id (Not exposed)

Table 32. Copied Fields for Service Products

Source Field Destination Field

From Quote – Quote Items View To Order Entry - Line Items View

Covered Quote Item Id (Not exposed) Covered Quote Item Id (Not exposed)

Service Price Amount (Not exposed) Service Price Amount (Not exposed)

Service Price Percent (Not exposed) Service Price Percent (Not exposed)

Service Price Method (Not exposed) Service Price Method (Not exposed)

Table 33. Pre-populated Fields in Order Entry - Orders Business Component

Order Entry - Order Business Component Field Value

Order Number System-generated value

Account Quote’s Account

Table 31. Population of Fields in Order Entry - Line Items View

Source Field Destination Field

From Quotes – Quote Items View To Order Entry - LIne Items View
Version 7.5.3 Siebel Sales Handheld Guide for Windows-Powered Devices 195



User Properties and Methods

Methods
Account Location Quote’s Account Location

Contact Last Name Quote’s Contact Last Name

Contact First Name Quote’s Contact First Name

Order Priority Medium

Status Pending

Order Type Sales Order

Active Set to Active (Turned on? Flag is set to 
on?)

Order Date Today’s date

Discount Quote’s Discount

Price List Quote’s Price List

Currency Code Quote’s Currency Code

Requested Ship Date Quote’s Requested Ship Date (Not 
exposed)

Created Today’s date

Created By Name User’s login ID

Discount Amount (Not exposed) Quote’s Discount Amount (Not 
exposed)

Primary Organization Id (Not exposed) Quote’s Primary Organization Id (Not 
exposed)

Table 33. Pre-populated Fields in Order Entry - Orders Business Component

Order Entry - Order Business Component Field Value
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This chapter describes the print tagging language that is used to create print 
templates for your handheld device.

The audience for this appendix is Siebel application developers.

Overview
You can create the print template file in any text editor.

■ Tags are enclosed in angle brackets and identified with the keyword TAG, 
followed by a colon.

For example: <TAG: ....>

■ Parameters are specified with a keyword, followed by an equals sign. Arguments 
are in uppercase, surrounded by quotation marks.

For example, Font = "FONT FACE"

■ Values are in uppercase and lowercase, surrounded by quotation marks. 

For example: Font = "Helvetica"

■ Tags may appear in any order in the file. The only required tag is the Title tag.

■ Variables within a print template must be uniquely named. Variable names must 
be one-word strings and spaces are not allowed.

The following tags are used to specify the format of the print output, which applets 
are included, and the query that is executed:

■ Applet—Specifies which applets are used in the document.

■ Comment—Adds comments that do not appear in the final document.
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■ Divider—Adds visual lines to visually separate different parts of the document.

■ Footer—Adds information such as page numbers, date, and time.

■ Format—Specifies characteristics such as font, boldface, italics, and underline.

■ Header—Adds information such as page numbers, date, and time.

■ Page Break—Specifies a break in the text, forcing the text that follows to appear 
on the next page.

■ Picture—Adds graphic images to the document.

■ Title—Specifies a name for the template that appears in the print job list.

In addition, you may add static text in the print template.

The following print tags allow you to calculate additional information and add it to 
your reports:

■ GetTotal—Calculates the total for a column of data

■ GetField—Gets the value of a field

■ GetCount—Calculates the number of records

You can also calculate dates and times using the GetDate and GetTime tags, and you 
can retrieve the value of the registry using GetRegistry.

All of this information is stored in variables that you specify. In addition, you can 
assign any value to a variable using the SetVariable tag. You can present this 
information in your report using the Cell and EndofLine tags to create tables of 
information. See “Using Variables in Print Templates” on page 223 for an example 
of how variables can be used to present information in print templates.
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Applet

Description Specifies the applet to be printed.

Usage Any data that appears in your document must be generated from the applets in the 
view. Therefore, you must create applets that will produce the data required for your 
document.

Use the Applet tag to specify any number of list or form applets within the template 
and to locate the applet in your document. In the form view, a maximum of two 
fields per row are supported.

Syntax <TAG:Applet Name="APPLET NAME" Query="QUERY STRING" 
Caption="CAPTION" Headerdivider="HEADERDIVIDER" 
Recorddivider="RECORDDIVIDER" Wrap="WRAP">

Parameter Description

TAG:Applet (Required) Applet tag indicator.

APPLET NAME (Required) Applet name as defined in Siebel Tools.

QUERY STRING (Optional) Specifies the query string directly set to the business 
component supporting the document.

If the query string is not specified, the currently active query string 
in the view is applied to expose the relevant records.

CAPTION (Optional) Specifies whether the captions in the form applets are 
suppressed.

Valid values are TRUE (default) and FALSE. This parameter does not 
apply to list applets. Column headings in list applets are always 
enabled.

HEADERDIVIDER (Optional) Specifies whether a divider is printed below the column 
heading in list applets.

Valid values are TRUE and FALSE (default). This parameter does not 
apply to form applets.
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Example <TAG:Applet Name="Order List" Headerdivider="TRUE">

RECORDDIVIDER (Optional) Specifies whether a horizontal divider is printed between 
records in list applets.

Valid values are TRUE and FALSE (default). This parameter does not 
apply to form applets.

WRAP (Optional) Specifies whether text field values are word wrapped. 

Valid values are TRUE and FALSE (default). This parameter does not 
apply to numeric fields.

Parameter Description
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Cell

Description Prints the string stored in STRING or VARIABLE NAME at the specified location on 
the current line.

Usage Use the Cell tag to create cells of data in a row in a table. Use it with the EndOfLine 
tag. If the data exceeds the width of the cell specified by Startat and Endat, it wraps 
to the next line.

Syntax <TAG:Cell Startat="START" Endat="END" Name="STRING" 
Variable="VARIABLE NAME" Align=ALIGNMENT"

Parameter Description

TAG:Cell (Required) Required tag indicator.

START (Required) Specifies the starting point of the cell, expressed as 
a percentage of the printable page width. For example, if 
START =10, then the cell starts at the point that is 10% from the 
left edge of the printable width.

END (Required) Specifies the end point of the cell, expressed as a 
percentage of the printable page width. For example, if 
END=50, then the cell ends at the point that is 50% from the 
left edge of the printable width.

STRING (Optional) String value. If Variable is not specified, then String 
is a required parameter. 

VARIABLE NAME (Optional) Name of variable where the value is stored. If String 
is not specified, then Variable is a required parameter.

ALIGNMENT (Optional) Specifies the alignment of the string.

Valid values are LEFT (default), CENTER, and RIGHT.
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Example <TAG:Divider Weight="3" Startat="20" Endat="80">
<TAG:Cell Startat="0" Endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Defective:" 
Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveTotal" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodTotal" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Defective Count:" 
Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveCount" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Good Count:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodCount" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv3reg">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv5str">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="30" Variable="vvv4date">
<TAG:Cell Startat="30" Endat="70" Variable="vvv4longdate">
<TAG:Cell Startat="70" Endat="100" Variable="vvv8time">
<TAG:EndOfLine>
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Comment

Description Adds code comments to the print template.

Usage Use to add explanatory notes or documentation to explain and maintain the print 
template. Comment tags are ignored during printing and do not appear in the 
printed document.

Syntax <REM: COMMENT>

Example <REM: Quotation Print Template. This template includes four applets.>

Parameter Description

REM (Required) Comment tag indicator.

COMMENT (Optional) Comment text.
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Divider

Description Renders a horizontal line across the width of the page.

Usage Use to visually separate the different sections of your document. The Divider tag 
can be used between other tags; therefore, you may add a line between two applets. 
However, you cannot embed a Divider within an applet.

Syntax <TAG:Divider Weight="WEIGHT" Startat="START" Endat="END">\

Example <TAG:Divider Weight="2" Startat="20" Endat="80">

Parameter Description

TAG:Divider (Required) Divider tag indicator.

WEIGHT (Optional) Specifies line thickness.

Valid values are 1–5. The default value is 1, which produces a 
line 0.2 mm wide. Increasing the value by 1 increases the width 
by 0.2 mm. A 5 produces a line that is 1 mm wide.

START (Optional) Percentage that specifies the starting point of the line. 
The default is 0%, the farthest left point.

END (Optional) Percentage that specifies the end point of the line. 
The default is 100%, the farthest right point.
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EndOfLine

Description Specifies the end of a row and advances to the next line.

Usage Use to create rows of data in a table. Used with the Cell tag.

Syntax <TAG:EndOfLine>

Example <TAG:Cell Startat="0" Endat="50" Name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>
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Footer

Description Adds footer information such as page numbers, the current date, and the current 
time.

Usage You may, for example, always want the text “Thank you for your business!” to 
appear on the bottom of your receipts. If so, you may include this text in a Footer 
tag.

The Footer tag may be specified anywhere in the template file; however, it will 
always appear at the very bottom of your document. Only one Footer tag is applied 
to the document. If you have multiple Footer tags in the file, only the last Footer tag 
is used; any other Footer tags are ignored.

If you include a Footer tag in your template, then you must set the BottomMargin 
in setup.ini to a minimum of 20.

The footer has three sections, Left, Center, and Right, which are used to position the 
information in the footer.

The text in the footer is formatted in 10 point, Helvetica font. If Helvetica is not 
available on your system, the default font is used. You cannot customize text 
formatting of the Footer tag. The Format tag does not affect the formatting of the 
footer.

Syntax <TAG:Footer Left="DATA" Center="DATA" Right="DATA">

Parameter Description

TAG:Footer (Required) Footer tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing
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Example <TAG:Footer Left="<date>" Right="<page>"
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Format

Description Specifies the characteristics of the text—the typeface or font, whether the text is in 
boldface, italics, or underlined, and the text alignment.

Usage The font specification specifies the characteristics of all text that follows the tag 
until the next Format tag.

The text alignment tag (Align) behaves somewhat differently. When the applet is 
rendered, the field alignment specification takes precedence over the Align 
parameter.

Syntax <TAG:Format Face="FONT FACE" Size="FONT SIZE" Bold="BOLD" 
Italic="ITALIC" Underline="UNDERLINE" Align="TEXT ALIGNMENT">

Parameter Description

TAG:Format (Required) Format tag indicator.

FONT FACE (Required) Specifies the typeface of the text.

Any typeface installed on the handheld device may be specified. 
There is no default for this parameter.

FONT SIZE (Required) Specifies the text size.

Any installed font size for an installed typeface on the handheld 
device may be specified. There is no default for this parameter.

BOLD (Optional) Specifies whether the text is in bold.

Valid values are TRUE or FALSE (default). If TRUE, text is set to 
bold.

ITALIC (Optional) Specifies whether the text is in italic. 

Valid values are TRUE or FALSE (default). If TRUE, text is set to 
italic.
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Example <TAG:Format Face="Helvetica" Size="10">

UNDERLINE (Optional) Specifies whether the text is underlined.

Valid values are TRUE or FALSE (default). If TRUE, text is set to 
underline.

TEXT ALIGNMENT (Optional) Specifies the text alignment.

Valid values are LEFT (default), RIGHT, and CENTER.

Parameter Description
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GetCount

Description Calculates the number of records in the selected rows and assigns this value to a 
variable.

Usage Use GetCount to calculate the number of records and print this value in your report.

Syntax <TAG:GetCount Appletname="APPLET NAME" Query="QUERY STRING" 
Variable="VARIABLE NAME">

Example <TAG:GetCount Appletname="CS HH Product Bucket List Applet" 
Query="Status|Good" Variable="StatusGood">

Parameter Description

TAG:GetCount (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

QUERY STRING (Optional) Search specification for the rows to be included in 
the row set. If not specified, the current search specification is 
used.

The syntax for the query string is: Field Name|Query Statement. 
You may specify one or more query strings separated by a 
vertical bar (|).

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 
'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.
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GetDate

Description Gets the current date, offsets the date by the number of days specified in Dayoffset, 
and stores the result in a variable.

Usage Use GetDate to print a specific date in your report.

Syntax <TAG:GetDate Dayoffset="NUMBER OF DAYS" Variable="VARIABLE NAME" 
Logformat="DATE FORMAT">

Example <TAG:GetDate Longformat="TRUE" Variable="LongDate">

Parameter Description

TAG:GetDate (Required) Required tag indicator.

NUMBER OF DAYS (Optional) Number of days by which the current date is offset. 
For example, –100 subtracts 100 days from the current date; 100 
adds 100 days to the current date. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.

DATE FORMAT (Optional) TRUE prints the date in long date format (for 
example, Monday, February 11, 2002). FALSE prints the short 
date format (for example, 2/21/02). The default is FALSE.
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GetField

Description Gets the value of the specified column of the first row of selected rows and assigns 
the result to a variable.

Usage Use GetField to print a value without developing a print applet. Design the query 
and sort strings so that the desired record is the first record in the selected rows. 
GetField only allows you to get the value in the first record.

Syntax <TAG:GetField AppletName="APPLET NAME" Fieldname="FIELD NAME" 
Query="QUERY STRING" Sort="SORT STRING" Variable="VARIABLE NAME">

Example <TAG:GetField AppletName="CS HH Product Bucket List Applet" 
Fieldname="Quantity" Variable="ProdBucketListField">

Parameter Description

TAG:GetField (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

FIELD NAME (Required) Name of the field or column.

QUERY STRING (Optional) Search specification for the rows to be included in 
the total. If not specified, the current search specification is 
used.

SORT STRING (Optional) Sort specification. If not specified, the current sort 
specification is used.

The syntax is: Field Name [ASC][DESC]. The default is ASC 
(Ascending).

For example: Sort="Account DESC, Date". In the example, the 
Account field is sorted in descending order, then the date field 
is sorted in ascending order.

VARIABLE NAME (Required) Name of variable where the value is stored.
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GetRegistry

Description Gets a value in the registry for Siebel Handheld and assigns it to a variable.

Usage Use GetRegistry to print the contents of the registry key in your report.

Syntax <TAG:GetRegistry Name="REGISTRY NAME" Variable="VARIABLE NAME">

Example <TAG:GetRegistry Name="InstallDir" Variable="Registry">

Parameter Description

TAG:GetRegistry (Required) Required tag indicator.

REGISTRY NAME (Required) Value the registry.

VARIABLE NAME (Required) Name of variable where the value is stored.
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GetTime

Description Gets the current time, offsets the time by the number of seconds specified in 
Secondoffset, and assigns the result to a variable.

Usage Use GetTime to print a specific time in your report.

Syntax <TAG:GetTime Secondoffset="NUMBER OF SECONDS" Variable="VARIABLE 
NAME">

Example <TAG:GetTime Secondoffset="3600" Variable="Time">

Parameter Description

TAG:GetTime (Required) Required tag indicator.

NUMBER OF 
SECONDS

(Optional)Number of seconds by which the current time is 
offset. For example, –100 subtracts 100 seconds from the current 
time; 100 adds 100 seconds to the current time. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.
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GetTotal

Description Calculates the total for the specified column for all selected rows and assigns the 
value to a variable.

Usage Use GetTotal to calculate a column total and display the total in your report.

Syntax <TAG:GetTotal AppletName="APPLET NAME" FieldName="FIELD NAME" 
Query="QUERY STRING" Variable="VARIABLE NAME">

Example <TAG:GetTotal AppletName= "CS HH Product Bucket List Applet" 
Fieldname="Quantity" Variable="ProdBucketListTotal">

Parameter Description

TAG:GetTotal (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

FIELD NAME (Required) Name of the field or column. Specify a field or 
column with numeric data. If you specify a field with non-
numeric data, a 0 is assigned to the variable.

QUERY STRING (Optional) Search specification for the rows to be included in 
the total. If not specified, the current search specification is 
used.

The syntax for the query string is: Field Name|Query Statement. 
You may specify one or more query strings separated by a 
vertical bar (|). 

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 
'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.
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Header

Description Adds header information such as page numbers, the current date, and the current 
time.

Usage You may always want the current date and time to appear on your invoices. If so, 
you may include this information in a Header tag.

The Header tag may be specified anywhere in the template file; however, it always 
appears at the very top of your document. Only one Header tag is applied to the 
document. If you have multiple Header tags in the file, only the last Header tag is 
used; any other Header tags are ignored.

If you include a Header tag in your template, then you must set TopMargin in 
setup.ini to a minimum of 20.

The header has three sections, Left, Center, and Right, which are used to position 
the information in the header. The Left parameter aligns the text with the left 
margin, and the Right parameter right aligns the text with the right margin. The 
Center parameter centers the text in the header.

The text in the header is formatted in 10 point, Helvetica font. If Helvetica is not 
available on your system, the default font is used. You cannot customize text 
formatting of the Header tag. The Format tag does not affect the format of the 
header. 

Syntax <TAG:Header Left="DATA" Center="DATA" Right="DATA"

Parameter Description

TAG:Header (Required) Header tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing
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Overview
Example <TAG:Header Center="Company Confidential">
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Page Break

Description Forces text that follows the tag to appear on the next page.

Usage Use this for multipage documents or forms.

Syntax <TAG:PageBreak>

Example <TAG:PageBreak>

Parameter Description

TAG:PageBreak (Required) Page break tag indicator.
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Picture

Description Specifies graphic files included in the print template.

Usage Use to add graphic images, such as a company logo, to your documents. 

The supported file formats are BMP and JPG. 

Graphics files are located in the \Program Files\Siebel Handheld\templates 
directory on the handheld device. Specify the full path name of the file for the Name 
parameter.

Scaling or graphics operations, such as inverse image, are not supported.

The Alignment and Position parameters are used together to place the graphic. 
Alignment specifies the left edge, the center, or the right edge of the graphic. 
Position is distance, specified in millimeters, from the left edge of the paper. 

■ If Alignment ="Left" and Position="30", then the left edge of the graphic is set 
30 millimeters from the left edge of the paper. 

■ If Alignment = "Center" and Position = "30", the center of the graphic is set 30 
millimeters from the left edge of the paper.

■ If Alignment = "Right" and Position = "30", the right edge of the graphic is set 
30 millimeters from the left edge of the paper.

If Position is not specified, it defaults to 0. Depending on the Alignment setting, the 
graphic is left-aligned (Alignment = "Left"), the graphic is right-aligned 
(Alignment = "Right"), or the graphic is centered (Alignment ="Center")

Syntax <TAG:Picture Name="FILE NAME" Alignment="ALIGNMENT" 
Position="POSITION">

Parameter Description

TAG:Picture (Required) Picture tag indicator.

FILE NAME (Required) Specifies the full path and name of the graphics file.
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Example <TAG:Picture Name="\Program Files\Siebel Handheld\templates\logo.bmp" 
Alignment="Right" Position="88">

ALIGNMENT (Optional) Specifies the left edge, the center, or the right edge of the 
graphic. Used with the Position parameter to specify the horizontal 
position of the graphic.

Valid values are LEFT (default), CENTER, and RIGHT.

POSITION (Optional) Specified in millimeters, it is the distance from the left edge of 
the paper. Used with the Alignment parameter to specify the horizontal 
position of the graphic. The default is 0.

Parameter Description
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SetVariable

Description Sets a value to a variable.

Usage Use SetVariable to assign a value to a variable. You can then print the value by 
specifying the variable in the Cell tag.

Syntax <TAG:SetVariable Name="VALUE" Variable="VARIABLE NAME>

Example <TAG:SetVariable="100" Variable="TotalQuantity">

Parameter Description

TAG:SetVariable (Required) Required tag indicator.

VALUE (Required) A value.

VARIABLE NAME (Required) Name of variable where the value is stored.
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Static Text
You may add static text anywhere in your template by using the current Format 
settings. The text goes across the entire page width. If it exceeds the width of the 
page, it wraps to the next line.

Example This quote is valid for 60 days from the date on this quotation.
222 Siebel Sales Handheld Guide for Windows-Powered Devices Version 7.5.3



Print Tagging Language

Print Template File Examples
Title

Description Name used to identify the template.

Usage The Title tag is a required tag in your print template file. 

When you print your document, this title appears in the print job list. This title does 
not appear on the document that is printed. Use static text to add the document title 
to your template.

Syntax <TAG:Title Title="TITLE">

Example <TAG:Title Title="Quotation">

Print Template File Examples
The following is an example of a print template file.

Using Variables in Print Templates
The following example shows how to use variables in a print template.

<TAG:Title Title="Inventory Report">

<REM: **********Variable Assignment Examples**************>

<TAG:SetVariable name="THIS IS VARIABLE" variable="VarStr">
<TAG:GetRegistry name="InstallDir" variable="VarReg">
<TAG:GetDate dayoffset="10" variable="VarDate">
<TAG:GetDate longformat="TRUE" variable="VarLongDate">
<TAG:GetTime secondoffset="-3600" variable="VarTime">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" 

Parameter Description

TAG:Title (Required) Title tag indicator.

TITLE (Required) Title text. May be between 1–255 characters.
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fieldname="Quantity" variable="VarTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" 
fieldname="Quantity" query="Status|Good" variable="VarGoodTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" 
fieldname="Quantity" query="Status|Defective" 
variable="VarDefectiveTotal">
<TAG:GetField appletname="CS HH Product Bucket List Applet" 
fieldname="Quantity" variable="VarQuantityField">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" 
query="Status|Good" variable="VarGoodCount">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" 
query="Status|Defective" variable="VarDefectiveCount">

<REM: **********Variable Assignment Examples End************>

<REM: Inventory Print Template. This template includes 3 applets. 
The ENU template>

<TAG:Format Face="Helvetica" Size="16" Align="Center">
[Distributor Name
Street Address
City, Country Postal Code
Phone Number   Fax Number]

<TAG:Format Face="Helvetica" Size="20" Bold="TRUE" Align="Center">
Inventory Report
<TAG:Format Face="Helvetica" Size="8" >
<TAG:Applet Name="CS HH Inv Loc Print Applet" Caption="TRUE" 
Wrap="TRUE">
<TAG:Applet Name="CS HH Product Bucket List Applet" Line="FALSE" 
Headerdivider="TRUE" Recorddivider="FALSE" Wrap="TRUE">

<REM: *************Variable Usage Example***************>

<TAG:Divider Weight="3" startat="20" endat="80">
<TAG:Cell startat="0" endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarTotal" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell startat="0" endat="50" name="TOTAL Defective:" 
Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveTotal" 
Align="RIGHT">
<TAG:EndOfLine>
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<TAG:Cell startat="0" endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodTotal" 
Align="RIGHT"
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Defective Count:" 
Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveCount" 
Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Good Count:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodCount" 
Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarReg">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarStr">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="30" variable="VarDate">
<TAG:Cell startat="30" endat="70" variable="VarLongDate">
<TAG:Cell startat="70" endat="100" variable="VarTime">
<TAG:EndOfLine>

<REM: ***********Variable Usage Example End***************>

<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="LEFT">
Warehouse Signature
<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="RIGHT">

Rep Signature
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Print Configuration Settings F
You configure printing attributes in the setup.ini file. This appendix describes the 
printing parameters for Siebel application developers and application 
administrators.

Overview
The administrator sets up the default printer setting in the setup.ini file located in 
the setup directory.

There are a number of parameters to specify printing on the handheld. The 
parameters specify the following:

■ Printer attributes (printer model, port, baud rate, and printer handshake)

■ Printing attributes (portrait or landscape orientation, print density and quality, 
use of compression techniques, and advancing continuous–feed paper)

■ Dimensions of the paper (U.S. or European standard paper sizes or custom–size 
paper)

■ Margin settings of the pages (left, right, top, and bottom margins)

These parameters are specified in the [Printing] section of the setup.ini file located 
in the setup directory. The file contains default settings for all the printing 
parameters. Review the settings in the file to verify that these settings will work for 
your printing environment. If necessary, edit the settings as required. You may use 
any text editor to edit the file.

See Appendix E for a list of the printing parameters and valid values.

The parameters are set using the following syntax:

PARAMETER_NAME = VALUE
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For example: PrinterType = 1

The parameters are listed below in alphabetical order by the parameter name.

MarginBottom
Use the MarginBottom parameter to specify the dimensions of the bottom margin 
of your page. Specify the margin in millimeters using a whole number; decimal 
fractions are not valid. The default is 5 millimeters.

The data specified in the Footer tag of the print template is printed in the margin 
specified by MarginBottom. Therefore, if the print template includes a Footer tag, 
you must specify a wide enough bottom margin to accommodate the footer. 
MarginBottom should be set to a minimum of 20 millimeters. For more information, 
see “Footer” on page 206.

MarginLeft
Use the MarginLeft parameter to specify the width of the left margin of your page. 
Specify the margin in millimeters using a whole number; decimal fractions are not 
valid. The default is 5 millimeters.

MarginRight
Use the MarginRight parameter to specify the width of the right margin of your 
page. Specify the margin in millimeters using a whole number; decimal fractions are 
not valid. The default is 5 millimeters.

MarginTop
Use the MarginTop parameter to specify the dimensions of the top margin of your 
page. Specify the margin in millimeters using a whole number; decimal fractions are 
not valid. The default is 5 millimeters.

The data specified in the Header tag of the print template is printed in the margin 
specified by MarginTop. Therefore, if the print template includes a Header tag, you 
must specify a wide enough top margin to accommodate the footer. MarginTop 
should be set to a minimum of 20 millimeters. For more information, see “Header” 
on page 216.
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PaperHeight
If the paper that your printer uses is not one of the supported standard sizes, then 
set PaperSize to 5 (custom paper dimensions). Then, specify the height of the paper, 
in millimeters, using the PaperHeight parameter. You must use a whole number; 
decimal fractions are not valid. The default is 280 millimeters. If you specify a value 
of 1–4 for PaperSize, the PaperHeight parameter is ignored.

Use the PaperWidth parameter to specify the width of the paper.

PaperSize
Specify one of the standard paper sizes or specify a custom paper size. (See 
Table 34.) If you specify custom paper size (5), you must also specify the 
PaperWidth and PaperHeight parameters. The default is custom paper dimensions.

See also PaperWidth and PaperHeight.

PaperWidth
If the paper that your printer is printing to is not one of the supported standard 
sizes, then set PaperSize to 5 (custom paper dimensions). Then, you must specify 
the width measurement of the paper, in millimeters, using the PaperWidth 
parameter. You must use a whole number; decimal fractions are not valid. The 
default is 5 millimeters. If you specify a value of 1–4 for PaperSize, the PaperWidth 
parameter is ignored.

Table 34. Paper Dimensions

Value Description

1 Letter size (8.5" x 11.5")

2 A4 (210 mm x 297 mm)

3 B5 (176 mm x 250 mm)

4 Legal size (8.5" x 14")

5 (default) Custom paper dimensions (Specify PaperWidth and PaperHeight 
parameters.)
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Use the PaperHeight parameter to specify the length of the paper.

PrinterBaudrate
Use PrinterBaudrate to specify the speed of the data transmission for the printer. 
(See Table 35.)

PrinterCompressed
Use PrinterCompressed to specify the data compression mode. (See Table 36.) For 
the printers supported in this release, always set PrinterCompressed to 1.

PrinterDensity
Use the PrinterDensity parameter to get a lighter or darker output from the printer. 
Start with the default setting, 2, which corresponds to the printer manufacturer’s 
default. As you get feedback from the field, you may need to adjust this setting.

Table 35. Printer Baud Rate

Value Description

0 Always use 0 for LPT or Network printer ports or for COM ports 
that communicate with the printer at 4800 baud.

1 (default) 9600 baud

2 19200 baud

3 38400 baud

4 57600 baud

5 115200 baud

Table 36. Data Compression

Value Description

0 No compression techniques used

1 (default) Use any known compression
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The valid values are 0–4 where 0 is the lightest print density, 4 is the heaviest print 
density, and 2 is average print density.

PrinterDither
Use to specify the method by which different colors are represented. (See Table 37.) 
For the printers supported in this release, PrinterDither should always be set to 0.

PrinterDraftMode
Use PrinterDraftMode to specify the quality of the printing. (See Table 38.) For the 
printers supported in this release, PrinterDraftMode should always be set to 0.

PrinterFormFeed
Use PrinterFormFeed to specify how paper advances to the next page. (See 
Table 39.) If using sheets of paper, set PrinterFormFeed to 0. 

Specify 1 or 2 for continuous–feed paper:

■ Set PrinterFormFeed to 1 if you do not need to conserve paper or if you want 
pages of uniform length. The printer scrolls to the length specified by the 
PageHeight parameter and trims the page there. 

Table 37. Print Dithering

Value Description

0 (default) Use color diffusion

1 Use dithering

Table 38. Print Quality

Value Description

0 (default) Use the highest quality printing

1 Use a lower quality printing if available
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■ Set PrinterFormFeed to 2 to conserve paper or if it does not matter if your pages 
are of varying length. In this case, the printer scrolls 25 millimeters beyond the 
last printed line and trims the page there. The scroll distance, 25 mm, is not 
customizable.

For both values, 1 and 2, the page length never exceeds PageHeight.

PrinterHandshake
Use PrinterHandshake to define the serial port handshake. (See Table 40.) The 
PrinterHandshake parameter applies only when the printer port is a Com1 or Com2 
port. If PrinterPort is set to Com1 or Com2, then set PrinterHandshake to 1. 

Table 39. Printer Form Feed

Value Description

0 (default) Printer sends a form feed command to the printer at the end of 
each page. Use this setting for sheet paper.

1 Printer scrolls the page to the length specified by the PaperHeight 
parameter.

2 Printer scrolls the page 25 millimeters past the last printed line of 
the page.

Table 40. Printer Handshake

Value Description

0 Uses Xon/Xoff

1 (default) Uses hardware control lines

2 No handshaking of serial port
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PrinterOrientation
Specify whether the paper is to be oriented vertically (portrait) or horizontally 
(landscape). (See Table 41.) Not all printers can print in landscape orientation. 
Therefore, you will need to check the specifications for your printer.

PrinterPort
Specify the port to which the printer is connected with the PrinterPort parameter. 
(See Table 42.)

If PrinterPort is an LPT port or a network path (2 or 9), then the PrinterBaudrate 
must be set to 0.

Table 41. Paper Orientation

Value Description

1 (default) Portrait (vertical)

2 Landscape (horizontal)

Table 42. Printer Port

Value Description

0 Com1: serial port

1 Com2: serial port

2 LPT: parallel port

3 (default) IR Infrared port

4 Com3: serial port

5 Com4: serial port

6 Com5: serial port

7 Com6: serial port

8 Print to file OUTPUT.PRN

9 Print to network address
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PrinterType
Specify the type of printer using the PrinterType parameter. See Table 43 for the list 
of supported printers.

Default Printing Settings
The following are the printing parameters from the setup.ini file. The values shown 
are the default settings.

[Printing]

PrinterType= 14
PrinterPort= 3 
PrinterBaudrate= 1
PrinterHandshake= 1
PrinterOrientation= 1
PrinterDensity= 2
PrinterCompressed= 1
PrinterDither= 0

10 Bluetooth BlueCard solution by Wireless Solutions

11 Socket PNC Bluetooth card support

12 Bluetooth BlueCard solution by Anycom

13 Com7: serial port

14 Com8: serial port

Table 42. Printer Port

Value Description

Table 43. Printer Type

Value Description

6 Pentax PocketJet 200

14 (default) O’Neil microFlash2i and microFlash4t printers

108 O’Neil microFlash8i printer
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PrinterDraftMode= 0
PrinterFormFeed= 0
PaperSize= 5
PaperWidth= 115
PaperHeight= 280
MarginLeft= 5
MarginRight= 5
MarginTop= 5
MarginBottom= 5
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organization of guide 14

P
Page Break print tag 218
PaperHeight parameter, about 229
PaperSize parameter, about 229
PaperWidth parameter, about 229
participants, specifying 161
PDQ filters, administration

Companion Sync, about 66
Direct Server Sync mode, about 67

performance
client performance, about 179
network performance, about 181
server performance, about 180
SQLTrace, enabling 177

pick applets, data filtering for
about 67
business object declarations, setting 

examples 69
configuration file directives 68
Popup Visibility Type setting, 

overriding 72
visibility, designating 70

Picture print tag 219
Pocket PC

menu bar, about using 39
multiple applet views, screen 

allocation 32
toolbars, configuring 40

pop-up lists
auto pop-up lists, about 37
data visibility, about controlling 39, 68

Popup Visibility Type setting, 
overriding 72

Predefined Queries (PDQs)
about and example 58
All Records PDQs, about 61
general and default PDQ filters, 

described 59
PDQ filters, summary of use (table) 62

print applets, designing
See also individual print entries
about 45
form applets, designing 45
list applets, designing 45

Print button
See also individual print entries
configuring (procedure) 47
configuring, about 46

print tagging language
See print templates

print templates
See also server installation; individual 

print entries
Applet print tag 199
Cell print tag 201
Comment print tag 203
Divider print tag 204
EndofLine print tag 205
Footer print tag 206
Format print tag 208
GetCount print tag 210
GetDate print tag 211
GetField print tag 212
GetRegistry print tag 213
GetTime print tag 214
GetTotal print tag 215
Header print tag 216
Page Break print tag 218
Picture print tag 219
print template file example 223
print template file, creating 

overview 197
SetVariable print tag 221
Static Text print tag 222
Title print tag 223
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variables, example using in 
template 223

PrinterBaudrate parameter, about 230
PrinterCompressed parameter, about 230
PrinterDensity parameter, about 230
PrinterDither parameter, about 231
PrinterDraftMode parameter, about 231
PrinterFormFeed parameter, about 231
PrinterHandshake parameter, about 232
PrinterOrientation parameter, about 233
PrinterPort parameter, about 233
PrinterType parameter, about 234
printing quotes 166
printing, configuration settings

See also server installation; individual 
print entries

default printing settings, list of 234
MarginBottom parameter, about 228
MarginLeft parameter, about 228
MarginRight parameter, about 228
MarginTop parameter, about 228
PaperHeight parameter, about 229
PaperSize parameter, about 229
PaperWidth parameter, about 229
parameters and syntax, about 227
PrinterBaudrate parameter, about 230
PrinterCompressed parameter, 

about 230
PrinterDensity parameter, about 230
PrinterDither parameter, about 231
PrinterDraftMode parameter, about 231
PrinterFormFeed parameter, about 231
PrinterHandshake parameter, about 232
PrinterOrientation parameter, about 233
PrinterPort parameter, about 233
PrinterType parameter, about 234

printing, configuring for the handheld
See also individual printing entries; print 

templates
about 43
defining documents for printing 44
print applets, configuring for printing 46
print applets, designing 45

Print buttons, about configuring 46
Print buttons, configuring 

(procedure) 47
products, associating an opportunity 

with 157

Q
Query by Example filters (QBE)

about 55
business component filters, adding 56
List of Values, filtering out 58

Quote Number field, about 194
quotes

AutoOrder method, copied fields for 
service product (table) 195

AutoOrder method, population fields in 
Order Entry (table) 194

opportunity quotes, about viewing 157
quotes, developing

about 162
AutoQuote, about using and Quote Item 

fields (table) 163
AutoQuote, quote fields automatically 

completed (table) 164
AutoQuote, using to create a quote 164
business scenario 162
creating a quote 162
printing a quote 166
quote line items, adding 165
quote line items, deleting 166

R
recovering data

Companion Sync journal files 109
Siebel Handheld Journaling 108

reinstalling handheld application 118
remote database

See synchronization, conflict handling 
and recovery

report
expense report, creating 169
views, associating with 34
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repository
.SRF file, location of 43
compiling, about 43

Repository Configuration, about 53
resources, additional 15
restore, troubleshooting 171

S
Sales Handheld PDQ filters

about 62
sales methods, about 156
screens and views (table)

Siebel Sales 184
screens and views, designing

applet, overriding default behavior 33
drill-down only views, about 33
multiple applet views, screen 

allocation 32
multiple applet views, toggling 

between 32
print templates and reports, views 

associated with 34
scripting

deactivating scripts, about 75
user interface methods, calls to 76

server installation
CompactFlash card, setting up 

installation on 95
database backup, enabling 93
Direct Server Synchronization (DDS), 

installation 80
DSS URL, about changing 96
external media, installing from 97
handheld logging parameters, 

configuring 95
hardware and network configuration, 

recommended 79
installation configuration file, editing 89
planning for, about 77
print templates, about installing 96
server logging levels, configuring 83
server process management, 

optimizing 86

server topology overview, about and 
diagram 78

synchronization performance and 
scalability 86

setup.ini file, location and editing 89
SetVariable print tag 221
Siebel eScript, issues and validation 75
Siebel Expert Services, about using 182
Siebel Handheld Client

handheld screen, about designing for 30
identify user activities, improving 

performance 30
minimal navigation, about designing 

applications 30
Multi-Value Group applet, support of 27
naming conventions, about 31
scripting, about 75
Siebel Web Client, differences in 

configuring 26
stop-and-go workflow, about 

supporting 30
testing the handheld application 48
unsupported functions (table) 28
user functionality, defining 29

Siebel Handheld Journaling
about and parameter settings 108
journal log files, location and name 108

Siebel Mobile Web Client, about 
installation 87

Siebel Professional Services, about 
using 182

Siebel Visual Basic (VB), issues and 
validation 75

Siebel Web Client
Multi-Value Group applet, support of 27
scripting, issues and validation 75
Siebel Handheld client, differences in 

configuring 26
unsupported functions (table) 28

SQLTrace, enabling 177
.SRF file, location of 43
stand-alone installer, about creating 97
Static Text print tag 222
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status bar, about 41
synchronization

See also synchronization, conflict 
handling and recovery

Direct Server Sync via Proxy, about 22
Direct Server Sync, about and 

diagram 21
handheld synchronization errors, 

logging 176
methods and architecture 19
overview 18
preventing synchronization with another 

handheld 52
resynchronization problems, 

troubleshooting 174
servers, types of 19
synchronization conflicts, preventing 41
troubleshooting, about problems caused 

by 172
synchronization filters

See Predefined Queries (PDQs)
synchronization, conflict handling and 

recovery
See also Siebel Handheld Journaling; 

synchronization
about 101
extended insert processing 105
extended pick processing, about 101
extended pick processing, enabling 102

T
templates, associating views with 34
terms, adding 168
testing the handheld application 48
timeout parameter, changing on 

Windows 178
Title print tag 223
toolbars, configuring

Pocket PC 2002 toolbar functions 
(table) 40

totals, adding 168
transaction errors, viewing 110
troubleshooting

client installation, backup, and 
restore 171

client performance, about 179
Companion Sync checklist, using 173
Companion Sync log files 175
Direct Server Sync checklist, using 173
Direct Server Sync log files 174
handheld device logs 176
network performance, about 181
resynchronization problems 174
server performance, about 180
Siebel Expert Services, about using 182
Siebel Professional Services, about 

using 182
SQLTrace, enabling 177
synchronization, about problems caused 

by 172
timeout parameter, changing on Windows 

2000 178
timeout parameter, changing on Windows 

NT 178

U
uninstalling handheld application 118
upgrading handheld application 118
user functionality, defining

about 29
general guidelines 29

user interface elements, configuring
about 35
auto pop-up lists, about 37
buttons, about and functionality 

(table) 39
form applets, group boxes 37
form applets, labels 37
form applets, layout sequence 36
Home Page applets, configuring 38
hyperlinks, about configuring 41
list applets, about and guidelines 35
menu bar, about using 39
status bar, about 41
toolbars, configuring 40
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user interface methods, business 
component script calls to 76

user properties (table) 191

V
views

drill-down only views, about 33

new views, adding 49
visibility, designating 70

W
Windows, changing timeout 

parameter 178
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